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Chapter 1: 3D Basics
This part describes basic 3D concepts. The following discussion 
centers on Poser, however most of these concepts apply to all 3D 
applications. Novice 3D artists should read the entire chapter to 
gain valuable “behind the scenes” insight that will help in learning 
and using Poser. Veteran 3D users can use this chapter as a handy 
reference or refresher.

About 3D Space
Let’s begin by defining the three dimensions:

•	 Zero dimension: A point is an example of a zero-
dimensional object. It defines a point in space but has no 
length, height, or width.

•	 First dimension: A one-dimensional object is a single line. 
It has length but no height or depth.

•	 Second dimension: A two-dimensional object has any 
two of the following three dimensions:

Length��

Height��

Depth��

Figure 1.1

Pick any one of the three dimensions and call it A. Now pick either 
of the remaining two dimensions and call it B. In the graphic, the 
arrows represent the two dimensions and the rectangle represents 
a two-dimensional object. You will immediately notice that all two-
dimensional objects are perfectly flat, like the surface of a sheet of 
paper. Two-dimensional objects are called planes.

•	 Third dimension: Three-dimensional objects use all three 
of the dimensions (length, height, and depth).

As you can see from the graphic, the cube is a three-dimensional 
object. It has length, height, and depth. That’s pretty simple, right? 
Here’s the hard part: You create 3D data using two-dimensional 
tools. Your computer screen is a two-dimensional object and your 
mouse can move in two dimensions; it can report left-right and 
front-back motion but cannot report how far above or below the 
desk it is. Furthermore, your output will always be two-dimensional. 
Look at the above graphic: It does not have depth. It does, 
however, represent three dimensions using a simple optical illusion 
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called perspective, which is defined as the tendency of objects 
to appear progressively smaller the farther away they are until 
they disappear on the horizon at a location called the vanishing 
point. You can see this by standing at the corner of a long 
building and noticing how the roofline appears to get closer to the 
ground the farther away you look. Given these limitations, you ask, 
how can one create 3D information?

Figure 1.2

The short answer is that all 3D applications, Poser included, create 
a “virtual” 3D space. Look at the above graphic again. We can view 
and manipulate the cube in three dimensions by separating them 
into separate workspaces called views. One view will displays 
the A and B dimensions, the second will displays the A and C 
dimensions, and the third will displays the B and C dimensions. You 
can also have a fourth view that displays all three dimensions. This 
graphic shows how the four views might look in a 3D application 
such as Poser.

Figure 1.3

Let’s look at the same graphic again, only this time let’s substitute 
a simple boat for the cube to better illustrate the concept. One of 
the benefits of this system is that it becomes possible to precisely 
control your 3D model. For example, you can determine the length 
of the boat using the AB or AC view, the width using the AB or BC 
view, and the height using the AC or BC view. Which view you use 
depends on what you are trying to accomplish. For example, to 
create the stern, you would probably use the BC view, and would 
probably use the AB view to create the overall shape.
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Figure 1.4

In these examples, the A, B, and C dimensions are collectively called 
axes. Taken individually, each dimension is called an axis. So far, 
we have used each axis to describe one of the three dimensions 
without caring about which axis describes which dimension. The 
A dimension could describe any of the three dimensions with B 
describing either one of the remaining two dimensions and so 
forth. We did this to illustrate the most basic theory behind 3D 
applications such as Poser. Let’s expand on that.

It should be obvious that the AB, AC, and BC views lack 

perspective. Two-dimensional views without perspective are called 
orthographic views. Each three-dimensional object has six 
orthographic views: Top, Bottom, Left, Right, Front, and Rear. Pick 
up any object you like and look at it from all angles; you will see 
that this always holds true. So, while the boat example above 
shows the Top (AB), Left (AC), and Rear (BC) views, it could just as 
easily show any three of the six possible views. This is important 
because, like the boat, not all three-dimensional objects are 
symmetrical.

Now that you understand this fundamental concept, let’s learn how 
it’s used in the real world. To recap, the three dimensions are width, 
length, and height or depth, each dimension is represented by an 
axis, and we can view each pair of axes in two ways to generate 
a total of six possible views. So far so good, except for one small 
problem: If everyone used an arbitrary system of axes to define 
the three dimensions, then it would be difficult to pass data back 
and forth. In the above example, we are using the AB as the Left 
view. Someone else could just as easily define AB as any of the 
six available views. You can see the chaos that could ensue. To 
prevent this, both 2D and 3D objects conform to a standard system 
of axes called the Cartesian coordinate system. The term 
Cartesian is used in honor of the French mathematician and 
philosopher Rene Descartes (1596–1650), who was one of the first 
to employ such coordinate systems.
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Cartesian Coordinates
Before getting too far into Cartesian coordinates, let’s pause for a 
quick math review: If you arranged all of the numbers from negative 
infinity to positive infinity along a line, the number 0 would be in 
the center of that line. Negative numbers would be on the left side 
of 0 with –1 being the closest to 0, and positive numbers would be 
on the right side of 0 with +1 being the closest to 0.

Figure 1.5

Negative numbers being on the left (or front) works for horizontal 
lines or axes. For vertical lines, negative numbers are beneath 
0 with positive numbers above 0. This stands to reason, since 
negative numbers are literally less than 0. When dealing with 
coordinate systems, we assume that each dimension is infinite, with 
zero representing the dimension’s center or origin.

The Cartesian coordinate system goes one step further by defining 
three axes, called X, Y, and Z. In our previous examples, we 
deliberately used the arbitrary letters A, B, and C to illustrate the 
concept of axes and avoided using the actual letters because 
we wanted to familiarize you with the general idea of axes and 
dimensions before focusing on how they are actually used. In the 
Cartesian coordinate system, the axes correspond to dimensions as 

follows:

X•	 : Width

Y•	 : Height

Z•	 : Depth

Let’s combine the origin with the Cartesian axes as follows. As 
you can see, the Cartesian coordinate system uses three axes to 
represent each of the three dimensions: X, Y and Z. The positive 
X axis points to the right, the positive Y axis points up, and the 
positive Z axis points towards the front of the scene. The center 
of the 3D space is a single point, which is the midpoint (origin) 
of the three axes. Thus, the 3D space extends to infinity in both 
negative and positive directions along all three dimensions. You can 
see the origin in any of the Poser views.

Figure 1.6
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Now that we have a standard system for defining 3D space and 
objects within that space, we can use coordinates to define the 
object’s shape. Remember that coordinates are always listed in XYZ 
order. Coordinates themselves are defined as the distance from the 
origin along each of the three axes. For example, the coordinate 
{1,1,1} signifies a point that is 1 unit to the right of the X origin, 1 
unit above the Y origin, and 1 unit behind the Z origin.

 The format of listing the X, Y, and Z coordinates within 
braces and separated by commas is the standard shorthand 
used with the Cartesian coordinate system.

Remember the box we used in the previous 3D example? We can 
use Cartesian coordinates to define its corners. What if we move 
the box over somewhat? The graphics on the right show how that 
might affect the coordinates. As you can see, Cartesian coordinates 
serve to define an object’s shape, size, and location in 3D space.

Figure 1.7

Planes
As we discussed earlier, 3D applications must depict and 
manipulate 3D data using a series of 2D views and tools. You 
already know that 2D objects are planar because they exist on a 
mathematically defined plane. A plane is a formula defining the 
relationship between two dimensions, such as XZ. Combining 
these two facts with what we just learned about the Cartesian 
coordinate system and a quick glance at our monitor, we find that 
3D applications like Poser use three views aligned with coordinate 
planes to help you locate points in 3D space. 

Figure 1.8

You can change the Poser Document window to show several 
cameras, including the orthogonal views (Left, Right, Front, Back, 
Top, Bottom) and perspective views (Main, Auxiliary, Face, Hand, 
Posing). Please refer to the Poser Reference Manual, Chapter 5: 
The Document Window on page 60, for a description of the Poser 
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Document window. The graphic shows a quick rendition of three 
orthogonal views:

Figure 1.9

Global vs. Local Coordinates
There is one last wrinkle to the Cartesian coordinate system. To 
explain this wrinkle, let’s use the example of a motorcycle rider 
leaning into a turn. What just happened? For the sake of argument, 
let’s assume that the headlight is 30 inches above the ground 
when the motorcycle is upright. If the rider leans the motorcycle 45 
degrees to the left, then headlight will now be 21.2 inches to the 
left of center and 21.2 inches off the ground.

For anyone into trigonometry, we find the new location 

by multiplying the original location by the sin and cosine of 
the angle. In this case, sin(45) = cos(45) =.707, and.707*30= 
approx. 21.2.

Thus, the headlight’s coordinates will have changed from {0, 
30,0} to {21.2, 0, 21.2}. However, nothing has changed about the 
motorcycle itself. The headlight is still in the exact same position 
relative to the rest of the machine. To demonstrate this, let’s 
create a second 3D space using the motorcycle’s center of gravity 
(balance point) as the origin. Let’s further say that the headlight is 
12 inches above and 30 inches in front of the center of gravity. This 
means that the headlight’s relative coordinates are {0, 12, -30}, and 
these relative coordinates do not change because the headlight 
does not move relative to the center of gravity. But what do we 
mean by relative?

Has the motorcycle leaned 45 degrees to the left, or has the 
world leaned 45 degrees to the right? To an observer standing 
on the ground, the motorcycle has leaned over 45 degrees. To 
the rider, s/he is still on top of the motorcycle and it is the world 
that has leaned over 45 degrees. Further, the rider maintains her 
or his relationship to the motorcycle, meaning (for example) that 
her or his head is still 30 inches behind and 32 inches above the 
headlight. Thus, while the motorcycle’s world coordinates 
have changed, its object (or local) coordinates have 
remained the same.
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Figure 1.10

If this seems a bit complex, bear with us as we use a far simpler 
example. Each object in Poser has its own object coordinate 
system. When an object is first created, its center and orientation 
are the same as the world’s. As described above, this changes when 
the object moves. The world’s center and orientation are still the 
same, but the object’s center and orientation may have changed. 
Look at the square in the graphic. Say the upper-left corner is 
located at {-5,5,0}. When the object is first created, that point is the 
same in local and global coordinates because the object’s center is 
at {0,0,0}. If we move the object +7 along the X axis and +3 along 
the Y axis, the upper-left corner would now be at {2,8,0} in global 
coordinates but would remain at {-5,5,0} in local coordinates, that 
is, relative to the object’s center. In other words, any point can be 

specified relative to its object’s local coordinate system (object 
space) or relative to the global coordinate system (world 
space or global coordinates) shared by all objects.

Transformation
So far, you have learned about 3D objects, the Cartesian coordinate 
system, and the difference between object space and world space. 
Let’s move on and learn how we can use XYZ values to define 
an object’s transformation in addition to its size, shape, and 
position.

An object’s transformation describes an object’s position 
(translation), orientation (rotation), and size (scale) in 3D 
space. When an object is first created, its transformation is set to 
align with the global coordinates. Its position is set to {0,0,0}, its 
orientation is set to {0,0,0}, and its size is set to {1,1,1}. An object’s 
transformation values are almost certain to change as you work 
with the object.

Translation

An object’s translation describes its position in 3D space relative 
to its center and is measured in defined grid units. Let’s take 
another look at the box we used in an earlier example:

As you can see, the box’s center is the same as the origin ({0,0,0}). 
What happens if you want to move the box? You can move each 
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one of the points, delete the existing box and draw a new one in 
its new location, or simply translate the box. For example, setting 
a Translate value of {2,2,2} would move box’s lower left corner 
to {0,0,0} since (-2)+2=0. Again, the Translate value refers to the 
location of the center of the object relative to world space.

Rotation

An object’s rotation value refers to its orientation in 3D space 
measured in degrees. As you probably know, any actual object will 
revolve around its center of gravity (balance point). Objects in Poser 
have no mass and no center of gravity, so you can set the object’s 
center wherever you like and the object will rotate around that 
point.

Figure 1.11

Let’s think back to the motorcycle example. If you model a 
motorcycle and decide you wish to lean it 45 degrees, nothing 
is stopping you from performing trigonometric calculations to 

determine the new location of each part. Remember that each part 
of the motorcycle will move in at least two dimensions as the whole 
machine rotates. In this case, since the motorcycle is rotating about 
the Z axis, you could simply enter a rotation value of {0,0,45}. The 
trigonometric calculations will still need to be performed, however 
Poser will get stuck with the job instead of you.

Scale

An object’s scale value refers to its size in relation to itself and 
is measured in percent. In this case, a value of 1 corresponds to 
100%. Take the example of a circle. As with all other Poser objects, 
it is initially created with a scale value of {1,1,1}, meaning that it is 
100% of its original size in all three dimensions.

Now that your perfect circle is in place, you realize you need to 
double its height on the Y axis. Simply enter a scale value of {1,2,1} 
and the circle will turn into an ellipse that is twice as long on the 
Y axis as it is wide. To stretch it on the X axis, you would enter 
{2,1,1}.

Figure 1.12
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To compute every point on a model, multiply the original 
coordinates by the X, Y, and Z components. With this in mind, it 
becomes easy to see how different values can change the size of 
your object. For example, entering a scale value of {2,2,2} would 
double the circle’s size. Poser allows you to set each scaling factor 
independently in order to obtain squashing and stretching effects. 
This is called differential scaling.
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Chapter 2: Basic 3D Elements
Now that you’ve learned about 3D objects, Cartesian coordinates, 
object space vs. world space, and object transformations, let’s go 
ahead and learn more about 3D objects themselves.

Vertices
A point is a zero-dimensional (0D) object in 3D space. It has a 
set of coordinates to define its location but has no length, width, 
or height. It is nothing more than a location in Cartesian space. 
However, we can connect points to create edges or polylines. An 
edge is part of a polygon between two vertices, and a polyline 
connects two vertices together that are not part of a polygon. At 
its root, 3D modeling consists of nothing more than connecting a 
series of vertices together to create 3D objects.

A group of vertices used to define a 3D object is called a point 
cloud. Each point in a cloud is usually called a vertex and is used 
to define one of the corners of a polygon. Points used to define a 
spline (see below) are called control points. We’ll define these terms 
a little later.

Splines
Splines are lines that are defined by multiple control points. 
The following graphic shows three basic types of splines. The 
simplest type of spline consists of a set of control points connected 
by straight lines, called a linear spline (shown on the near 
right). The other two splines are curved. You can curve a spline by 
adjusting its basis, or method used to compute the spline. Splines 
can be divided into interpolating and approximating.

Figure 2.1

An interpolating spline will always touch the points that define it. 
In the above graphic, the two splines on the left are interpolating. 
This gives them a more drastic skin-like bend than approximating 
splines. Approximating splines, such as the right-most example 
in the above graphic, have a softer curve because they don’t 
necessarily touch the points that define them. Either type of 
spline requires three or more control points in order to show any 
curvature. Poser uses interpolating splines for such things as the 
Walk Designer and the Animation palette.
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Polygons
Polygons are multiple-sided surfaces that use vertices to define 
their corners and edges to define their limits. Most 3D applications 
use triangles (3-sided polygons) and/or rectangles (4-sided 
polygons). Groups of polygons form a polygonal mesh, 
which alone or with other meshes defines a mesh object. Let’s 
reexamine the box example we used above: In this example, the 
point cloud consists of eight vertices. These eight vertices are 
connected by 12 edges, which define six rectangular polygons. Had 
we used triangles, the eight vertices would be connected by 18 
edges, which would define 12 polygons.

Figure 2.2
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Chapter 3: More 3D Elements
We have just a few more basics to cover before diving into the 
actual tutorials.

The Poser Workspace
The Poser workspace (you’ll see this referred to throughout this 
manual) is the virtual 3D world in which you build your scenes. This 
world contains an origin and the three axes. 

The Document window acts as the viewfinder for the currently 
selected camera. By looking through this viewfinder, you can 
see the workspace. Please refer to the Poser Reference Manual, 
Chapter 5: The Document Window on page 60 for more 
information about the Document window.

Normals
A surface normal is a line (vector) that points perpendicular to 
(away from) the surface it originates from. Since models have more 
than one surface, knowing which way the normals are facing can 
help you understand how a particular function will affect a model. 
This is important when rendering a model or for calculating other 
operations such as a collision (determining if two objects are 

residing in the same 3D space). If a model’s normals are inverted, 
certain routines may behave erratically or your model may render 
incorrectly. Poser allows you to control the direction of the normals 
and automatically performs these calculations for you.

Figure 3.1

Camera
The Camera is a default object. This means that it always exists 
and cannot be deleted. However, the camera is an object like any 
other and can be moved and animated. Additionally, you can apply 
many different settings to the camera including its position, 
angle, perspective, and focal length. These are standard 
photography terms. Object animation rules apply to the camera.
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Lights
A light source is a special kind of primitive. When Poser launches, 
it places three default lights in your scene. You can add, edit and 
remove lights in your scene and can also control and animate many 
settings such as color, intensity, position, shaders (gels), etc.

Hierarchy
Poser objects are often grouped in a hierarchy in order to 
facilitate manipulation. The original object is known as a parent, 
and each object linked to it is known as a child. The graphic shows 
an example of a simple hierarchy. In this example, the trunk is the 
parent. The branch is a child of the trunk, the twig is a child of the 
branch, and the leaf is a child of the twig. Selecting and moving the 
trunk will also move the branch, twig, and leaf. Moving the branch 
does not affect the trunk but moves the twig and leaf, and moving 
the twig moves the leaf without affecting the branch or trunk. 
Selecting the leaf only moves the leaf. 

Figure 3.2

Let’s try another example: Bend your arm at the shoulder. Notice 
that your shoulder rotation moves your upper arm, lower arm, wrist, 
hand, and fingers. In this case, your upper arm is a child of your 
shoulder and so forth. Now try bending a finger. Your hand, wrist, 
arm, and shoulder do not move. 

Animation
Poser lets you animate virtually everything in your scene including 
objects, lights, materials (which can have a shader tree containing 
one or more nodes), and the camera. Each scene item has different 
settings (parameters) that can also be animated. For example, 
you can animate an object’s scale, rotation, translation, and shape, 
or a light’s color, position, and intensity (Poser calculates shadows). 
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You can animate any component of an object’s material. Plus, 
you can animate the camera’s position and rotation. Creating 
animations involves making changes to these parameters over time 
and assigning these changes to keyframes.

Keyframing
Animations are made up of individual images known as frames. 
An animation is created when a series of frames that vary slightly 
from one frame to the next are displayed one after another over 
time.

Keyframing is the core of computer animation and involves the 
following general process: First, a starting frame is created on a 
timeline and all parameters for each object in a scene are assigned 
to that frame. Next, an ending frame is created later on the timeline 
and all changes to any parameters are assigned to this frame. Poser 
then compares the parameters assigned to the starting and ending 
frames and calculates all of the intermediate frames that occur 
between the starting and ending frames. This calculation is called 
interpolation.

For example, if you tell Poser that an object is large and red at 
Frame #1 then small and blue at Frame #10, then Frames 1 and 10 
become the keyframes. Poser then calculates the intermediate 
values for all of the frames in between the keyframes. Thus, as 
the animation moves from Frame 1 to Frame 10, the large red 
ball will gradually shrink and turn blue with each passing frame 

until it reaches the values you set for it at Frame 10. Keyframing 
and interpolation allow you to create complex animations with a 
minimum amount of work.



Poser 8
Tutorial Manual 

16

Chapter 4: Groups

Chapter 4: Groups
This section describes how Poser differentiates between body part 
groups, material groups, and other group types on a figure or prop. 
This explanation is specific to Poser, however it will provide you 
with the background information you need in order to understand 
groups in general.

The following examples use the Alyson Casual figure (available 
in the Poser 8 Content palette’s Figures category). Add this 
figure to your scene by dragging from the Library to the document 
window, or by clicking the Apply to Scene or Add to Scene 
button at the bottom of the Library palette, as described in the 
Poser Reference Manual, Loading and Managing Items using the 
Library Icons on page 93). When you display the figure in Outline 
display mode and hover your mouse over the various body parts, 
you’ll see an outline of the group underneath the mouse. We have 
color-coded the groups for clarity in the following figure.

 Please remember that each figure/prop is different, 
having different body parts, materials, hair, and cloth groups. 
Further, the groups themselves may be arranged in different 
orders. However, the concepts explained here are the same for 
each figure/prop. 

Poser figures consist of named body parts that can be selected and 
articulated (or posed). Props normally consist of a single part 

that cannot be articulated, although poseable props do exist. The 
following graphic depicts an example of Poser body parts:

Figure 4.1

The example displays several body parts: head, left eyeball, right 
eyeball, neck, chest, left collar, right collar., left shoulder, right 
shoulder, and abdomen Each of these body parts can be articulated 
(posed).

Each body part (or group) consists of one or more polygons.
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As hinted above, there are several different types of polygon 
groups: body part groups, material groups, hair groups, and cloth 
groups for example. A polygon can belong to more than one type 
of group (such as a body part group and a material group, or a 
cloth group and a material group). A polygon can only be in one 
group of each type at a time. Thus, the following group 
combinations are possible:

One body part may have one material assigned to it. For •	
example, the neck will probably have the “skin” material.

Two or more body parts may use the same material. For •	
example, the fingers may all use the “skin” material.

One body part may use more than one material. For example, •	
each eyeball may have separate materials for the eyeball, iris, 
and pupil.

In addition to the above, a polygon may be part of a hair •	
group and/or a cloth group. Figure 4.2

Since body parts and materials are the most obvious forms of 
grouping, let’s use them to illustrate grouping as a whole since the 
same concepts apply to hair and cloth groups as well. The graphic 
displays the material assignments for the above-displayed body 
parts.

You can see that the head, neck, and portions of the chest use 
the skin material. The chest and collars use the shirt material. The 
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eyes use eyeball, pupil, and iris materials. The head uses several 
materials including skin, lips, and eyebrows.

Figure 4.3

The important things to remember are:

Poser groups polygons by body part, material, hair, and cloth, •	
and these groups are independent of each other.

Each material in a figure/prop gets assigned a unique •	
numbered ID, and that ID is in turn used by a polygon to 

specify which material should be applied to that polygon. 
For example, the skin material may have ID 1, the shirt ID 2, 
etc. Each polygon in a figure/prop includes the ID number of 
the material assigned to that polygon. Changing a material 
itself will affect the appearance of all polygons that have the 
corresponding material ID. For example, if one made the skin 
green, then all polygons with the “skin” material ID would 
turn green regardless of the body part.

The following table depicts a partial list of the relationships 
between body parts and materials in the Alyson Casual figure:

Body Part Assigned Material(s)
Head Head, Nostrils, Lips, EyeSockets, 

Lacrimals, InnerMouth, TearLine, 
EyelashesBottom, EyelashesTop, 
Teeth, Gums, Tongue

Eyeballs (left and right) EyeballLeft, IrisLeft, PupilLeft, 
CorneaLeft, EyeballRight, IrisRight, 
PupilRight, CorneaRight

Neck Body

Collars (left and right) Body, Shirt

Chest Body, Shirt
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Again, the only relationship between the body parts, materials, 
hair, and cloth is that defined by the figure’s creator. Poser does not 
mandate any such relationship.

Now that we have differentiated between body part and material 
groups and mentioned hair and cloth, let’s describe hair and cloth 
groups in more detail:

Hair Groups
Hair groups are groups of polygons that can also belong to any 
body part, prop, and material group. Polygons that are part of hair 
groups can have real 3D hair grown on them. Please refer to the 
Poser Reference Manual, Chapter 24: The Hair Room on page 371 
for more information about the Hair room.

Figure 4.4

Cloth Groups
Poser’s Cloth room allows you to create realistic cloth that you can 
use for almost any purpose in your scene. Cloth groups are actually 
vertex groups, meaning that they are groups of vertices instead 
of polygons, however this makes little difference in the overall 
discussion. Vertices belonging to a cloth group cannot belong to a 
body part group. 

Here is an example of a figure wearing dynamic cloth, which 
consists of props with named groups. See how the cloth realistically 
drapes and moves as the figure moves: 

Please refer to the Poser Reference Manual, Chapter 25: The Cloth 
Room on page 385 for more information about the Cloth room.

Figure 4.5
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Chapter 5: Multi/Sub-object 
Materials
Each figure/prop has its own unique material list containing 
individual materials within that list. You can see this for yourself by 
creating a Poser scene with two or more figures/props and opening 
the Material room.

Figure 5.1

This sample scene has two figures (Alyson Casual and Ryan 
Casual). The Material room therefore displays the following 
selections:

Figure 5.2
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As you can see, the two figures in this image each have different 
materials lists. Each object in a Poser scene has its own list of 
materials, which is different for each object. These lists of materials 
behave like a multi/sub-object material list/table.

Why Multi/Sub-object 
Materials?
The purpose of having more than one material per figure (multi/
sub-object materials) is to provide each polygon with a different or 
shared material property with other polygons. This gives you control 
over material properties down to the polygon level.

A side benefit is that multi/sub-object materials also allow great 
flexibility. For example, if you have a scene with multiple figures, 
each figure can have its own skin and clothing colors. Selecting 
one figure or prop displays only the materials assigned to just that 
figure/prop, which organizes your materials and prevents possible 
confusion. Also, if you save a figure or prop to the Library palette, 
its materials will be saved as well, thereby preserving your work.

Color
Color is easy. By applying a color to an object or material group, 
you are essentially dumping a bucket full of paint on that object or 
group. Color goes a long way toward establishing the final look of 

your object but it doesn’t tell the whole story. For example, painting 
an apple red is obvious, but the simple red color does not contain 
the other colors and shades, nor does it portray the apple’s small 
imperfections and other features. Thus, a material that simply uses 
color ends up looking plastic.

About Maps & Templates
Look at your own skin. Notice the differing colors, hairs, veins, 
moles, and other features. Look at any object. Is it smooth or 
rough? Opaque or transparent? If transparent, does it have the 
same transparency all over or in portions? Is it matte or glossy? 
Is it reflective? What sort of texture or pattern does it have? Now 
look at the objects around you. They all have different material 
properties. How can you capture these properties in your 3D 
objects? One answer is mapping. Each object in your Poser 
scene can have its own maps, which are used for specifying various 
attributes. Maps provide an efficient way to add advanced effects to 
your objects. For example, if you had to model every wrinkle, mole, 
eyelash, hair, or other feature, your object’s polygon count (number 
of polygons) would quickly become prohibitive. In fact, most of the 
3D figures and other objects you see in feature films have relatively 
low polygon counts and make extensive use of mapping.

As you know, most maps are two-dimensional representations 
of 3D surfaces. Each point on the Earth’s surface that lies within 
the map’s area of coverage corresponds to a point on the map. 
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Depending on the area being mapped and the mapping method 
used, the map may or may not resemble the actual surfaces it 
represents. This effect is called distortion and is most easily seen 
on world maps created using the Mercator projection. We could 
spend a lot of time on this, but the important things to remember 
are that:

Maps are 2D representations of 3D surfaces.•	

Each coordinate (location) on the 3D surface corresponds to a •	
location on the map.

The map may or may not resemble the 3D surface.•	

Here is a sample map template for a Poser figure:

Figure 5.3

The grid-like lines on the map correspond to the polygons on the 
figure mesh object itself. Blank areas do not correspond to any 
part of the figure and are ignored. Thus, you can “color outside 
the lines” without ill effect, since only color falling within the lines 
actually appears on the figure.

Maps used for figures normally use the UV coordinate system 
where the upper left corner corresponds to 0,0 and the bottom 
right corner to 1,1. Thus, the exact center of the map would be at 
0.5,0.5. For any given object, you start with the blank template 
shown above and modify it depending on the type of map you are 
creating.

Bump Maps
A bump map is used to simulate roughness on a surface. Bump 
maps are grayscale images where dark gray/black signifies lower 
areas and bright white/light gray areas signify higher areas. They 
work by shifting the object’s normals to give the illusion of depth. 
On a human figure, a bump map allows you to simulate wrinkles 
and other imperfections/textures.
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Figure 5.4

Transparency Maps
A transparency map is like a bump map in that it is a grayscale 
image. Transparency maps regulate the amount of opacity in a 
given location. The darker the color is, the greater the transparency, 
and vice versa. Here’s a sample transparency map for eyelashes.

Figure 5.5

Look at the bump map, above. The lighter colored areas around 
the eyelashes indicate that they should have height, that is, they 
should stand out from the figure itself. The texture map (see Texture 
Map on page 25﻿) specifies the lashes’ color as rough smears. The 
transparency map above allows only those portions of the texture 
map corresponding to the lighter areas to show through. The 
combined effect is eyelashes that stick out from the eyes. Where 
there are no eyelashes, you can see the skin beneath them. This is 
a great example of how combining maps can create very realistic 
effects.
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Reflection Map
Reflection maps are also grayscale. As the name implies, they 
are used to differentiate areas of varying reflectivity. The use of 
reflection maps allows you to, for example, create a patterned 
mirror where the patterns have a higher or lower amount of 
reflection.

Displacement Map
Displacement maps are very similar to bump maps but with a key 
difference: Instead of simply shifting normals, displacement maps 
actually move (displace) an object’s geometry. Thus, displacements 
provide more “real” depth than bump maps. Displacement occurs 
at render time, meaning that objects will look smooth until 
rendered.

Texture Map
All map types (bump, transparency, etc.) are 2D representations 
of 3D objects, and texture maps are no exception. Texture maps 
are the primary way of making 3D objects look real. Texture maps 
make skin on your Poser figure look real, add realistic grain to 
wood, etc. The following example shows a texture map for one of 
the Poser figures:

Figure 5.6

You can use shader elements such as color to get an effect without 
using texture maps, but you won’t be able to precisely place 
features where you want them (such as painted fingernails on the 
ends of the fingers).

 Texture maps are fully colored, unlike the grayscale 
example shown above.
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Procedural Shaders
Poser’s FireFly rendering engine supports the use of procedural 
shaders (or shaders for short). Shaders consist of a root 
node that can be modified by adding additional nodes that 
modify one or more of the root node’s values. A node’s output can 
modify one or more nodes, and you can use more than one node to 
influence another. You can include all of the maps we’ve discussed 
above when building shaders. You can also create realistic materials 
that don’t require any maps at all, or you can have other nodes 
modifying any maps you decide to use. Thus, shaders are a second 
method of creating materials that may or may not integrate 
maps. Please refer to the Poser Reference Manual, Chapter 13: 
The Material Room on page 203 for information about Poser’s 
Material room.

Putting It All Together
The following image demonstrates the results you can achieve by 
combining the various types of maps.

Figure 5.7
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Chapter 6: The Basics
The following set of lessons is designed to help you learn the basic 
operations in Poser. They cover topics such as working with posing 
and scene development tools. 

Lesson 1: Working with the 
Cameras
You can access the cameras in Poser in several different ways. 
An often overlooked method of selecting a camera is by using 
keyboard keys. Learning a few key commands can make viewing a 
figure much easier.

Poser’s camera is modeled after the Conical camera type. There 
are two types of cameras in Poser: Conical and Isometric. Conical 
cameras (such as the Main, Hand and Face cameras) act like real-
world cameras in that they display perspective. Isometric cameras 
(such as From Top, From Left, etc.) have no perspective. When you 
view figures using Isometric cameras you won’t be able to rotate 
around the workspace. 

Each camera has its own center; it centers on and rotates around 
an object. For example, the Right Hand camera rotates around the 
Right Hand, and the Face camera rotates around the face. Both 
cameras face the center directly unless you intentionally redirect 

them. By default the camera rotates around the center of the 
workspace; you can, however, assign it to rotate around a specific 
object within the scene.

Refer to the Poser Reference Manual, Chapter 11: Cameras on 
page 169 for more on Poser’s cameras.

In this lesson you’ll explore the Poser workspace using the various 
cameras.

 Unless stated otherwise, the tutorials in this chapter 
use the Alyson Casual figure, located in the Poser 8 Content 
subcategory of the Figures library.

To view your figure using the Main camera:

Hold down the Command/Ctrl-M. The view switches to the 1.	
Main Camera. Start with a figure placed in the center of your 
Document window. 
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Figure 6.1: The view from the Main camera.

Move your cursor over the 2.	 Trackball in the Camera controls. 

Figure 6.2

Click and drag from left to right over the 3.	 Trackball. Then drag 
from right to left. 

Figure 6.3 The new view of the workspace.
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You’ll notice that the Main camera points at the center of the 
workspace. You can change this default behavior by linking the 
camera to an object in the workspace.

To link a camera to an object:

Make sure that the Main Camera is the currently selected 1.	
object.

Check the 2.	 Current Figure and Current Actor menus at the 
top of the Document window. They should list Alyson Casual 
and Main Camera. If not, click the menu and select the Main 
Camera.

Choose 3.	 Object > Point At.

The 4.	 Point At dialog appears. The dialog shows a visual list of 
all the objects in your scene.

Scroll down until you see the Head element. Click 5.	 Head in the 
list and click OK.

The Main camera now points at the Head. In the Parameters 6.	
palette, note the new parameter dial called Point At appears 
at the top of the list of dials.

Figure 6.4: The view of the workspace with the Point At behavior applied.

Move your cursor over the 7.	 Trackball on the Camera controls 
again, and drag down until the camera moves beneath the 
figure. 

Figure 6.5: The new view of the workspace.

No matter where you move the camera, the Head remains in 8.	
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the view. 

With the Point At behavior the camera always points at the target 
object, without changing its position.  By changing the camera’s 
parent, you can automatically move the camera whenever you 
move the figure. 

To change a camera’s parent:

Select the camera that you want to affect.1.	

Choose 2.	 Object > Change Parent. The Object Parent 
dialog appears. 

Choose Alyson Casual’s 3.	 Body from the list.

Click 4.	 OK.

Figure 6.6: The new view from the Main camera using Body as its parent.

Press Command/Ctrl-T to switch to the Top camera. 5.	

Figure 6.7: The view of the workspace from the Top camera.

Click the 6.	 Translate tool. 

Select the figure ring around the Body and move it anywhere 7.	
in the Document window. Do not click directly on the body or 
you will alter the pose.
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Figure 6.8: The repositioned Body.

Press Command/Ctrl-M to switch back to the Main camera 8.	

Figure 6.9: The view of the workspace from the Main camera.

Notice that the view from the Main camera remains the same. 9.	

That’s because the camera moved with the Body when you 
repositioned it. 

Try moving the figure’s body again using another camera and 10.	
switch back to the Main camera. The Main camera returns to 
the same position.

To view the figure using the Face camera:

Press Command/Ctrl-(=) to switch to the Face Camera. 1.	

Figure 6.10: The view from the Face camera.

Click and drag left over the 2.	 Trackball. 

Notice that Face camera always stays with the selected figure, 3.	
no matter where you move the figure. 



Poser 8
Tutorial Manual

33

Chapter 6: The Basics

The Face Camera is ideal for making animations that center on 4.	
a single figure.

To view the figure using the Top camera:

Press Command/Ctrl-T to switch to the Top camera. 1.	

Figure 6.11: The view of the workspace from the Top camera.

The Top camera, like the Left, Right and Front cameras, is an 2.	
Isometric camera, meaning that it doesn’t show perspective. 

It is designed specifically for viewing a pose rather than 3.	
rendering poses. This camera is very useful for placing figures, 
creating animations, and locating Figures and Spotlights you 
may have lost in the workspace. 

Set the Top camera Scale Parameter Dial to 400% or more to 4.	
get a wide view of the Poser workspace.

Figure 6.12: The expanded view of the workspace.

A Note on Focal Lengths 

Poser’s default cameras are set to 25mm and have all the attributes 
of a real-world 25mm Wide Angle Lens. You can experiment with 
other focal lengths such as 50mm, which resembles the human 
eye’s view, and 100mm, a lens favored by Portrait Photographers. 

Each time you set the focal length, the Scale will also reset. Scaling 
down from 100% to 25% zooms in, while scaling up from 100% 
to 1000% zooms out.
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Lesson 2: Tracking Modes
A tracking mode determines how the figure looks as you move it. 
Box Tracking mode displays the figure as boxes all the time. Fast 
Tracking mode displays the figure as boxes during movement, and 
uses the currently selected display style when the figure is still. Full 
Tracking mode displays the figure in the current display style at 
all times.

Tracking modes help you overcome the limitations of your 
computer’s processing speed when posing. Faster computers can 
display better tracking, while slower machines benefit from less 
complex modes. 

In this lesson you’ll learn how to choose a tracking mode.

To set a tracking mode:

Click one of the 1.	 Tracking Mode icons located in the pop-up 
menu at the bottom left of the Document window.

From the top to bottom they are: 2.	 Box Tracking, Fast 
Tracking, and Full Tracking. 

Click each of the mode icons and adjust the figure’s pose. 3.	
Observe how different modes affect response time.

Use the mode that doesn’t slow down your computer’s 4.	
response time.

Figure 6.13
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Chapter 7: Working with 
Lights
Lights are one of the most necessary and least understood part of 
any 3D Program. Often they’re difficult to use. Poser’s remedy is 
unique Lighting controls that let you intuitively manipulate lights.

There are four types of lights available in Poser: Infinite lights, 
Point lights, Spotlights, and Diffuse Image Based Lighting (IBL). To 
use them effectively, you first need to understand the differences 
between them:

Infinite light illuminates one side of everything in the scene •	
in the same way sunlight does. Poser’s default light set uses 
three infinite lights.

Point lights emit light from a single point outward in a 360-•	
degree radius.

Spotlights point in a single direction and illuminate everything •	
that falls within the cone of light they produce. When you 
create a new light, the Spotlight type is automatically created.

Diffuse Image Based Lighting uses a 360-degree light •	
distribution map, or light probe, to illuminate the scene.

Lesson 1: Using the Light 
Controls
You’ll begin this lesson by deleting two of the three default lights 
in the Poser scene and learning the controls.

To use the Light controls:

On the Light controls, select the circle for the light you want 1.	
to delete.

Figure 7.1: Each light in the workspace is represented by a circle on the Light 

controls. This example shows a selected light.

Click the 2.	 Delete Light icon. The selected light is deleted. 
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Figure 7.2

Select another light and repeat step 2.3.	

Select the remaining light. Click and drag over the control 4.	
from left to right. Note how the Light Indicator (representing 
the global light) revolves around the figure. The arrows of the 
indicator show the direction from which the light comes. 

 There is a quick way to delete all lights in your scene. 
From the Scripts menu, choose Utility > deleteLights. 
When a dialog asks if you are sure, choose OK. All lights in 
your scene will be removed.

Figure 7.3: The Light Ring in the Document window.

 You can use the Rotate Tool to manipulate the Light 
Indicator directly in the Document window.

The Light Intensity slider on the Lighting controls has a range 
from 0% to 100%. It acts as the brightness control, or dimmer. The 
midway point of the slider is 75%.

The parameter dials also let you control some of the light’s 
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parameters. Refer to the Poser Reference Manual, Chapter 12: 
Lighting on page 185 for more on lights. 

Next you’ll add a spotlight to the workspace.

To add a spotlight:

Click the 1.	 Create Light icon. A new spotlight appears on the 
Light controls. The color of the new light is selected at random.

Figure 7.4

Drag the new light’s circle to locate it approximately front and 2.	
center. This places the light in front of the figure. 

Figure 7.5 The position of new light on the Lighting controls.

Use the Intensity slider to set the 3.	 Light Intensity to 
approximately 75% (near the middle of the slider). 



Poser 8
Tutorial Manual 

38

Chapter 7: Working with Lights

Figure 7.6: The Light Intensity slider set to 75%.

Select the 4.	 Object > Create Light > Spot menu option.  A 
new spotlight is created.

Figure 7.7

  You can change any light type at any time. Select the 
light you want to change, and then open the Properties palette. 
Select Spot, Infinite, Point, or Diffuse IBL from the available 
choices at the top of the palette.

Figure 7.8: The Spotlight option on the Light Properties palette.

You now have a new spotlight, you can control how it behaves by 
applying the Point At function to it. 

To apply the Point At behavior to a light:

Make sure your new spotlight is the selected element.1.	
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From the menu bar, choose 2.	 Object > Point At.  The Point At 
dialog appears. 

Choose your figure’s 3.	 Head from the hierarchy list.

In the Parameters palette, set the Tran values for the light to 4.	
the following. This moves the spotlight’s indicator to behind 
the figure and near the floor. Notice how it remains pointed at 
the Head:

xTran�� : -4.000

yTran�� : Between .900 and 1.000

zTran�� : -4.000

Figure 7.9: The Spotlight’s indicator in the Document window.

Adjust the values of the x, y or zRotate parameter dials to 5.	
experiment.  You’ll notice that the spotlight doesn’t rotate like 
an infinite light. Infinite lights rotate around the center of the 
workspace. Spotlights rotate around the center of the light 
object. 
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Chapter 8: Using Poser’s 
Tools
The lessons in this section teach you how to work with the most 
commonly used Posing tools and the parameter dials.

Lesson 1: The Parameter Dials 
The simplest way of posing a figure is by selecting each individual 
part, and using the parameter dials to move it into the desired 
position. 

A much faster way of posing is to use the four main posing tools 
directly on the figure in the Document window. However, this 
method requires considerable practice. 

This lesson leads you through the process of posing a figure using 
the parameter dials. 

To pose by typing in numerical values:

With Alyson Casual in your scene, select the 1.	 Translate/Pull 
tool from the Editing tools, and click the Right Shoulder in the 
Document window.

Figure 8.1: The Right Shoulder selected on the figure.

A series of parameter dials appear in the Parameters palette. 2.	

Click the value on the 3.	 Up-Down dial and type 80 in the field 
that appears.

Figure 8.2: The Up-Down dial.

The whole right arm should now be at the figure’s side.4.	
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Figure 8.3: The new position of the right arm.

To pose using the dials:

Select the Left Shoulder1.	

Figure 8.4: The left shoulder selected.

In the Parameters palette, select the 2.	 Up-Down dial and drag 
the slider toward the left until the value shown is at or near 
-80. The left arm should be at the figure’s side.

Figure 8.5: The new position of the left arm.

 Notice that for the left shoulder, the downward bend 
value is negative, for the right shoulder, the value is positive. 
This is generally true when working with a figure; left is 
negative and right is positive. You’ll notice similar behavior for 
the Front-Back parameter dial in the Left and Right shoulders.
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Lesson 2: The Rotate Tool
The Rotate tool is probably the most useful tool for directly 
manipulating your figures. Unlike the Translate tools, it only 
affects the individually selected part. 

In this lesson you’ll use the Rotate tool on the Forearms.

To pose using the Rotate tool:

First, switch to the 1.	 From Left camera by pressing 
Command/Ctrl-( ; ). You are now looking at the figure’s right 
side.

 Becoming used to quickly changing cameras makes 
posing a much simpler task. Many of the Poser cameras have 
keyboard shortcuts. Press the Command/Ctrl key plus the key 
shown in parenthesis following to change to Main (M), From 
Left ( ; ), From Right ( ‘) , From Top (T), From Front (F), Face 
(=), Posing (,), Right Hand ([), Left Hand (]), Dolly (/), and Fly 
Around (L).

Click the 2.	 Rotate tool. 

In the 3.	 Document window, select the Right Forearm.

Figure 8.6: The selected Right Forearm.

Place the cursor directly over the selected forearm, then click 4.	
and drag to the right until it is extended in front of the figure. 

Figure 8.7: Drag to the right until the arm is in the position shown.

Press 5.	 Command/Ctrl-( ’ ) to switch to the From Right 
Camera. You are now looking at the left side of the figure.
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Figure 8.8: The figure shown through the From Right Camera.

Select the Left Forearm with the 6.	 Rotate tool.

Figure 8.9: The selected Left Forearm.

Place your cursor behind the figure and drag to the left. The 7.	
Forearm bends up.

Figure 8.10: Drag left until the forearm is in the position shown.

Place the cursor to the left of the figure and drag up. The 8.	
Forearm follows

Figure 8.11: Drag up until the forearm is in the position shown.
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 Now you have used two methods of working with the 
Rotate tool. You can use the tool directly on the selected part, 
or you can drag the tool across the workspace and the part 
will follow. This is true of all four main Posing tools: Rotate, 
Twist, Translate/Pull and Translate In/Out.

Lesson 3: The Twist Tool 
The Twist tool does exactly what its name implies, it twists body 
parts. This is accomplished by selecting the part and drawing the 
tool across the screen. It is an extremely useful tool for creating 
realistic poses quickly. 

To use the Twist tool:

First, press 1.	 Command/Ctrl-M to switch back to the Main 
Camera. Select Edit > Restore > All to reset the figure and 
camera to the default positions.

Figure 8.12: The figure shown through the Main Camera.

With Alyson Casual’s 2.	 Body selected, select the Twist tool. 
Click the faint circle that surrounds the figure. The circle turns 
white.

Figure 8.13: A figure with the Figure ring highlighted.

Beginning with the cursor placed over the figure circle, drag 3.	
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your cursor toward the right side of the Document window 
until you see the figure at a three quarter face.   Check the 
yRotate dial value. It should be at about 45 degrees.

Figure 8.14: The rotated figure.

Use the 4.	 Figure > Use Inverse Kinematics command to 
turn Inverse Kinematics on for the Right Leg and Left Leg if 
necessary, before continuing with the next step. 

Select the Hips with the 5.	 Twist tool. Drag to the left until the 
figure is once again directly facing the camera.

Figure 8.15: The Hips selected with the Twist tool.

Select the Neck with the Twist tool and drag to the right. The 6.	
Twist dial should be near 16 degrees.

Figure 8.16: The selected Neck.

Select the Head with the Twist tool and drag to the right.  The 7.	
Twist dial should be near 16 degrees.
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Figure 8.17: The final position of the Head.

Lesson 4: The Translate Tools
The Translate/Pull, and Translate In/Out tools are some of the 
most powerful direct posing tools available to you. Used together, 
they can quickly generate any pose. Once you have a pose, you can 
then fine-tune the pose using the parameter dials. In this lesson, 
you’ll explore posing using just these tools.

To pose using the Translate/Pull tool:

First, save anything you wish to keep from the last tutorial, 1.	
and create a new document (File > New). Load Alyson 
Casual into the scene.

Select the 2.	 Translate/Pull tool. 

In the 3.	 Document window, select the Hips. Drag up to lift the 
figure onto the tips of her toes.

Notice that the feet begin pointing down until it looks 
like the figure is completely in the air. This is because IK 
(Inverse Kinematics) is applied to the legs.

Basically, IK sets up dependencies between parts of 
a figure to simulate more realistic movement. In this 
case, each part of the leg is dependent on another to 
determine movement. for example, when the Thigh 
moves, the Shin follows. You can turn IK on and off 
depending on your needs. Refer to the Poser Reference 
Manual, Chapter 9: Posing Figures on page 122 for a 
complete discussion of IK.

Figure 8.18: The selected Hips
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Figure 8.19: Drag up until the figure is in the position shown.

With the Hips selected, lower the figure so that its toes touch 4.	
the Ground plane.

Figure 8.20: Drag down until the figure is in the position shown.

Select the Right Forearm.5.	

Figure 8.21: The selected forearm.

Pull the Forearm to the right, then up and down. Notice that 6.	
this movement affects more than just the Forearm. You’re 
pulling the figure all the way down to the Abdomen. 

Next, you’ll explore using the Translate In/Out tool.

To use the Translate In/Out tool:

Click the 1.	 Translate In/Out tool. 

Select the Right Foot2.	
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Figure 8.22: The Right Foot selected.

Drag up. The Right Foot and leg move away from you3.	

Figure 8.23: The position of the Right Foot after the move.

Select the Chest and drag down. The figure appears to bow.4.	

Figure 8.24: The new position of the Chest.

Press Command/Ctrl-Z to undo the last command.5.	

Choose 6.	 Figure > Use Inverse Kinematics > Left Hand 
and again with the Right And to turn IK on in the arms. IK is 
enabled when a checkmark appears next to a menu item. 

Select the Chest again and drag down.7.	

With IK turned on, the Hands resist movement when you 8.	
translate a body part that affects them. It appears as if they 
are holding onto something.



Poser 8
Tutorial Manual

49

Chapter 8: Using Poser’s Tools

Figure 8.25: The position of the figure with IK turned off.
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Chapter 9: Posing
In this section you’ll learn several ways of posing that expand on 
what you have learned in the previous sections.

Lesson 1: Creating Poses
In this lesson, you’re going to use everything you’ve learned so far 
about Poser’s tools to create a simple, yet realistic pose: Hands on 
Hips. You’ll use the tools as well as the Symmetrical command to 
quickly set-up the pose. 

Keep in mind that although the human body looks symmetrical, it’s 
rarely positioned in a symmetrical manner. Even a very symmetrical 
pose like placing both hands on your hips may not look entirely 
natural if you just reverse the values from left and right. That’s why 
you’ll also use the tools to set up a more natural position for the 
figure’s limbs.

Posing using the Editing Tools can be somewhat imprecise for the 
new user; you may want to use the parameter dials to reposition 
body parts. The parameter dial values used in the pose are listed so 
you can duplicate it using only the dials.

Once you achieve the pose described here, use what you’ve learned 
to make additional adjustments so that the final pose looks right 
to you. 

To position the right arm:

Create a new scene and load Alyson Casual. Then select the 1.	
Twist tool. 

Place the 2.	 Twist tool over Right Shoulder in the Document 
window. Drag right so that the arm twists to 45°. The Right 
Shoulder’s Twist parameter should be set at approximately 
45°.

Figure 9.1: The Right Shoulder should be in the position shown. 

Select the Right Forearm and drag right.  The Twist dial should 3.	
be at 14°.
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Figure 9.2: The Right Forearm should be in the position shown.

Select the Right Collar and drag right.  The Twist dial should 4.	
be at 25°.

Figure 9.3: The Right Collar should be in the position shown

Select the 5.	 Rotate tool.  Select the Right Hand and drag right 
to bend the Right Hand. The Bend dial should read about -75°.

Figure 9.4: The Right Hand after positioning.

Select the Right Forearm. In the Parameters palette, set the 6.	
Bend dial to 95° and the Side-Side dial to 5°. 

Figure 9.5: The new position of the Right Forearm.

Using the 7.	 Rotate tool, select the Right Shoulder. Set Up-Down 
to 26°. 
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Figure 9.6: The new position of the Right Shoulder.

Select the Right Collar. Set Up-Down to 23°. 8.	

Finally, select the Right Hand. In the Parameters palette, locate 9.	
the Hand Controls section of Parameter dials. Set the Grasp 
dial to 26.

Figure 9.7: The repositioned Right Collar.

Once you’re done, your parameter dials should read as follows:

Right Collar:•	

Twist = 25°��

Up-Down = 23°��

Right Shoulder:•	

Twist = 45°��

Up-Down = 26°��

Right Forearm:•	

Twist = 14°��

Side-Side= 5°��
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Bend = 95°��

Right Hand:•	

Bend = -75°��

Grasp = 26��

To apply the right arm pose to the left arm:

From the Menu bar, choose 1.	 Figure > Symmetry > Right 
Arm to Left Arm. A dialog will appear asking if you want to 
copy the joint zone’s setup also. Click No.

Click the Left Hand, and adjust the Grasp dial in the 2.	
Parameters Palette to -20.

Figure 9.8: The symmetrical pose.

This will be a good time to save the file. Choose 3.	 File > Save 
and save to the folder and filename of your choosing.

Your pose is almost finished, but it still looks a little unnatural. Next 
you’ll shift the figure’s weight.

To achieve a natural standing position:

Click the 4.	 Translate/Pull tool.

Select the Right Foot.5.	
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Drag left so that the figure appears to be placing its weight 6.	
on the left leg. 

Figure 9.9: The repositioned foot.

To turn Inverse Kinematics off for the hands, choose 7.	 Figure 
> Use Inverse Kinematics > RightHand. Then choose 
Figure > Use Inverse Kinematics > LeftHand. Both 
hands should be unchecked.

Choose the 8.	 Twist tool and select the Abdomen. Drag left so 
that the Twist dial reads -10°.

Figure 9.10: The repositioned Abdomen.

Select the Chest.  Drag left so that the Twist dial reads -10°9.	



Poser 8
Tutorial Manual

55

Chapter 9: Posing

Figure 9.11: The finished pose.

Lesson 2: Adding Poses to the 
Poses Library
Once you create a pose, you can add it to the Library for future 
use. For easy access, you’ll also create a new category for your 
custom poses.

To add a pose to the library:

Click on the 1.	 Library tab then select the Poses category. The 
Poses subcategory folders are listed.

Figure 9.12.

Click the down arrow to the right of the Poses title at the top 2.	
of the Poses Library. This opens the Library Options menu. 
From this menu, choose Add New Category.

Figure 9.14: The Sub-Category menu.
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A Save dialog appears. 3.	

Enter a name for your personal 4.	 Library subcategory and press 
Enter.

A dialog appears asking if you want to save a single frame or 5.	
a multi-frame animation. Select single frame and click OK.

A new category appears in the palette.6.	

Click the 7.	 Add to Library (+) icon at the bottom of the 
palette to add a custom pose.

Figure 9.15: The Add to Library icon.

Enter a name for the pose, such as Hands on Hips or Posed 8.	
Arms 01.

Press Enter.9.	

Figure 9.16: The pose saved into a personal category.

Poser creates a 10.	 Library entry which you can use as the base 
for other poses on other figures. However, if you use a figure 
other than the Poser 4 Casual Female, you may need to make 
subtle adjustments to make the pose work correctly. 

Lesson 3: Posing Faces
Facial expressions are created using morph targets. These targets 
alter the shape of the polygon mesh that makes up the figure. 

Many of the parameter dials on the Face have morph targets 
associated with them. When you work with facial dials, you’re 
moving the figure’s geometry towards one or more morph 
geometries. Refer to the Poser Reference Manual, Chapter 28: 
Modifying Figures & Props on page 442 for more on morph targets.
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 The Scale, Translation, Rotation and Taper dials for the 
Face are not morph targets.

To apply preset expressions:

Create a new project and load Alyson Casual.1.	

Press Command/Ctrl-(+) to switch to the Face camera.2.	

Select the Face category in the Library palette. Navigate to the  3.	
folder that stores the face you want to use (for example Poser 
8 Content > Poser 8, Alyson). Select the face you want to 
use to highlight it.

Figure 9.17: The Expressions library.

Select the figure’s head in the 4.	 Document window.
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Figure 9.18: The selected head.

Apply each expression preset by double-clicking on the library 5.	
thumbnail.

Figure 9.19: An expression preset applied to the figure.

As you apply each face, pay attention to the Head’s parameter 6.	
dials. Notice how they change, interacting with each other to 

achieve a desired expression. 

When you examine the dials you’ll see that the mouth has 7.	
more targets than any other part of the face. That’s because 
the mouth can be precisely posed to create subtle expressions.

Figure 9.20: Parameter dials for the mouth.

Keep in mind that dials such as Smile affect primarily the 8.	
upper lip, as opposed to the Frown dial which affects the 
lower lip. Slightly fewer dials apply to the brows—three for 
each. 
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 You’ll notice that for some figures, such as the Poser 
4 Casual Woman, there is no target for a Furled Brow. To 
accomplish this, select the Worry Left and Worry Right dials and 
enter Negative 0.5 in each.

After exploring the facial controls, you’re ready to create your own 
expression. Next, you’ll create the face of an angry woman using 
the target dials.

To create an expression:

Select the head. 9.	

Enter Open Lips= 0.431 to tighten the lips.10.	

Set Smile= -0.128. 11.	

Set Mouth F= 0.152. This pulls in the lower lip.12.	

Set Mouth M= 0.234 to tighten the lips laterally.13.	

Set Blink Right and Blink Left = 0.2 to narrow the eyes slightly.14.	

 Be sure to use the decimal point in each of these 
numbers. If, for instance, you enter -431 instead of -0.431 for 
the Open Lips, you will severely distort your figure—she’ll be 
very angry.

Figure 9.21: The completed expression.

Click the 15.	 Add to Library (+) button at the bottom of the 
Library palette to save the file to the Expression library.
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Chapter 10: Rendering
Rendering is the process of converting your 3D figure into a 2D 
image or animation. There are several options you can set for 
a rendering session. All available options are displayed in the 
Render Settings window.

To set up a rendering session:

Choose 1.	 File > Open. 

Locate the file 2.	 paper-airplane.pz3 in the Tutorials/
BasicPoserOperations folder accompanying your Poser 
installation.

Figure 10.1: The paper-airplane file in the Document window.

Press Command/Ctrl-Y. The 3.	 Render Settings window 
appears. Click on the FireFly render engine tab.

In the Auto Settings tab, slide the Render slider to Draft 4.	
quality, or the next level above. This disables the Cast 
Shadows option and will speed things up.

Click 5.	 Render Now (Firefly). Poser loads textures and then 
performs the render. In true WYSIWYG fashion, what you see 
in the Document window is exactly what is produced. 

Figure 10.2: The rendered file.

Depending on where the main camera was positioned when 6.	
you saved the scene, this view may be exactly what you desire 
for your final render. However let’s assume you’re not satisfied 
with the results.
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To reposition the camera:

Select the Main Camera.1.	

Figure 10.3: The Main camera.

Choose 2.	 Object menu > Point At. The Point At dialog 
appears. 

Select the Teacher figure’s Head element from the list, then 3.	
click OK.

Use the Scale parameter dial to rescale the camera so that 4.	
both figures appear in the screen.

Figure 10.4: Both figures in the scene.

Move the camera using the 5.	 Translate and Move YZ tools 
on the Camera controls. The camera will always point at the 
Teacher.
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Figure 10.5: The view through the repositioned camera.

Now you decide that perhaps the scene would be better 6.	
if the camera wasn’t centered on the teacher’s head. First 
you need to unparent the head from the camera. One quick 
way to do this is to select the Main Camera and go into 
the Parameters Palette. Scroll down to find the Point At 
parameter and set it to 0. 

Now, adjust the view of your scene using the Camera 7.	
Trackball, Camera Controls, and Move XY camera control.  
Your scene should look similar to the following.

Figure 10.6: The view through the elevated camera.

Using the same Draft settings as before, test render the file 8.	
again. 

Figure 10.7: The test render.
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Now that you’ve rendered the scene with the floor showing, 9.	
you might be wondering why the floor disappeared during 
the render. By default, the Ground plane is set with a material 
setting that causes it to only catch and render shadows. 
This allows you to use a photo as a backdrop. To change the 
Ground plane so that it also renders the floor texture, return 
to the Preview tab. Select GROUND from the Current Actor 
menu in the Document window.

Switch to the 10.	 Material room and click the Advanced tab. 
Uncheck the Shadow_Catch_Only option in the GROUND’s 
PoserSurface root node. 

Figure 10.8: The final render.

You can test render again to be sure the floor looks OK. When 11.	
the test render produces good results, open the Render 
Settings window (Command/Ctrl-Y) and move the Quality 
slider up to Final. This enables the Cast Shadows option 
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and increases other render settings for a higher quality render. 
Render the file once more. Final quality renders will take 
longer than draft quality renders.

Figure 10.8: The final render.

There is no set rule for what makes a good render. Success is 
subjective. Poser can produce varied results using its custom 
rendering engine. Try exploring other lighting and rendering options 
using this file and other personal files.
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Chapter 11: Character 
Creation and Animation 

Advanced Tutorials
The following tutorials are designed to be both challenging and 
rewarding. Do not plan on completing these tutorials quickly; work 
methodically so that you become comfortable exercising Poser’s 
most powerful features. 

The scenes you create in these tutorials can be dropped into 
most contemporary films, or can be the centerpiece of a major 
production. The goal is to provide you with experience using 
Poser’s animation tools that will enable you to produce increasingly 
complex and extravagant scenes. 

 At any time while working with these tutorials, feel free to 
experiment. Each section overlaps and explores different features, 
as well as different aspects of the same features. This allows you 
to develop a well rounded understanding of how to accomplish 
desired effects.

Lesson 1: Creating a Clown from 
Scratch
Use of props and texture maps are essential to creating a good 
character. This lesson walks you through the processes of scaling 
body parts, applying props, and texture mapping to create a basic 
clown figure from scratch. 

You’ll also animate your clown and place him in a scene to interact 
with props and other figures.

To select a base figure:

From a new, empty scene, click the 1.	 Figures category on the 
Library palette.

Select the Poser1-5 > Poser 4 Hi subcategory.2.	

Click 3.	 Add to Scene, or drag and drop the Business Man 
thumbnail into the scene to load the figure.
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Figure 11.1: The Business Man thumbnail.

To set figure color:

Click the Smooth Shaded document style icon from the 1.	
Display Style controls.

Figure 11.2: The Business Man thumbnail.

Figure 11.3: The Business Man displayed using the Smooth Shaded document 

style.
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To quickly set all of the parts of the figure to white, you’ll use 2.	
a Python utility that is furnished with Wardrobe Wizard. First, 
choose Window > Python Scripts to display the Python 
Scripts palette.  

Figure 11.4: The colored figure.

Make sure that Figure 1 (the man) is selected as the current 3.	
figure. Then from the Python Scripts palette, choose Wardrobe 
Wizard. A dialog informs you that the script is initialized. 

Choose OK to continue.

Continue in the Python Scripts palette, selecting the 4.	 Utilities 
button, then the Texture button, and finally choosing Set All 
to White. All of the parts of the figure turn white.

Figure 11.3: The colored figure.

To apply a texture map:

 The following tutorial describes the procedure for 
applying a texture map using the Advanced tab of the 
Material room’s Shader window. This process is also possible 
using the Simple tab.
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To apply a custom texture map to a prop or figure in Poser, you will 
need to enter the Material room. 

Click the 1.	 Material tab. The Material room layout appears. 
If necessary, click the Advanced tab to display the advanced 
shader view.

Figure 11.4.

Make sure that the figure or prop you wish to use is selected 2.	
in the Object menu. For the purposes of this tutorial, the 
name will be “Figure 1”. 

Select the particular material you wish to modify from the 3.	
Material menu. We will use the clown’s Jacket material. As 
there is already an image map associated with this material, 

you will see a line linking one or more of the channels in the 
PoserSurface node to a Color_Texture node.

 If no Color_Texture node exists, click on the plug icon 
to the right of a given channel on the PoserSurface node, and 
drag to the right to create a connection. Poser will prompt you 
to select a node type. Select New Node > 2D Textures > 
image_map.

Click the white file name next to the Image_Source listing in 4.	
the node. The Texture Manager dialog will appear.
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Figure 11.5.

In the 5.	 Texture Manager, browse to the image file clown01.
tif in the Tutorials / BasicPoserOperations folder of your 
Poser installation, and click Open. You return to the Texture 
Manager.  Then click OK to return to the Advanced shader 

view.

Select 6.	 Apply to all from the Options menu at the top right 
corner of the Shader window. Poser asks you to confirm that 
you want to apply selected nodes to all materials in the object. 
Click OK to confirm your choice.

Figure 11.6: The new texture map applied to the figure.

Click the Pose tab so that you can see a larger view of your 7.	
scene. Then select the Texture Shaded option from the 
Document Display Style tool to see the results of your 
texture image in the Document window 
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Figure 11.6: The new texture map applied to the figure.

To add a prop:

Click the 1.	 Props symbol at the top of the Library palette. 

Figure 11.7.

Select the 2.	 Poser 8 Content > Primitives subcategory. Select 
the Ball object and click Apply to Scene, or drag and drop it 
into the Document window.

Figure 11.8:The Ball thumbnail.
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Click the 3.	 Color tool. Then click the ball and make it red.

Figure 11.9: The From Left camera icon.

To position the prop:

Drag to the right over the Camera controls until the From 1.	
Left camera icon appears. Alternatively, choose Display > 
Camera View > From Left, or use the shortcut Command/
Ctrl-(;)

Figure 11.9: The From Left camera icon.

Click the 2.	 Translate/Pull tool. Position the ball in front of the 
clown’s face, as shown below. 

Figure 11.10.

With the ball selected, set the Scale dial to 22%.3.	
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Figure 11.11. The scaled ball.

Use the 4.	 Translate/Pull tool to move the ball over the clown’s 
nose.

Figure 11.12: Position the ball over the nose as shown.

Press Command/Ctrl-F to switch to the Front camera.5.	

Check the lateral position of the ball on the nose.6.	

Figure 11.13: The clown displayed using the Front camera.

To set the prop parent:

Choose 1.	 Object menu > Change Parent to display the 
Choose Parent dialog. 

The dialog shows a visual list of all the objects in your scene.2.	

Select Head from the list and click OK. 3.	

Press Command/Ctrl-M to switch to the Main camera.4.	

Review your work from several angles. 5.	

Save the clown to the 6.	 Figures library in the Library palette. 
Refer to “Lesson 2: Adding Poses to the Poses Library” on 
page 54 for instructions.
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Lesson 2: Making the Clown Walk
This lesson leads you through the process of creating and editing 
keyframes to create a walking motion.

You can use this animation later with the Walk Designer. 

Setting the First Walking Frame

To begin you need to set up a starting pose. 

To set up a starting pose:

Make sure your clown document is still open.1.	

Double-click the handle at the bottom of the screen to open 2.	
the Animation controls. 

Figure 11.14: The Animation controls.

Make sure the frame counter is set to 1 of 30.3.	

Press Command/Ctrl-M to switch to the Main camera. 4.	

Select the Right Shoulder.5.	

Figure 11.15: The Right Shoulder selected on the figure.

Set the Bend value to 78°.6.	

Figure 11.16: The bent Right Shoulder.

Select the Left Shoulder.7.	

Set the Bend value to -78°.8.	
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Figure 11.17: The adjusted Left Shoulder.

Select the Abdomen and set Side-Side to 3.9.	

Select the Chest and set Side-Side to 3.10.	

Figure 11.18: The adjusted Abdomen and Chest.

Press Command/Ctrl-(’ ) to switch to the From Right camera.11.	

Click the 12.	 Translate/Pull tool. 

Select the Left Foot and move it forward.13.	

Figure 11.19: The re-positioned Left Foot.

Select the Right Foot and move it back.14.	

Figure 11.20: The final pose.
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 For future reference, a variation of this pose has already 
been saved for you in the Tutorial subcategory of the Poses 
library, under the name “ClownStart”.

Adding Keyframes

Once you have a starting point, you’ll create an action by changing 
the pose over time and saving the changes as keyframes. A 
keyframe stores a point in time where action occurs. Here you’ll 
store changes in foot positions as keyframes to create a walking 
motion. Refer to the Poser Reference Manual, Keyframe Controls on 
page 315 for more on setting up keyframes.

To add frames:

Press Command/Ctrl-M to switch to the Main camera.1.	

Figure 11.21: The clown viewed from the Main camera.

In the 2.	 Animation controls, drag the small triangle (called the 
Scrubber) to Frame 16.

Figure 11.22: The Scrubber at Frame 16.

Choose 3.	 Figure > Symmetry > Swap Right and Left. 

The figure’s left foot moves back and the right foot moves 4.	
forward.
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Figure 11.23: The left foot position swapped for the right foot position.

Click the 5.	 Add Keyframe (+) button to keyframe the new 
position. 

Figure 11.24: The Add Keyframe button.

Move the 6.	 Scrubber to Frame 15. 

Click the 7.	 Add Keyframe (+) button to insert a keyframe.

Editing Keyframes

Now that you have a number of keyframes, you’ll learn how to edit 
them in the Animation palette to create more realistic motion.

To edit frames:

Click the 1.	 Edit Keyframes button.

The 2.	 Animation palette appears. The palette displays all the 
animatable attributes in the workspace and all the keyframes 
you’ve created. Refer to the Poser Reference Manual, Chapter 
21: Animating with Poser on page 310 for more on this 
palette.

Figure 11.25: The Animation palette.

Drag the scroll bar all the way to the top.3.	
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Click the green keyframes for Frame 15 and drag all the way 4.	
to the bottom to select the keyframes for all the attributes. The 
selection is bordered with a white line.

Figure 11.26: All the Frame 15 keyframes selected.

Be sure only the green keyframes of Frame 15 are selected. Be 5.	
very careful not to select anything but Frame 15.

Drag all of selected keyframes to Frame 30. 6.	

Figure 11.27: Frame 15 keyframes moved to Frame 30.

Click the close box in the upper-left corner of the dialog. 7.	

In the 8.	 Animation controls, move the Scrubber to Frame 30.

Figure 11.28: The Scrubber at Frame 30.

Choose 9.	 Figure > Symmetry > Swap Right and Left.
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Click the 10.	 Play button to check your work. 

Figure 11.29: The Play button.

The figure should appear to walk in place.11.	

Saving the Walk

You can save animations as poses to the Library palette. Next, 
you’ll save your completed walk to the Poses library.

To save an animation to the Library:

Open the 1.	 Library palette.

Click the 2.	 Poses button.

Figure 11.30: The Poses icon in the Library palette.

Click the subcategory menu and choose Walk Designer.3.	

Click the Add to Library (+) icon.4.	

Figure 11.31: The Add to Library icon.

The 5.	 Add New Set dialog appears.

Enter the name “Clown Walk” for your animation and click 6.	
OK.

A Save Frames dialog appears.7.	

Enable the Multi Frame option and click OK. 8.	

Figure 11.32: The Save Frames dialog.

Your animation is saved as a 30 frame preset in the 9.	 Walk 
Designer category.
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Figure 11.33: The clown in the Library palette.

Lesson 3: The Walk Designer
The Walk Designer lets you set up various parameters to 
automatically create a realistic walking motion. In this lesson you’ll 
use the file you created in the previous lesson in conjunction with 
the Walk Designer to make your clown move. 

To set up the walk animation:

Choose 1.	 File > New to start with an empty file. 

Open the 2.	 Library palette and click the Figures icon. 

Double-click the clown figure you saved earlier.3.	

The default figure is replaced with the clown. 4.	

Figure 11.34: The clown figure in the Document window.

Choose 5.	 Figure menu > Create Walk Path.

A new path appears in the 6.	 Document window. You may need 
to adjust the camera view in order to see the entire path. You 
should use the “Move Y and Z” tool on the Camera palette to 
adjust the camera.
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Figure 11.35:A new Walk Path in the Document window.

Make sure the 7.	 Scrubber in the Animation controls is at 
Frame 1. 

Open the 8.	 Library palette and click the Poses icon. 

Click the subcategory menu and choose Tutorial.9.	

Double-click the Clown-Start pose to apply it to the clown.10.	

Figure 11.36: The Clown Start pose in the Library.

Display the 11.	 Animation palette. 

Move the 12.	 Scrubber to Frame 30.

In the 13.	 Library palette, double-click the Clown Finish pose to 
apply it.

Figure 11.37: The Clown Finish pose in the Library.

Click the 14.	 Current Actor popup at the top of the Document 
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window and choose Cameras > Top Camera. 

Figure 11.38: The Current Actor menu.

Figure 11.39: The clown viewed from the top.

Set Scale to 400%. You should able to see the entire scene.15.	

Figure 11.40: The scaled view of the clown.

Move the camera up or down to see the whole path.16.	

Select the Walk Path using the 17.	 Translate/Pull tool.

It looks like a slight backward “S” extending out in front of 18.	
the figure.

The path has several small white squares along the gray walk 19.	
path called nodes.
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Figure 11.41: Nodes on the Walk Path.

Select each of the middle two nodes and move them so that 20.	
the path becomes straight. Notice how the pointer changes 
when you position it over the path.

Figure 11.42: Your path should look like the one shown.

Make sure the 21.	 Scrubber is at Frame 30.

Click the 22.	 Current Actor menu at the top of the Document 
window and choose Body.

Drag the clown to the end of the Walk Path. 23.	

Make sure the red figure ring appears before you start 24.	
dragging. The ring indicates that the whole figure is selected. 
Do not click directly inside the Figure ring or you will move the 
figure’s parts instead of the entire figure.

Place the clown over the end of the gray path.25.	

Figure 11.43: The repositioned clown on the path.

To set up a walk in the Walk Designer:

 In order to complete this portion of the tutorial, please 
make sure that the Clown Walk style is in the Runtime > 



Poser 8
Tutorial Manual

83

Chapter 11: Character Creation and Animation 

Libraries > Pose > WalkDesigner folder. If that is not the 
case, you need to copy it there from the folder to which you 
saved it earlier.

Press Command/Ctrl-Shift-S to open the 1.	 Walk Designer.

Figure 11.44: The Walk Designer.

Click the 2.	 Walk button to see the current walk style in action.

Click the 3.	 Stop button to stop the action.

Scroll the 4.	 Blend Styles section of the dialog until the Clown 
walk is visible.

Set Clown to 100%.5.	

Click 6.	 Apply. 

The 7.	 Apply Walk dialog appears.

Figure 11.45: The Apply Walk dialog.

 You are about to apply the walk to the figure. Once 
you’re done with the Walk Designer, the only real way to fix 
errors is to start from scratch (beginning from Lesson 3).

Make sure the following defaults are set in the dialog:8.	
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Start Frame = 1��

End Frame = 120��

Figure = Figure 1��

Walk In Place = Disabled��

Cycle Repeat = Empty��

Path = Path_1��

Always Complete last step = Enabled��

Transition from pose at path start in 15 Frames = Enabled��

Transition to pose at path start in 15 Frames = Enabled��

Align head to = Disabled��
Once all parameters in the Walk Designer are set, click OK.9.	

Click Done to close the Walk Designer.10.	

The new walk is applied to the clown.11.	

Save the file with the name: 12.	 CLOWN-ANI.

Lesson 4: Keyframe Editing
So far, you’ve created a waddling clown that appears to fall over 
something invisible at the end of the Walk Path. There are two 
missing elements: the object the clown fell over, and the cause of 
his fall. By editing the animation and adding props, you can create 
the story behind the clown’s actions.

First. you’ll create a back up file to preserve your work so far.

To create a back up file:

Open the file you saved at the end of Lesson 3.1.	

Choose 2.	 File > Save As.

Rename to the file to 3.	 CLOWN-ANI01.

Now you have a back-up of your original animation.4.	

 Consider using a compression utility to archive the 
original clown-walk.pz4 file. This will save hard drive space 
and prevent future headache’s. You can continue to add 
completed lesson files to the archive as you work through the 
rest of the tutorial.

Next, you’ll set up an animated expression for the clown.

To set up an animated expression:

Click the 1.	 Edit Keyframe button on the Animation controls. 

Figure 11.46: The Edit Keyframes button.
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The 2.	 Animation palette appears. 

Click the Head label on the left side of the dialog.3.	

Figure 11.47: The Head element selected.

Select all the keyframes from 2 to 105.4.	

Figure 11.48: Head keyframes selected.

While still pressing the mouse button, drag up one line to 5.	
include the Neck frames in your selection.

Figure 11.49: Both Head and Neck keyframes selected.

Press 6.	 Delete.

With the frames still selected, click the 7.	 Linear Section 
button. 

Figure 11.50: Linear Section button.

This is important for any expression changes applied face 8.	
during the animation.

Select Head keyframe 1.9.	
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Figure 11.51: Head keyframe 1 selected.

Close the 10.	 Animation palette.

Open the 11.	 Library palette.

Click the 12.	 Expression button at the top of the palette.

Figure 11.52: The Expression icon on the Library palette.

Click the 13.	 Library category popup menu and choose Add 
New Category.

The 14.	 New Category dialog appears.

Enter 15.	 Clown Faces and click OK.

Click the 16.	 Add to Library (+) button to add the clown’s face 
into the library.

Figure 11.53: Your clown face in the library.

Move the 17.	 Scrubber to Frame 105.

Apply the face preset you just saved to the clown.18.	

Next, you’ll add another actor to your scene.

To import a Poser document:

Choose 1.	 File > Import > Poser Document.

An Open dialog appears.2.	

Locate the file 3.	 Trapeze Artist Walk.pz3 in the Tutorials/
BasicPoserOperations folder accompanying your Poser 
installation.

A new figure appears in the 4.	 Document window.
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Figure 11.54: The imported document in the Document window.

Click the 5.	 Current Actor menu at the top of the Document 
window and choose Top Camera. 

Set Scale to 400%.6.	

Figure 11.55: The figures viewed from the Top Camera.

Click the 7.	 Box Tracking icon, as shown below.

Figure 11.56:

Click the 8.	 Play button on the Animation controls

Figure 11.57: The Play button.

While the animation plays, watch the relative positions of the 
figures as they pass each other. At the beginning, they’re walking 
past each other on the right. Then, the clown turns his head to face 
the new figure as he walks. 

To align the figure’s face:

Make sure the 1.	 Scrubber in the Animation controls is at 
Frame 1.

Press Command/Ctrl-T to switch to the Top camera.2.	
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Figure 11.58: The scene from the Top camera.

Use the Twist dial to align the clown’s head to face the 3.	
Trapeze Artist figure.

Figure 11.59: The clown’s head rotated to face the Trapeze figure.

 If you’re having a hard time seeing the position of 
the clown’s head, try expanding the size of the Document 
window using the resize control in the bottom-right corner of 
the window. 

Divide the Twist value in half and reset the Twist dial.4.	

This creates the starting pose for the clown’s head.5.	

Select the clown figure’s Neck.6.	

Use Twist to align the Neck so that the clown’s face is looking 7.	
at the Trapeze Artist figure

Figure 11.60: The head and neck rotated.

Move the 8.	 Scrubber to Frame 50.

Repeat steps 2-6 for Frame 50.9.	

Move the 10.	 Scrubber to Frame 55.

In Frame 55, the Trapeze Artist and the Clown are in the 11.	
process of passing each other. The Clown’s chin should be in-
line up with his shoulder, and his silly grin should be intact. 

Repeat step 2 to 6 for Frame 55.12.	

Next, you’ll twist other body parts to keep the Clown facing the 
Trapeze Artist. You’ll use the same twisting method you used on the 
Head to re-align the Chest and Abdomen.
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To align the figure’s body:

Click the 1.	 Edit Keyframe button to open the Animation 
palette.

Figure 11.61: The Edit Keyframe button.

Select keyframes 56 through 105 of both the Clown’s 2.	
Abdomen and Chest.

Press 3.	 Delete.

Close the 4.	 Animation palette.

 Move the 5.	 Scrubber to Frame 60.

Press Command/Ctrl-T to switch to the Top camera.6.	

Figure 11.62: The scene view through the Top camera.

Click the 7.	 Current Actor menu and choose the Chest.

Use the Twist dial to align the clown’s chest so that its Head 8.	
faces the Trapeze Artist. 

Figure 11.63: The re-aligned chest and head.

Twist should be set to approximately -46.9.	
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Divide the value of the Chest’s Twist dial in half and reset 10.	
Twist to the resulting number.

Click the 11.	 Current Actor menu and choose the Abdomen.

Use the Twist dial to align the abdomen so that the clown 12.	
faces the Trapeze Artist.

Figure 11.64: The re-aligned abdomen shown through the Main camera.

 These are more refinements you can add to this file to 
make the action more realistic: 

Have the clown’s eyes follow the Trapeze Artist as his body 
finishes twisting.

Add hand gestures to both figures.

Use the skills you’ve learned in the earlier parts of the tutorial 
to create these effects.

Lesson 5: Adding the Final Touch
At the end of the Clown animation, the Clown seems to trip and 
fall over an invisible object. To complete the scene you’ll need to 
add a prop.

To add a prop:

Display the 1.	 Library palette. 

Select the 2.	 Props category, as shown. 

Figure 11.65.

Choose the 3.	 Tutorial subcategory from the menu.

Click the Circus Ring. 4.	
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Figure 11.66: The Circus Ring prop in the scene.

The prop is added to the scene.5.	

Now that you have a prop, you can adjust the character’s 
movements to interact with it. 

To add an animation to your scene:

Click the handle at the bottom of the screen to display the 1.	
Animation controls.

The center of the 2.	 Animation controls displays the current 
frame and the total number of frames. 

Click the total number of frames field.3.	

Enter 130 to add ten frames.4.	

Figure 11.67: The total number of frames field.

Click the current frame display and enter 121.5.	

Figure 11.68: The current frame field.

Select the 6.	 Poses category in the Library palette. 

Figure 11.69.

Click the subcategory menu and choose 7.	 Tutorial.

Click the Clown Flop pose.8.	
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Figure 11.70: The Clown Flop pose in the library.

This ten frame animation will be added to your the animation.9.	

 When you’re setting up an animated pose like Clown 
Flop to append to a work in progress, be sure not to move the 
entire Body. Adjust the Hips instead to get the proper motion 
in relation to the last pose created.

Lesson 6: Setting Animated Cameras 
and Test Rendering
In this lesson you’ll use the Dolly camera (the only free floating 
camera in Poser) to render the scene. You could use any camera 
to render, the Main, Auxiliary, Posing, and Head cameras are all 
good choices for rendering. However, the advantage of the Dolly 
camera is that it stays true to its own center, making it useful for 
animations. 

When you’ve completed the lesson, try experimenting with the 
other cameras, especially the Head and Posing cameras.

To position the Dolly camera:

Select the Dolly Camera from the 1.	 Camera controls.

Figure 11.71: The Dolly camera icon.
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In the 2.	 Animation controls, move the Scrubber to frame 120.

Using the Move X and Y control, move the camera back until 3.	
the Clown is in full view.

Figure 11.72: The readjusted view.

Choose 4.	 Animation > Make Movie. 

The 5.	 Make Movie dialog appears. 

Click the Resolution menu and choose Quarter.6.	

Click the Renderer menu and choose Preview.7.	

These settings should give you a good test render. 8.	

 Reduce the resolution for the test render, as Full 
resolution renders are time consuming. Even at this resolution, 
the animation will not render quickly.

Click 9.	 OK. The Save dialog appears. 

Choose a save location for the QuickTime (MAC) or AVI (PC) 10.	
file and click OK. 

The 11.	 Video Compression dialog appears. 

Use the default settings and click 12.	 OK. 

Poser starts rendering.13.	

Lesson 7: Final Render
After one or more test renders, you’re ready to start the final 
rendering.

To render your final animation:

Choose 1.	 Render > Render Settings. 

Select a render engine (FireFly or Poser 4) and adjust the 2.	
Render Settings as needed.

Enable Shadows and Anti Aliasing to produce the best results. 3.	

Click Render Now.4.	

Depending on the image size and computer system, the final 5.	
render may take between 45 minutes to two hours.
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Chapter 12: Content 
Management

	
by Lisa Ahrens
Poser offers a variety of powerful tools to assist you with storing, 
organizing, and obtaining more Poser content. This tutorial will 
walk you through the benefits available to you from Poser’s 
Library palette, Content Paradise, Download Manager, and 
new content Collections. 

The Library Palette
The Library palette, shown to the right, is your content 
management center. The Library allows you to store content in 
various categories and subcategory folders, for easy access when 
building your scenes. The Library palette contains nine content 
categories: Figures, Poses, Expression, Hair, Hands, Props, 
Lights, Cameras, and Materials. Each of these categories 
holds various subcategory folders, which in turn contain icons for 
specific content items. Selecting an item, and then clicking either 
the Change Figure or the Create New Figure / Apply Library 

Preset icon at the bottom of the Library loads the item into your 
Poser scene.

Figure 12.1.

 The Materials library category is only visible when you 
are in the Material room.

Adding New Content
You can also save items, poses, etc. from your scene into the 
Library. Here’s how:

Navigate through the 1.	 Library categories, until the folder to 
which you want to add the item is open.

If you want to add your content to a new, custom 2.	 Library 
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subcategory folder, click on the Library Options menu icon, 
which is the downward facing arrow at the top right of the 
folder section on the Library palette. The Options pop-up 
menu will appear; select Add New Category from this list. 
Enter your new subcategory name in the Library Name 
dialog, and then click on the icon for your new subcategory 
within the Library palette, to open it.

Select the item you wish to save in the 3.	 Document window’s 
Current Actor menu. If you are saving a pose, select the 
figure in the Select Figure menu, and Body in the Current 
Actor menu.

Click the 4.	 Add to Library icon at the bottom of the Library 
palette. You will see an icon for your new content appear in 
the Library palette. 

Figure 12.2.

For more information about the dialogs that may appear when 
saving various types of content to the Library, please refer to the 
Poser Reference Manual, Chapter 7: The Poser Library on page 88.
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Adding New Runtimes
In addition to the standard Poser content Library, you can install 
your own custom Runtime Libraries, and access them through the 
Library palette. Navigate to the top, or Library, level of the Library 
palette hierarchy, and open the Options menu as described above. 
Select Add New Runtime from the list, and select your custom 
content library folder from the Browse For Folder dialog that 
appears. When you have selected a folder and clicked OK, the 
folder will be added to the Library palette as a new Runtime 
Library. You will then be able to switch to your custom Library any 
time either by navigating to the top level of the Library palette 
and selecting the runtime folder icon, or by selecting it directly from 
the Current Runtime pop-up menu, which appears directly over 
the subcategory folder portion of the Library palette when it is in 
its expanded state.

When adding a new Runtime Library, you have the option of 
creating a new folder directly from the Browse For Folder dialog. 
Browse to the location in which you want to create the folder, and 
click the Make New Folder button. A new folder will appear, and 
will automatically be populated by a Libraries subfolder, containing 
the appropriate folders for Poser content categories. Before clicking 
OK, you will want to rename your new Library folder; just right-click 
on the new folder within the Browse For Folder dialog, and 
select Rename. Enter your new Library name, hit return, and then 
click OK on the dialog. Your brand-new custom Runtime Library 
will appear in the Poser Library palette. Then all you need to do 

is populate the subcategory folders with content, and you’ll have 
created your own Poser Library!

Content Paradise
If you want to add to your personal Library from the extensive 
additional Poser content that has been created by Smith Micro as 
well as other 3D content creators, visit the Content Paradise 
website. The easiest way to access Content Paradise is to click on 
the Content tab within Poser. The Content room contains a direct 
link to Content Paradise, which allows you to browse for the 
content you need, download it to the Library, and then add it to 
your scene, without ever having to leave Poser. Alternately, you can 
visit Content Paradise any time via a standard web browser, at 
www.contentparadise.com.

When you access Content Paradise from the Content 
Room, Poser’s Download Manager automates the process of 
downloading and organizing content for you, so you don’t have 
to interrupt your workflow to figure out correct file placement. 
Just add the items you want to your shopping cart in Content 
Paradise, complete the purchase transaction, and download the 
content files. Download Manager will do the rest--your content 
will automatically be installed into the appropriate content folders 
in your Poser Runtime folder, making it accessible from your 
Library palette.

If for some reason Poser doesn’t recognize the content files you 
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are downloading, you may have to manually add the content to the 
Poser Runtime folder. See the Poser Reference Manual, Chapter 8: 
The Content Room on page 119 and “the Poser Reference Manual, 
Appendix B: Poser File Structure on page 524 for information about 
downloading and installing files, and Poser file types and locations. 
If you wish to read another tutorial that covers manual content 
installation specifically, please refer to the “Installing New Content 
Into Poser” tutorial on the Smith Micro website (www.smithmicro.
com), in the Training > Tutorials > Poser > Content Management 
section.

Content Collections
New in Poser is the Library Collections tab. This portion of the 
Library houses content Collections, which are customized subsets 
of items from the Library categories. Content Collections can 
contain items from any category, and from any Runtime Library, 
which makes scene creation and population really simple. Just 
navigate once through the Library palette, selecting the items you 
want to use and adding them to one or more Collections. Then, 
when you’re ready to put those items into a scene, just click on the 
Collections tab, open the Collection folder, and voila! All your 
selected items will be there in one place, ready to go.

For example, say you wanted to create a basic scene of Jessi going 
to the beach. First, you need to create the content Collection to 
hold the various content items you will need for the scene. From 

within any category folder within the Library palette, righ-click on 
a content item. This opens the Collections menu, which lists all 
the available content Collections, and includes an option to create 
new Collections. As we are creating a new Collection, select the 
Add New Collection option from the menu. Your new content 
Collection will appear in the Collections tab, as shown: 

Figure 12.3.

Then, browse through the Library palette categories, selecting the 
various items you will want to place in the scene, such as: Jessi, 
a hairstyle, a walking pose, bathing suit, sunglasses, sandals, hat, 
a ball and torus for beach toys, and materials for the props and 
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background. If you want to include customized items, such as a 
custom pose or material, create them as you normally would and 
add them to the Library as described above. Then you can add 
them to your Collection. When you select each item that you want 
to include, again right-click on the item, and select the name of 
your new content Collection from the Collections menu. The 
content items will be added to the Collection. 

Figure 12.4.

Once you have created the Collection, whenever you are ready you 
can go ahead and create your scene. 

Figure 12.5.
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Chapter 13: FireFly Render 
Tips

	
by Colin Gerbode
The FireFly render engine, introduced in Poser 5 and refined in 
subsequent versions, provides Poser users with a high-quality 
micro-polygon rendering engine capable of extremely accurate, 
photorealistic output. FireFly is a sensitive beast, however, and 
its many settings and options can be somewhat daunting to the 
beginning user. In this tutorial I’ll explain how to get high-quality 
results from FireFly without “stress-testing” it; often, turning the 
settings all the way up to the maximum uses system resources with 
no improvement in image quality.

Automatic vs. Manual Settings
FireFly’s Auto render settings provide a good range of options, and 
many people will find them sufficient for their rendering needs. 
A few tips are appropriate here. First, for test and draft renders 
done to check overall scene composition, camera angles and basic 
lighting, use the lowest Auto Setting to save time. To make things 

go even faster, use the Quick-Scale pop-up menu to set the size 
of the test render to half or 1/4 of the final size (see below).

Figure 13.1: Quick-Scale  Menu.

As you refine your scene, you can increase the render settings to 
utilize various features of the render engine. Most scenes will not, 
however, benefit from setting the render presets to their maximum 
levels, as most scenes do not fully take advantage of the particular 
features that are activated in these settings. Unless the particular 
scene requires a large number of raytrace bounces, for example, 
the only thing that using the maximum settings will do is to 
increase the load on the system and increase render times without 
improving quality. The third-to-last setting should be more than 
sufficient for final renders of the vast majority of Poser scenes.
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Figure 13.2: Final Render Settings.

Now, if you need to go beyond the presets, you can delve into the 
Manual Settings and achieve a high degree of control over exactly 
which options are active and to what degree; which can allow you 
to produce a very high-quality render without wasted time, or to 
check particular features of your scene with a quick render.

Scene Settings and Specifics
When you set up your scene, there are several factors which will 
affect the rendering speed and quality. First, think about the 
lighting in your scene. For each light in the scene that is set to 
cast shadows, FireFly has to create a shadow map, or raytrace the 
shadows. This takes time and adds to memory usage; you can speed 
up your renders and improve stability by turning off shadow-
casting on fill lights and lights used for edge highlights. For quicker 

test renders, turn off (uncheck) Cast Shadows in the Render 
Settings dialog.

If your scene has no transparent surfaces in it, you can turn on the 
Hide Backfacing Polygons option; this will allow Poser to ignore 
polygons whose normals face away from the camera, thereby 
reducing the load on the render engine.  However, you may wish to 
leave this feature disabled unless you really need the performance 
advantage, because there is the possibility that if there are issues 
with the geometry of any objects in your scene, such as flipped 
surface normals, you may see holes in the surface when Hide 
Backfacing Polygons is enabled.

The Smooth Polygons setting tells FireFly to round the edges of 
polygons, to give a smoother, more natural look. This can cause 
problems with objects that are supposed to have sharp angles. 
Fortunately, polygon smoothing can be turned on or off for each 
object in the scene, by using the Properties palette. Turning 
Smooth Polygons on globally and then off for each specific object 
that needs it is a good way to apply polygon smoothing only to 
specific objects within the scene. Additionally, polygon smoothing 
will not override hard edges specified by the Crease Angle setting 
in the General Preferences dialog, or by smoothing groups set 
up with the Group Editor. So you can use Smooth Polygons 
as a global setting, and still specify hard edges definitively using 
crease angles or smoothing groups.

 If you encounter a “ballooning” effect on an object’s 



Poser 8
Tutorial Manual

101

Chapter 13: FireFly Render Tips

surface, you should lower the Crease Angle setting for that 
object in the Properties palette. Doing so should correct the 
problem.

Texture Filtering is used to improve the appearance of fine-
grained textures, and to reduce moiré patterns when a texture 
repeats and scales (imagine a checkerboard-patterned floor 
receding into the distance); it can give good results but can also 
use additional system resources. For example, a single 4000x4000-
pixel texture, without texture filtering, uses 64Mb of RAM (which 
is itself a good argument for reducing maximum texture size- see 
below) while with texture filtering on, that same texture takes 
192Mb--more than twice the RAM for the same texture file. Poser’s 
FireFly engine generates better performance with texture filtering 
enabled, hence texture filtering is active by default. This does result 
in some additional memory usage but since Poser’s FireFly engine 
manages texture memory so efficiently, the amount of memory 
used is minimal and will be more than covered by the performance 
benefits of texture filtering. 

Figure 13.3: Non-Filtered vs. Filtered Render.

In Poser 5 or 6, reducing the maximum texture size allowed 
users to control memory usage while producing high quality 
renders. In Poser, improved texture memory management makes 
this unnecessary, as textures no longer require large amounts of 
memory on loading. 

Poser 7 introduced Irradiance Caching, an improvement to the 
Ambient Occlusion calculation process. By default, this feature’s 
slider is set to 50%; higher settings provide increased precision 
and image quality when Ambient Occlusion is used, while lower 
settings increase render speeds at a slight cost in image quality. In 
the images below, note the shadows around the ear as an example 
of the effects of the quality settings. 
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Figure 13.4.

Setting the Maximum Texture Size can make a huge difference 
in memory usage without impacting image quality, provided you 
do it right. Use a texture size appropriate to the scene that you’re 
rendering. If you’re doing a big render around 2K-3K pixels on a 
side, then you should set your maximum texture size to a fairly 
high number; at most, about as big as the vertical dimension of 
your rendered image (but see the note below.) Similarly, if you’re 
rendering something smaller such as a 640x480 image for the 
Web, for example, then setting the Max Texture Size smaller (4-500 
pixels) will save memory and time when you render, as it will force 
FireFly to subsample the texture before it loads it. The critical limit 
should be the size in the rendered image of the figure to which 
the texture is being applied. If the largest figure in your scene is 
only 500 pixels high, then using a 1024-pixel texture is wasteful. 
Additionally, many figures ship with high- and low-resolution 
textures; it’s usually quite sufficient to use the low-resolution 

texture when you set up the scene, unless you’re producing a large 
close-up rendering. Similarly, when setting up the scene it will 
save considerable system resources to use lower-polygon figures in 
crowds or for figures who will not be seen close up.

Hi-Res vs. SubSamples Texture Render

The Minimum Shading Rate tells FireFly how fine a level of detail 
to render for each sample. Higher numbers give a “coarser” render 
that proceeds faster, while lower numbers give a finer render but 
take longer. A good setting for a draft render might be 4-8, while a 
really high-quality production render might use 0.3 or even 0.1 if 
there are fine surface details like fur to resolve.

Figure 13.5: High vs. Low Shade Rate Render

The Bucket Size tells FireFly how many pixels to render at once. 
Bucket settings have no impact on quality but will affect the speed 
of rendering, with high bucket numbers giving  faster renders that 
take more memory and low bucket numbers allowing a render 
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in low memory situations that will take longer.  While Minimum 
Shading Rate trades resources for quality (with an impact on 
speed), Bucket Size trades resources for speed with no impact on 
quality.



Poser 8
Tutorial Manual 

104

Chapter 14: Creating and Assigning Textures

Chapter 14: Creating and 
Assigning Textures
Creating your own textures for figures and/or props requires a 
solid grasp of the concepts explained in Part 1: “3D Basics” on 
page 1 and knowledge of one or more 2D graphics tools such as 
Adobe Photoshop. The process of creating textures is very similar 
if not identical for many 3D applications. While it’s impossible to 
cover the entire process in this book, we can give you enough 
information to understand the basics and begin creating your own 
maps.

  This section covers creating maps. please refer to the 
Poser Reference Manual, Part 3: Materials on page 202 for 
information about applying maps to shaders.

Creating Texture Templates
If you use the figures and props that came with Poser (or if you 
buy figures from most third-party vendors), they probably come 
with one or more ready-made texture maps and one or more blank 
templates. If you need to create a new texture template, you’ll need 
to follow a process that is roughly similar to the following:

Create your mesh object in your preferred 3D modeling 1.	
application.

Export the mesh in a format supported by Poser (see 2.	 the Poser 
Reference Manual, Importing 3D Objects on page 51 for a list 
of supported formats).

If your 3D modeling application supports exporting your mesh 3.	
object with UV mapping data, be sure to do this, as this will 
probably create your template for you. Please refer to your 3D 
modeling application documentation for information.

If your exported object does not have UV information, you’ll 4.	
need to use an application such as UV Mapper (http://www.
uvmapper.com) to create the UV information and a blank 
template that can be used for any sort of map (texture, bump, 
transparency, reflection, displacement, etc.). If you use a third-
party application to create texture templates, please refer to 
that application’s documentation for information on using 
that application. Also, should you require technical support, 
please contact the application’s creator or vendor. Smith Micro 
cannot provide support for third-party applications.

http://www.uvmapper.com
http://www.uvmapper.com
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Creating and Using Texture 
Maps
This subsection contains a brief tutorial on creating texture maps. 
The proper use of maps can create stunning results such as the 
scene below:

Figure 14.1: The Right Shoulder selected on the figure.

If you’ve seen some computer-animated movies lately, you were 
probably astounded by the realism of the characters; this high 
level of believability was achieved using high-quality 3D models 
and image maps. The fact is, image maps can make or break a 
model’s believability. What may surprise you is that Poser can 
generate equally realistic results for you. We are going to give you 

some pointers on how you can do this yourself using Poser and 
a 2D graphics application such as Adobe Photoshop. The primary 
topic for this tutorial is texture maps, however the same principles 
apply to all types of image maps. Please refer to “About Maps & 
Templates” on page 20 for information about the various types of 
image maps.

 Poser’s Material room can create complete materials 
without needing any image maps. To obtain precise results, 
however (such as a tattoo in a specific location), you will need 
to include image maps in your shaders for texture, bump, 
transparency, etc. Image maps are added to nodes using 
the Material room. Also, the Face room can create custom 
head textures for the Poser figures from images or even from 
scratch!

A texture map looks like a skinned 3D model spread out onto a flat 
surface. Imagine peeling an orange and flattening the peelings on 
a table- that’s a texture map. When creating a texture, remember 
that it will ultimately be wrapped around your object and that you’ll 
need to pay special attention to the edges, which will be seams 
when the texture is rendered.
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Figure 14.2.

Texture makers use a UV map (template) to place the texture’s 
major pieces. A UV map provides grid-like lines that correspond 
to the object’s geometry, provides a coloring book approach 
to making textures, and only requires a good graphics editing 
software package such as Adobe Photoshop. Like a coloring book, 
items not placed properly within the grid lines render askew, and 
anything bleeding over the edge of the grid does not appear at all 

when rendered. This is one time where you definitely want to stay 
between the lines! The texture maps for the figures and props that 
are included with Poser are located on the content CD. Because 
realistic human textures are the hardest to achieve, we decided to 
describe creating one for this section. The same principles apply to 
any texture you are creating, be it a brick wall, animal fur, a plant- 
any figure or prop for which you want to use texture mapping.

The brief explanation that follows is courtesy of Ms. Syyd Raven, 
who created the textures used by the default Poser 5 figures: 

“Save often and under different filenames to preserve 
each step of your work. 

Maps of 1500-3000 pixels provide an ideal realism/
performance balance. Some third-party textures 
can be 4000 pixels or more, however these can 
slow Poser down because they require additional 
computing resources.”

The figure used for these renders requires two maps, one for his 
head, and one for his body. Different Poser figures may use one or 
two texture maps, depending on the figure. The following sections 
address each map separately, and the same principles apply to 
figures that only use one map.

  As discussed above, creating maps is an advanced 
process that can require one or more third-party tools. Smith 
Micro cannot provide support or additional information on 
creating texture maps beyond the technical aspects that 
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directly involve Poser. The material presented in this section is 
for informational purposes only.

The Head Map

Photos used for the basis of your texture should roughly match •	
the final texture map size. 

Work on one side at a time. •	

Set the photograph’s opacity to approximately 50% so you can •	
use the underlying template to align it; scale, rotate, and clone 
individual facial features to perfectly fit the map. 

With your image editor running, launch Poser and apply the head 
texture to the figure: 

Set the figure’s material color to white and highlights to black •	
in the material editor. 

Render the model with white lighting, no shadow, and •	
antialiasing enabled to test texture alignment. 

Test various morph targets on the face to verify that the •	
texture remains in alignment. 

Figure 14.3.

Make changes in your image editing software and test render •	
in Poser as many times as you need. 

Once you are satisfied with your map, mirror the completed •	
side by copying and pasting into a new layer and flipping the 
new section. 

After mirroring the texture, you may notice a line down the •	
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center. Remove this line by cloning an area with a matching 
color, cutting and pasting small photo pieces from the original 
source image, using the blend tool, or any combination of 
these methods. 

Change and add various details (lines, moles, etc.). No face is •	
perfectly symmetrical! 

Continue expanding the skin to a bit beyond the template •	
edge. 

While testing, rotate the head to see the ear and side of the •	
neck; you will need to pay close attention to these areas to 
ensure that there are no seams. 

Cut out and place individual teeth, giving the front six •	
(top) and eight (bottom) the most detail. Realistic teeth are 
somewhat gray/yellow, not white. 

Photograph a tongue and apply it directly to the map. Pay •	
attention to the deep grooved center line; this adds credibility 
to the texture when the model’s mouth is open. 

The inner mouth looks reminiscent of a rib cage surrounding •	
lungs. 

Lachrymal glands (tear ducts) have wetness and roundness. •	

Take close-up photos of eyes. •	

Paying attention to eye reflections dramatically increases the •	

realism of your renders. 

Have the model hold their eyes wide open to show the whites •	
and roundness of the iris. 

Make the veins thin and not overly red to avoid bloodshot-•	
looking eyes. 

Figure 14.4.

The Body Map
The body’s fine details (hair, moles, etc.) require larger maps to 
avoid blurring and pixilation. Many third-party body maps are 
double the size of the corresponding head map.
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Figure 14.5.

It’s difficult to use complete photos for textures since they will •	
not align correctly. Size and rotate working images or photos 
using separate layers. 

Lay out the entire body first, without worrying about matching •	
edges to get major portions in place, then finesse the edges 
with ever-increasing detail. 

Male maps require more detail than females because of body •	

hair. 

Photograph small areas, treating arms as 4-sided objects; •	
concentrate on elbow creases. 

Male necks can include beards or stubble, which can be •	
problematic due to different resolutions between the head 
and body textures. 

Nipples can be tricky due to low resolution and may require •	
fine-tuning, especially on female maps due to breast morphs. 

Hands are also important; get close-ups of both sides. •	

Take care to include hand veins on the final texture as well as •	
creases that match the model’s geometry. 

Use the same map for the left and right hand, then add •	
asymmetrical features. Repeat this for the feet. 

Cut individual fingernails and toenails from your photographs •	
and fit them into the template. 

Make sure you test all your work-in-progress in Poser. •	

When the body is complete, correct the head and body color •	
to make them the same shade/hue. Writing down your color 
values can be a big help. 
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Figure 14.6.

Creating and Using Bump, 
Reflection, and  
Transparency Maps
To be fully realistic, many textures also need transparency and 
bump maps. For example, the eyelash area template needs to be 
white where you want the object or eyelash visible. Consequently, 
you will start with a black background and draw in white where 
you want the eyelashes to appear when rendered. A graphics tablet 
works well for this, since eyelashes require a natural curved line 
that tapers to a point, which can be hard to achieve with a mouse. 
If you don’t own a graphics tablet, you can begin with a very large 
map and reduce it to the proper size later. The larger map will make 
it easier to draw the lines with accuracy. 

Bump maps add further realism to skin pores, scars, or moles. For 
photorealistic skin, it’s imperative to deal with major landmarks 
(moles, birthmarks, etc.) using a bump map. The quickest way 
to create bump maps is to copy the finished texture, desaturate 
it (that is, remove all the color leaving only the black and white 
components), and invert it. Then convert it to grayscale. This reduces 
the file’s size and memory requirements.

Poser allows you to adjust the bump maps’ height, so it’s a good 
idea to design them with very high contrast (or the most bump). 
Most graphics packages have automatic contrast controls; this is a 
great way to quickly get the widest range of bump for your maps. 
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If needed, you can decrease the bump height within Poser before 
render time.

White areas of the bump map are high, and black areas are low. 
In order for your texture to make a plausible map, you will have to 
invert it before you can use it. If you forget to do this, it may take 
you a while to figure out why your test renders look a bit odd. 
A good example of this would be whiskers pushing in instead of 
outward.

  bump maps simply disturb an object’s normals. If 
you apply a bump map to a sphere, the surface will seem 
rough while the edges remain smooth. Poser’s Material room 
contains a displacement channel, allowing you to use bump 
maps to actually alter the geometry. For example, applying a 
displacement map to a sphere would make the edges appear 
rough.

Once you’ve adjusted the contrast and desaturated your texture, 
you can start modifying it to suit your particular needs. Go ahead, 
give it a shot: You might be pleasantly surprised with your results!

Figure 14.7.
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Chapter 15: The Face Room

	
by Denise Tyler
The Face room allows you to create custom faces and textures for 
your Poser figures in several different ways. When you first open 
the Faceroom, it appears as shown in Figure 1.

Figure 15.1: The various areas and controls in the Face room.

The areas contained in the Face room allow you to perform the 

following tasks:

Photo Lineup•	 : Allows you to import front and side photos 
of a person, and use the photos to generate a face shape 
and texture. This area also contains several tools that assist in 
aligning the head geometry to the photos that you use. The 
Apply Shape button generates head geometry that matches 
your photos.

Texture Variation•	 : Click the Texture Variations tab to 
display options that allow you to modify the appearance 
of your texture. You can add facial coloring for beards, eye 
sockets, and eyebrows, and also modify the texture to add 
ethnicity, age, and gender differences.

Face Sculpting Window•	 : Displays a textured preview of 
your 3D head. Camera controls are located above the top right 
corner, allowing you to rotate, pan, and zoom in or out. You 
can also push or pull selected vertices to reshape the head.

Action Buttons•	 : Contains buttons that apply the head 
shape and or texture to your current character in several 
different ways, with or without the generated texture.

Face Shaping Tool•	 : Contains parameter dials that allow 
you to shape the head and facial features further. The dials are 
similar to those in the Parameters palette of the Pose room.

Caricature Dial•	 : Adds character to your face by enhancing 
the features. Negative values de-exaggerate head and facial 
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features, while positive values over-exaggerate them.

Reset Face Room Button•	 : Restores the default head 
shape and texture map and undoes all previous Face room 
work.

Texture Preview Window•	 : Shows a preview of your 
texture while you are working on a photo-generated face, and 
allows you to load or save face texture maps.

Random Face Button•	 : Randomizes the Face Shaping Tool 
morph settings to generate a new face as a starting point. Use 
this feature with caution, as it erases any work that you have 
previously completed.

In this tutorial section, you’ll learn about each of these Face room 
areas, and will step through a real-world project that will create a 
female character and head. The topics you’ll learn are as follows:

Getting Ready for Your Face Room Project•	

Choosing and Preparing Photos•	

Task 1: Import the Photos to the Face Room•	

Task 2: Adjust Size, Position, and Rotation•	

Task 3: Adjust Feature Points•	

Task 4: Refine the Head Shape•	

Task 5: Apply to Your Figure•	

Getting Ready for Your Face 
Room Project
Though their heads are shaped and sized a bit differently, Don, 
Judy, Will, and Penny have one thing in common. They all share the 
same head geometry. As a result, the Face room morphs work on 
all of them. It has to do with the face geometry.

In order for any figure to work in the Face room, it must use 
the same head geometry that Don, Judy, Will and Penny use - 
otherwise, the morphs will be incompatible. Seeing as the main 
reason for the Face room is to create customized characters, the 
morphs are vital to this process. Unfortunately, this means that 
there are many other Poser figures that will not be compatible with 
the Face room, because their head geometry is entirely different. 

So, go to the Pose room and load Don, Judy, Will, or Penny onto 
the stage. When you do this is not really important, but you’ll 
definitely want to make sure you have the right character there 
before you apply your custom head to the figure. For the purpose 
of this tutorial, add Judy in the Pose room as shown in Figure 2. If 
you’re creating a male texture instead, choose Don.
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Figure 15.2: Load the proper figure into the Pose Room, so that it is ready for 

you to apply your custom head.

 Though you can create heads and textures for Will and 
Penny, the geometry adjustments and morphs that you create 
in the Face room may cause the heads to be larger.

 If you don’t want to use the Face room to create a 
head texture, you can use a third-party texture to develop your 
character. First, use the Material room to apply your favorite 

texture to Don, Judy, Will, or Penny. Then go to the Face room, 
and click the “Import Original Figure Head Texture” button 
in the Actions area. The head texture from the figure in the 
Pose room will be applied to the head in the Face Sculpting 
area.

Choosing and Preparing Photos

 The Face room allows you to import photos in 
the following file formats: BMP (Windows bitmap); GIF 
(Compuserve GIF format); JPG (JPG Files); PCX (ZSoft 
Paintbrush format); PNG (Portable Network Graphics format) 
and TIF (TIFF Files)

Though Poser does allow you to work with mismatched photos, or 
photos that are not perfectly aligned, you get the best results if you 
follow certain guidelines. 

It helps matters if you keep the following points in mind when you 
shoot photos for the Face room. The closer your photos are to 
these guidelines, the better your results will be. 

Position the camera so that it is level with the subject’s face. •	
It should also be close enough to capture the entire face with 
the maximum amount of detail. Take the front and side photos 
at the same distance.
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If your camera has a white balance feature, have your subject •	
hold a piece of white paper in front of his or her face, and 
adjust the white balancing accordingly before you shoot the 
photos (or for each view if you adjust the lighting between 
shoots). This is essential to achieve photos that are natural in 
color.

Lighting should be all white. Colored or unnatural lighting •	
colors affect color fidelity. Adjust the lighting so that you 
achieve the maximum amount of detail without washing out 
the subject. Lighting that is too dark will not show enough 
detail, while lighting that is too bright will wash out the 
subject.

The subject should remove glasses or other adornments that •	
are unwanted in the final texture.

The subject should have a neutral facial expression, with •	
closed mouth. 

Ears should be clearly visible. Comb or pull back the hair to •	
show as much of the ear as possible.

For the front photo, the subject should directly face the camera •	
without tilting the head upward or downward. 

For the side view, the subject should face 90 degrees away •	
from the camera, preferably facing toward the right. (Poser can 
flip photos that face toward the left).

Important Notes about Photo Size
By default, Poser creates a 512 by 512-pixel texture. You can, 
however, create a face texture that is of higher resolution. However, 
in order to do so, there is a slight catch in regards to the size of the 
original photos: the dimensions of the source files must be a power 
of 2.

What this means to you is that if you want to create a head texture 
that is about 1500 x 1500 pixels, you can’t use a photo that is 
that size. The next-highest power of 2 is 2048 x 2048. Your source 
photos should be 2048 x 2048 to result in a face texture that is 
2048 x 2048. You would then need to resize your texture in a photo 
editor to get the desired size of 1500 x 1500.

For quick reference, the following table shows dimensions that are 
powers of two:

512 x 512 1024 x 1024

2048 x 2048 4096 x 4096

If your photos do not come near the sizes listed above, you can use 
a photo editor to add pixels around the outer edges of the photo 
until you arrive at the recommended dimensions.
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Improving Photos with an Image 
Editor
If your photos are not quite perfect, you can use an image editing 
program to help the situation. Here are some tips for you. 

Adjust color, hue, saturation, or contrast until your photos look •	
their best and maintain consistency in color and brightness. 
Try to make your front and side photos look uniform in this 
regard.

Size the front and side photos uniformly, so that the eyes, •	
nose, mouth, and chin match up to each other. What can help 
in this process is to open one of the photos in an image editor 
that supports layering (such as Photoshop, Painter, or Paint 
Shop Pro). Copy the larger photo to a layer above the first 
photo and reduce the transparency so that you can see the 
smaller image beneath it. Then, rescale the larger photo so 
that the eyes, nose, mouth corners, and chins are on the same 
horizontal plane as shown in the next figure. Guides can also 
help in this process. An example of this process is shown in 
Figure 3.

 Photos used in this tutorial appear with the permission 
of Peter Levius, host of http://www.3d.sk. This site makes 
thousands of high quality photos available to texture artists for 
a very reasonable fee. Check it out! 

Figure 15.3: Use an image editor such as Photoshop to align and straighten the 

front and side photos.

Fix photo imperfections. If you have multiple shots, you can •	
use parts of one photo to help fix imperfections in another. For 
example, let’s say you have a perfect straight-on shot that is 
facing directly toward the camera. The photo shown in Figure 
4 is perfect for a straight-on view, with one small exception: 
the subject’s mouth is slightly open. To remedy this problem, 
locate another photo that has a perfect mouth. Create a 
feathered selection around the good mouth and paste it into 
a layer above the less-than-perfect one. Adjust the brightness 

http://www.3d.sk
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and tone until it they match perfectly. If done properly, you’ll 
hardly know the difference, as shown in Figure 5. 

Figure 15.4: Use portions of other photos to fix imperfections in a shot that is 

almost perfect. Here, a different mouth is selected to cover the opened mouth in 

the photo.

Figure 15.5: After minor adjustments in brightness and sizing, the new version of 

the photo has a closed mouth that is more suitable for texturing in the Face room.

Adding Symmetry to the Front Photo
Sometimes, for one reason or another, your photo isn’t perfectly 
symmetrical on the right and left sides. The photo shown in Figure 
6 is a good example of this, because the subject’s head is turned 
slightly toward your left. 

One way around this is to use your image editor to make the photo 



Poser 8
Tutorial Manual

119

Chapter 15: The Face Room

symmetrical. Here, I take advantage of Photoshop’s ability to make 
guides, and then snap selections to them. Here, I pull a guide from 
the left ruler onto the image, and place it through the center of 
the face. If your photo is not perfectly straight, the guide helps you 
notice and correct it.

Figure 15.6: A vertical guide placed through the center of the face helps you 

align and divide the face in half.

The right side of the preceding photo (facing us) is rounder, and it is 
more likely that it will result in a smoother transition from front to 
side. Create a selection, starting from the top end of the guideline 

and including the entire right side of the photo (see Figure 7).

Figure 15.7: A selection is made to include the right side of the image, from the 

guide line to the right edge.

Copy the selection to a new layer. Flip the copy horizontally, and 
then align the two sides together. The left side should snap to the 
guideline. Also, make sure that the two sides exactly mirror each 
other so that one half is not higher or lower than the other half. 
Figure 8 shows the finished result. Save the new image under a 
different file name, so that you don’t overwrite the original version. 
Use the new image for the front photo and you should have an 
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easier time of making facial adjustments that are symmetrical.

Figure 15.8: A copy of the right side is flipped and matched at the center guide 

line.

Task 1: Import the Photos to the 
Face Room
With the figure loaded, you can click the Face tab to open the Face 
room. Let’s take a close look at the Photo Lineup area, shown in 

Figure 9. This area of the Face room allows you to use photos to 
generate a head texture and associated head shape. 

The Photo Lineup controls appear on the left side of the Face 
room, as noted in the following figure. Their primary function is to 
help you position and shape the head geometry while you align it 
to the photos that you import. You’ll use these controls later, after 
you import some photos.

Figure 15.The Photo Lineup area allows you to import photos and position the 

head geometry to match them.
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Importing the Front Photo
After you’ve selected and prepared your photos, you import the 
front and side photos into the Face room. To import the front 
photo, proceed as follows:

Click the Load icon for the front view. The Load Front Face 
Image dialog appears.

Use the 1.	 Look In drop-down list to locate the folder on the CD 
that contains the front image.

Highlight the file name of the image you want (which is 2.	
SimonaFront.jpg in this example). Click Open, or double-click 
the filename.

Poser displays the screen shown in Figure 10, which prompts 3.	
you to click your image on the corner of your model’s right 
eye. Click the location as noted.

Figure 15.10: When you load the front photo, you are prompted to click the 

corner of the model’s right eye.

You are automatically advanced to the screen shown in Figure 4.	
11, when Poser prompts you to click the image on the left 
corner of the lips. Click the location as noted.
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Figure 15.11: Next, Poser prompts you to click the left corner of the mouth.

After you pick the points Poser returns you to the Face room as 
shown in Figure 12. The upper portion of the Photo Lineup area 
displays the photo that you imported. The lower portion of the 
Photo Lineup area displays an outline of a head facing toward 
the right (for your side photo). The Face Sculpting area displays a 
3D textured preview of your head, and the Texture Preview area 
displays a 2D preview of your texture as it appears thus far.

At this point, don’t attempt to make any adjustments to the photo 
lineups. It is best to proceed to importing the side photo, which 
follows in the next section.

Figure 15.12: After the front photo is imported, you see previews in the Photo 

Lineup area.

 If you aren’t happy with the results you get, it might 
help to try the process again, and making slight adjustments to 
the points that you pick when you import the photo. Click the 
Load icon again to repeat the process. You can also click the 
Clear icon to delete the photo from the selected viewport. 

There are also controls that allow you to reposition or rescale 
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the facial outlines. You’ll learn more about these controls in 
Task 2.

Importing the Side Photo
When you import the side photo, the steps are nearly similar to 
those you followed for the front photo. Follow these steps:

Click the Load icon for the side view. The 1.	 Load Side Face 
Image dialog appears.

Use the 2.	 Look In drop-down list to locate the folder that 
contains the front image. If you are performing this task 
immediately after loading the front image, Poser defaults to 
the same folder that you previously selected.

Highlight the file name of the image you want (SimonaSide.3.	
jpg in this example) and click Open, or double-click the 
filename.

Poser displays a screen that prompts you to click your image 4.	
at the top of the right earlobe. If your figure is facing in the 
opposite direction of the guide image, click the Flip icon that 
appears beneath the photo.

Click the photo at the top of the right earlobe as shown in 5.	
Figure 13.

Figure 15.13: Click the top of the ear for the first side point.

Next, Poser prompts you to click the front of the chin as 6.	
shown in Figure 14.
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Figure 15.14: Click the front of the chin for the second side point.

After you pick the points for the side image, Poser again returns 
you to the Face room. The lower portion of the Photo Lineup 
area now displays the side photo beneath an outline of the head. 
The texture previews in the Face Sculpting area and Texture 
Preview area now appear a little more complete. Refer to Figure 
15 for an example.

You’ll probably find that your texture doesn’t line up perfectly, 
and the outline of the profile might look really strange and out 
of proportion. When you zoom in, the eyes may not be aligned 
correctly. The mouth may need adjustment. The ears may not fall in 

the right place. You might have a big wide spot in the back of the 
neck. You can remedy all of these texture problems by adjusting 
the scaling and positioning of the red lines as described in Task 2, 
and by adjusting the green control points as described in Task 4. 
Continue on with these tasks to complete your texture. 

Figure 15.15: Front and side photos are loaded and the texture preview is more 

complete.
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Task 2: Moving, Scaling, or 
Rotating the Head Guides
After you complete Task 1, you may notice that the texture does 
not align perfectly with the character’s features. There are several 
controls in the Photo Lineup area that allow you to fine tune the 
photo placement on the texture. Other controls help you align the 
head geometry so that it better matches the photo. This task shows 
you how to make these adjustments.

 If you did not complete Task 1, you can open the 
FaceRoomTask2.pzz file from the Tutorials/FaceRoom folder in 
your Poser installation to follow along from this point.

Adjusting Front Scaling and Position
You’ll notice in Figure 15, shown previously, that the red outlines 
don’t match the overall shape of the head. You can move or resize 
the overall head geometry to improve the position of the outlines 
over the photograph. Each view has a Move tool and a Rotate 
tool that help in this regard. When you resize the red outlines of 
the geometry, it also affects how features are positioned. As a 
result, you’ll have to alternate between scaling and positioning for 
best results. 

 When resizing and repositioning the red outlines in the 
front view, pay close attention to the placement of the eyes 
and mouth. By doing so, you will set yourself up to make the 
remaining adjustments easier. 

Begin by placing your mouse over the Move icon in the front view. 
Use the eyes and mouth as a guide for placing the outline in the 
right area. Step by step, here’s how you can approach the front of 
Simona’s face:

To adjust the Front view, place your mouse over the 7.	 Move 
icon . Move the center line of the outline’s mouth over the 
center line of the photo’s mouth. 

At this point, you’ll probably notice that the eyes don’t quite 8.	
line up correctly, because the spacing is a little bit off. So, drag 
the mouse over the Scale icon , and drag it right or left as 
necessary to get the eye spacing closer. 

If necessary, alternate between the 9.	 Move and Scale icons 
until the eyes and mouth both appear as they should. Don’t 
worry about the nose at this point, we’ll get to that later! 

An example of what you are looking for in the front view is shown 
below in Figure 16. Notice that the spacing between the eyes is 
pretty close and the center lines of the mouth match up. We can 
improve upon this further by adjusting the tilt and turn of the head.
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Figure 15.16: Scale the head geometry so that the eyes and the center of the 

mouth align with the photo.

Adjusting Side Scaling and Position
When you adjust the scaling and positioning in the side view, it 
affects the position of the ears and chin on the texture map. 

Use the 1.	 Move tool in the side view to place the ear outline 
over the ear. 

Drag the 2.	 Scale tool downward as necessary to increase the 
size of the ear. 

Alternate between the 3.	 Move tool and the Scale tool until 
the texture of the ear appears in the proper place on the Face 
Sculpting preview. At the same time, try to achieve the best 
possible balance between ear and chin placement.

 Drag the tool left to decrease the depth of the head, or right 4.	
to increase the depth of the head as necessary. The final result 
is shown in Figure 17.

Figure 15.17: Move and scale the side outline to match the height ratio of the ear 

and the chin.
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Compensating for Head Tilt or 
Rotation
Photos aren’t always perfect, and you may find yourself with some 
that show the subject with his or her head tilted or turned slightly. 
In fact, the photos that we are using for this tutorial have a slight 
problem in this regard. When you look at the front photo, her 
right cheek is fuller than her left, indicating that her face is turned 
slightly.

The Rotate tool can help remedy situations when your subject 
is looking directly at the camera but has his or her head tilted or 
turned slightly toward the left or right. It is important to note, 
however, that the Rotate tool won’t work well for heads that are 
more than a slight variance from center.

 There is no undo for the Rotate tool. Before you use 
it, you might want to exit to the Pose room and save your 
project under a file name you can remember (such as Work in 
Progress.pz3) Doing so will save the entire project, including 
the state of the Face room texture and head shape. After you 
save the project, return to the Face room to use the Rotate 
tool. If you don’t like the results you can use the File > 
Revert command to return to the previously-saved version.

The Rotate tool for the front view tilts the head geometry along 
the Z (side to side) axis. When you drag the mouse upward or 
toward the right with the Rotate tool, the head tilts the right 

side of the red outline downward. However, you’ll notice the left 
side of the texture tilt downward in response. Similarly, drag the 
mouse downward or toward the left to tilt the left side of the red 
outline downward. The right side of the texture tilts downward in 
response. 

The alignment of the head tilt appears to be just fine, as shown in 
Figure 18. The eyes line up quite well as they are, so we don’t need 
to make any adjustments to the tilt of the head.

Figure 15.18: The tilt of Simone’s head does not require adjustment.

We do have another problem with our front photo, however. The 
head is turned slightly toward our left, making the right cheek 
appear more full. To remedy this, press the Alt key while you use 
the Rotate tool in the front view. This turns the head geometry 
along the Y axis.

Proceed as follows with Simone’s face project:

From the Front view, press the Alt key while you drag the 1.	
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Rotate tool toward the right to turn the geometry a bit. 
A couple of “notches” should do it, it only takes a slight 
adjustment.

If necessary, make adjustments with the 2.	 Move and Scale 
tools to further improve texture placement in the Face 
Sculpting area. As you can see in Figure 19, the placement of 
the eyes is even better still!

Figure 15.19: After we Alt-click and drag the Rotate tool for a slight head turn, 

the eyes are centered better.

Task 3: Fine-Tuning the Texture

 If you did not complete Task 2, you can open the 
FaceRoomTask3.pzz file from the Tutorials/FaceRoom folder in 
your Poser installation to follow along from this point.

After you adjust the geometry with the preceding tools, you can 
use the green feature points and red outlines to make more refined 
changes to the geometry and texture. Though the texture placement 
is acceptable over the eyes and mouth at this point, the green 
feature points will allow you to fine-tune and smooth the texture 
around the forehead, mouth, eyes, and chin. 

 An “Apply Shape” checkbox appears between the front 
and side photos in the Photo Lineup area. When checked, the 
green control points and red outlines affect both the head 
geometry and the texture - in other words, the shape of the 
head will change as you move the green feature points or red 
outlines. If you do decide to use this feature, make sure that 
you keep the green feature close to the features that they 
control when possible. Otherwise you will see strange bends, 
twists, and over-exaggerations in the geometry.

A better approach is to leave the “Apply Shape” checkbox 
empty. This way, the control points and outlines will only affect 
texture placement. This also ensures that you get the best 
texture results. You can then use morphs in the Face Shaping 
Tool area to fine-tune the head shape and features after the 
texture is complete.
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Refining the Front View
You’ll start by making adjustments to the feature points in the 
Front view. If you adjust the feature points in specific order, you’ll 
find that results will be pretty consistent. Basically, you start with 
the overall shape of the head and work your way inward to the 
finer detail points.

Adjust top, bottom, left and right feature points1.	 . Try 
to maintain the best outline of the head, while matching the 
eyes as closely as possible. Watch the 3D preview in the Face 
Sculpting area while you adjust the points as follows:

Adjust the Top feature point to achieve proper height of ��
the eyebrows and eye folds.

Adjust the Bottom feature point to place the texture for ��
the lower lip and chin in the best possible location.

Adjust the Left and Right feature points to create a ��
smooth transition along the upper cheeks.

If necessary, use the 2.	 Move tool to reposition the head 
geometry for better texture placement. Figure 20 shows the 
results after the four control points have been adjusted.

 Do not move green feature points to an extreme 
position to adjust a red outline. Smith Micro recommends that 
you place the green feature points directly above the features, 
without worrying about the red outlines. 

Figure 15.20. Top, Bottom, Left and Right control points help define the height of 

the eyelids and brows, as well as the cheek and chin areas.

Adjust forehead and jaw. The forehead points affect placement 3.	
and spacing of the hairline around the forehead, as well as the 
spacing of the eyebrows. Adjust the forehead feature points to 
maintain the same relative distance along the top semi-circle. 
For the jaw, keep all adjacent feature points along the lower 
jaw at roughly the same distance from left to right, while you 
watch the placement of the shadow along the jawline. Figure 
21 shows the result after the forehead and jaw feature points 
have been adjusted.
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Figure 15.21. After adjusting the forehead and jaw feature points, the eyebrows 

and chin are in position.

Adjust the eyes. Match the eye points carefully. This is a little 4.	
tricky and can be time consuming. Also note that when you 
make adjustments to the right eye, the left eye is also moving 
somewhat. You have to strive for a compromise between the 
two eyes, and the points may not be exactly the same on each 
of the eyes. If you don’t get them perfect, you can always 
come back to adjust the eyes in the front view after everything 
else is done. Figure 22 shows the result of one round of eye 
adjustments.

 When adjusting the eyes, remember that the placement 
of the face around the eyes is what is most important here. It 
is much easier to create new eye textures than it is to make a 
face texture that is placed correctly, so it is not so important 
what the “eyeballs” look like. Instead, pay attention to the 

placement of the eye folds, eye lids, and lachrymals. 

Figure 15.22. After some eye adjustments, the eyes are lining up very well.

Adjust the mouth. The placement of the mouth opening and 5.	
corners appear to define the shape of the mouth. First, move 
the corners to get the proper width. Adjust the top center 
point until the upper lip looks correct. Then, adjust the lower 
center point so that the mouth opening appears in the right 
place. Figure 23 shows our progress so far.
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Figure 15.23. For best results, make sure that the mouth opening is in the right 

place when you adjust the mouth feature points.

Adjust the nose and nose tips6.	  until you see that the 
texture falls in the right place in the Face Sculpting window. 
Figure 24 gives you an idea of the result around the nose. 
Adjust the side points until the wings of the nostrils fall in the 
right spot. Be careful when adjusting the wings: too much 
adjustment can cause the head to tilt left or right. Then adjust 
the middle feature point to place the inside of the nostrils.

Figure 15.24: Adjust the nose and nose tips to place the folds of the nose in the 

right spot.

Refining the Side View
With the feature points completed for the Front view, your texture 
should be looking pretty good from the front by now! At this point, 
we have to fine-tune things in the side view. But the rule of thumb 
with the side view is, “If it ain’t broke, don’t fix it”, most especially 
if you are using the Apply Shape feature. The profile feature 
points go a long way in adjusting the geometry, so take it in small 
baby steps if you are applying the shape to the head. 

Before you begin, return to the Pose room and save your project 
before proceeding so that you have something to revert back to 
in case you are unhappy with the results. And remember, don’t 
move feature points unless you think they will help to improve your 
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texture or character.

If you have to adjust the feature points in the side view, proceed in 
this order:

Adjust the top feature point. 1.	 The top feature point in the 
side view controls the placement of the hair on the crown. 
Adjust as necessary to get a nice smooth texture as shown in 
Figure 25.

Figure 15.25. Adjust the top feature point in the side view to affect the hair on 

the crown.

Adjust the feature point on the back of the head. Use the 2.	
best possible compromise between the back of the head and 
the neck. Too much adjustment here affects the forehead and 
eyebrows. If you have the Apply Shape option checked, try 
to achieve the best head shape rather than trying to get the 
texture right. If you don’t have the option checked, move the 
back feature point to cover the back of the neck as much as 

possible without distorting the rest of the texture placement, 
as shown in Figure 26. Pay attention to the texture around and 
behind the ears while you do this feature point. 

Figure 15.26: Adjust the feature point at the back of the head to fill in the neck. 

If you have the Apply Shape option checked, you’ll have to achieve the right 

balance between head shape and texture.

Adjust all of the profile points if necessary. Starting from 3.	
the top of the forehead, adjust the profile of the head as 
necessary to improve the texture or the shape of the head. 
Notice in Figure 27 how the profile follows the photograph to 
a reasonable degree. The feature points affect the following 
areas, but you may need to adjust one or more of them 
simultaneously to get the effect you want:

The �� upper forehead feature point controls the 
forward/backward position of the hair on the crown; it 
also controls the shape of the forehead if you have the 
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Apply Shape button on.

The next feature point down controls placement of the ��
eyebrows. It also affects the forward/backward tilt of 
the head to a small degree.

The third feature point affects the indentation of the ��
sellion (nose indentation) when the Apply Shape button 
is on. It also affects the shape of the inner eyes and nose 
area on the texture.

The fourth and fifth feature points control the��  tip and 
bottom of the nose. Observe the placement of the 
nostrils while you adjust these.

Adjust the points of the �� mouth to improve the texture 
where necessary. If you have the Apply Shape option 
checked, adjust the points until you are satisfied with the 
shape of the mouth. You may also need to adjust points 
in the front view to realign the texture.

Adjust the��  top and front of the chin to shape the 
area beneath the mouth. 

Figure 15.27: Starting from the hairline at the forehead, adjust all profile points 

down through the chin to further define the character and texture.

Adjust the eye. As you reach the end of the feature point list, 4.	
you will probably find that you’ll have to go back and tweak 
previous points in order to place the remaining ones. What 
matters for the corner of the eye is the height of the feature 
point. This makes a big difference in the shape of the eyelids 
on the 3D model. 
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Figure 15.28. Adjust the eye feature point to achieve the correct texture placement 

around the eyes. The feature point controls the tilt of the eyelids and eye corners.

Adjust the cheek. Place the cheek feature point at about the 5.	
same height as the tip of the nose. If you have the Apply 
Shape feature on, move the cheek feature point toward the 
front of the head to create puffier cheeks, or toward the back 
of the head to create a more gaunt face. 

Adjust the neck, jaw, and ear. The primary focus for this part is 6.	
to get the texture correct. A little goes a long way, especially in 
shaping the head and ear - so focus on the texture placement 

at this point. You may also find it helpful to use the Move tool 
to reposition the outline on the photo. Figure 29 shows our 
progress. While the profile around the mouth and chin doesn’t 
quite follow the photo, the texture looks nice and clean. 

 The feature points and outlines in the following figure 
do not exactly match the profile of the photographs. While 
a result like this creates a good texture, it will distort the 
geometry if the Apply Shape checkbox is checked. The reason 
for this is because the green control points are stretched far 
from the red outline in spots.
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Figure 15.29. With all points adjusted in the front and side views, the texture 

looks nice and clean.

If desired, you can go back through all of the feature points and 
give them little tweaks to improve your texture further. However, 
if you’re happy with it for the time being, leave it as is ... you can 
always clean up the texture in an image editing program such as 
Photoshop!

 Now that the texture is complete, it might also be a 
good time to go to the Pose room, and save your project so 

that you don’t lose all of your hard work. The next step is to 
refine the shape of the head.

Adding Texture Variation
You can use the Face room’s Texture Variation area to enhance 
your Face room texture in various ways. This includes adjusting the 
facial color to darken eyebrows and eye area, and adding shading 
for beards. You can also vary the texture to add ethnicity, age, or 
gender differences.

To add texture variation, click the Texture Variation tab that 
appears to the right of the Photo Lineup tab. Figure30 shows all 
of the options you can add to your texture.
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Figure 15.30: The Texture Variation area allows you to adjust shading of the 

texture to achieve various enhancements to the Face Room texture.

To add variation, simply move a parameter dial left or right, or 
enter a numerical value in the appropriate field. For purposes of 
demonstration, Figure 31 shows an example of how the Beard 
parameter dial affects the texture.

Figure 15.31. A beard is added to the texture using the Texture Variation options.

Saving Your Texture
After your texture is complete, you can save a copy to your hard 
drive by using the controls located at the side of the Texture 
Preview area. Follow these steps:

Click the 1.	 Save icon that appears at the right of the Texture 
Preview area, as shown in Figure 32.
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Figure 15.32. To save your texture, click the Save icon at the right of the Texture 

Preview area.

Poser asks if you want to change the texture resolution. 2.	
Choose No to leave the texture at its default resolution of 512 
by 512, or Yes to save a higher-resolution texture (in this case, 
2048 x 2048).

Next, Poser asks if your texture will be for a male or female. If 3.	
you created a male texture, choose Yes. If you created a female 
texture, choose No.

Finally, the 4.	 Save As dialog appears. Locate the folder to save 
your texture. Then choose a file format from the Save As 
Type dialog. Some file types will also require that you choose 
a compression setting. If you plan to edit and enhance the 
texture in a graphics program, it’s usually best to choose a file 
format that does not compress the image.

Click Save to save your new texture.5.	

Task 4: Refine the Head Shape
The Face Shaping Tool, shown in Figure 33, provides several 
morph dials that allow you to change the facial features of your 
character. There are basically three ways you can reshape the face, 
and you can use all or some of them to achieve a wide variety of 
characters:

Automatically create a face using the Random Face button •	
that appears beneath the Face Sculpting area.

Click on the face in the Face Sculpting area to locate a green •	
feature point, and drag the mouse to adjust the shape of the 
face. Changes are applied to the face symmetrically where 
applicable.

Use the Facial Morphs in the lower section of the Face Shaping •	
Tool.

Let’s take a look at each of these procedures individually.

 If you did not complete Task 3, you can open the 
FaceRoomTask4.pzz file from the Tutorials/FaceRoom folder in 
your Poser installation to follow along from this point.
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Figure 15.33. The Face Shaping Tool allows you to change the appearance of 

the facial features.

Creating a Random Face
The Random Face feature helps you generate a character 
that serves as a great starting point for your final character. The 
character you generate can be as realistic or as outrageous as you 
choose. The Random Face button, located beneath the Face 
Sculpting area, allows you to generate a completely random face 

with the click of a button.

Additional controls in the Face Shaping Tool control how much 
effect the Random Face button has on the head geometry. These 
controls are shown in Figure 34.

Figure 15.34. Controls in the Face Shaping Tool affect the results of the Random 

Face button.

The controls shown above are used for the following purposes: 
Morph button

The yellow button at the top of the Face Shaping Tool allows you 
to reshape the face by pulling or pushing a control point with the 
mouse.

Pin button•	 : After you adjust a feature point to the shape 
you want, click the Pin button, and then click the desired 
control point to lock it into place.

Clear Morphs•	 : Click this button to revert the head shape 
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back to its original default shape. DO NOT use the Reset Face 
Room button unless you also want to lose your current face 
texture.

Clear Pins•	 : Click this button to remove the pins that keep 
the morphs from affecting your facial morphs. This removes all, 
not some, of the pins.

Caricature•	 : Adjust this dial, plus or minus, to add or remove 
the amount of exaggeration in the final face. A Caricature 
setting of -1 turns all morph dials completely off, and the 
Random Face button will not work. Set the Caricature dial 
between -1 and 0 to achieve faces that are more realistic; the 
closer they are to -1, the more realistic they will be. Settings 
between 0 and 1 create characters that are more “cartoony” 
or fantasy-like.

Exaggeration Min•	 : Adjust this dial to the minimum 
amount of affect that you want each of the facial morphs to 
have. The default setting is -1.5. If you don’t want any of the 
facial morphs to work in a negative setting, you can set this 
at 0. If you want the Random Face button to have a smaller 
effect on the overall shape of the face, you can decrease this 
setting to -.15. This results in random faces that are a bit more 
realistic and less characterized.

Exaggeration Max•	 : Adjust this dial to the maximum 
amount of effect that you want each of the facial morphs to 
have. The default is 1.5, but setting it at a smaller value (such 

as .15) results in random faces that are a bit more realistic and 
less characterized.

Use Morphs•	 : There are three Use Morphs options: 
Both (the default), Symmetry, and Asymmetry. When Both 
is selected, the morph dials will make symmetrical and 
asymmetrical changes to the face. With Symmetry selected, the 
only changes made to the face will be symmetrical changes. 
With Asymmetry selected, the only changes made to the face 
will be asymmetrical.

To create a random face, follow these steps:

Set the Caricature dial, if desired, to a value other than -1. For 1.	
more realistic characters, set this value closer to -1. For more 
extreme characters, move the setting more toward 1. A good 
compromise is -.5. You can also adjust the dial left or right at 
any time to affect the amount of caricature after you use the 
Random Face button or other morphs.

Set the 2.	 Exaggeration Min and Exaggeration Max dials to 
the lowest and highest values (respectively) that you want the 
morph dials to target. A min value of -.15 and a max value of 
.15 creates very good starting points for realistic characters.

Decide whether you want the morphs to affect Symmetry 3.	
(same changes right and left), Asymmetry (differences in right 
to left), or both.

Press the 4.	 Random Face button under the Face Sculpting 
area until you get a face that you like. Figure 35 shows some 
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examples achieved with Caricature at -.5, Exaggeration Min 
at -.15, Exaggeration Max at .15, and “Both” selected for 
Morphs options. As you can see, the faces truly are random 
and offer a great starting point for characters. You can also go 
back and adjust the settings you selected in steps 1 to 3 to 
get even more varied results.

Figure 15.35. Random faces created in the Face room offer great starting points 

for Poser characters.

Changing the Face Shape 
Interactively
Whether you start with a random face or the default face, the 
feature points that you work with in the Face Sculpting area 
allow you to visually adjust the Facial Morphs in the Face 
Shaping Tool. As you click and drag one or more of the feature 
points, you notice that the morph dial settings in the Face 
Shaping Tool respond to the adjustments. As a result, the 
adjustments you make to the face are limited to the morphs that 
you find in the Face Shaping Tool.

That being said, it’s very easy to reshape the face with feature 
points:

Because the sculpting tool moves vertices relative to the 1.	
way that you are viewing the model, you will need to adjust 
the mini-camera controls at the top right corner of the Face 
Sculpting area to rotate or zoom into the area you want to 
work with. 

Click on the face in the 2.	 Face Sculpting area to locate a 
feature point, which appears as a green dot similar to those 
you see in the Photo Lineup area.

Move the mouse to reshape the face. Changes are made 3.	
symmetrically when applicable. Figure 36 shows an example 
of an adjustment in progress.
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Figure 15.36. Use the green feature points to adjust the face in the Face Sculpting 

area.

Once you adjust an area to the shape that you like, you can 4.	
“freeze” the associated dial setting into place. This prevents 
the dial setting from changing while you work on other areas 
of the face. To apply a pin, click the Pin button (the yellow 
button at the top of the Face Shaping Tool). Then, click the 
area that you want to freeze. Pins are shown with a red dot. 

Then reselect the Morph button to continue working on other 
areas of the face. 

 To delete a pin, simply move or click it with the mouse. 
To delete all pins, click the Clear Pins button at the top of the 
Face Shaping Tool.

Changing the Face with Morph Dials
The Face Shaping Tool comes with a host of facial morphs that 
control various facial features and head shapes. Facial morphs are 
divided into several different categories: Brow Ridge, Cheekbones, 
Cheeks, Chin, Eyes, Face, Forehead, Jaw, Mouth, Nose, Templates, 
and Ears. There are also additional morphs that affect ethnicity, age, 
and gender, or morphs that apply the shapes of the Poser default 
characters (Don, Judy, Will and Penny).

 There are additional morphs in the Pose room. While 
most deal with facial expression, some of them are also good 
for character development. Be sure to check those out after you 
apply your Face room head to your character.

Earlier, we covered how to prevent movement of morphs by using 
pins. Somewhat related to pins, you can also enable or disable 
individual morphs from working. Beside each morph in the Face 
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Shaping Tool is a green bullet point, as shown in Figure 37. When 
a lock icon appears beside the morphs they will not change. To 
lock morphs, click the green bullet point beside an entire category 
(such as Cheekbones). This prevents an entire group of morphs 
from being affected. To unlock the morph, click the padlock icon to 
change it back into a bullet. You can also click a single morph (such 
as high/low or thin/wide) to prevent it from being affected.

Figure 15.37. You can lock morph dials to keep them at their current settings. 

Click beside a group name to lock or unlock all morphs beneath it, or click a 

single morph name to lock or unlock it.

If you have used the Random Face feature, or the morph tool 
and pins, you’ll probably see some of the dials have already been 
adjusted beyond the default setting of 0. Using the morph dials is 
very straight-forward. Move the parameter dial to the left to reduce 
the effect of a morph or dial it into the negative range. Move the 
parameter dial to the right to increase the effect or dial the morph 
into the positive range. 

 There are quite a few morphs that have the words 
Axis, Twist, Asymmetry, Transverse, Disparity, Bend, or Shear 
in them. For the most part, these morphs add asymmetry to 
your character, making them appear a little more realistic. Even 
a little bit of these morphs goes a long way toward adding 
realism to your character.

It took several morphs to create the face shown at the right in 
Figure 38. Rather than include all of the settings in this tutorial, 
you can find the project file in the Tutorials/FaceRoom folder in your 
Poser installation. The file is named FinishedCharacter.pzz
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Figure 15.1: 38. The final face (right), found in FinishedCharacter.pzz, uses 

several of the morphs in the Face Shaping Tool. Differences in the forehead, eyes, 

and cheekbones are more feminine than the default head (shown at left).

Task 5: Completing Your 
Character
The Actions area of the Face room, shown in Figure 39, provides 
several buttons that allow you to apply the head, texture, or both to 
the currently selected character in the Pose room. The button you 
choose is dependent upon how you want to apply the head and 
texture:

Apply to Figure•	 : Click this button to permanently apply 
the head shape and texture from the Face room to the figure 

in the Pose room. If multiple figures are on the stage, the 
changes apply to the currently selected figure.

Apply Shape Only•	 : Click this button to permanently apply 
the head shape only to the figure in the Pose room.

Apply Texture Only•	 : Click this button to apply the texture 
only to the figure in the Pose room.

Spawn Morph Target•	 : Click this button to add the head 
and eyes as morph targets to the figure in the Pose room.

Import Original Figure Head Texture•	 : Click this 
button to apply the head texture that is currently on your Pose 
room figure to the head in the Face Sculpting area.

Figure 15.39. The Actions area provides several buttons that complete your 

character in different ways.
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Creating a Permanent Character
The Apply to Figure button creates a permanent modification to 
the character in the Pose room. The head effectively replaces the 
default head provided with Don, Judy, Will or Penny. The texture 
can be applied with or without color adjustments to match your 
head texture to the default body texture. After you create your 
character, you can save it to your Figures library for future use.

 The Edit > Restore > Element and Edit > Restore 
> Figure commands will not restore the default character 
head after you apply the Face Room head to your figure. 
There is one way to get the default head back. First, save your 
current project so that you can revert back if things go wrong. 

Next, return to the Face Room, click the Clear Morphs 
button in the Face Shaping Tool. Go to the Standard Figures 
> Poser category of the Face Shaping Tool, and then dial the 
applicable character morph (select from the default character 
morphs) to 1. Then click the Apply to Figure button that 
appears in the Actions section of the Face Room.

To create a permanent character with a new head and face texture, 
follow these steps:

Go to the 1.	 Pose room, and add or select the figure that you 
want to apply the head shape to.

Return to the 2.	 Face room. Click the Apply to Figure button 
in the Actions area. Poser asks if you want to change the 
texture resolution to apply.

Choose No if you want to keep the default texture ��
resolution of 512x512. This results in a smaller file, and is 
suitable for distant renders.

Choose Yes to create a higher resolution texture (1024 x ��
1024 or larger).

Poser informs you that it is creating an alpha map and then 3.	
creates the texture. Next, Poser asks if you want to change the 
face color to match the figure color.

Choose No to retain the coloring of the face texture ��
exactly as you see it in the Face room. This choice would 
apply if you also intend to use another graphic program 
(such as Photoshop) to create a matching body texture. 
Figure 40 shows an example of this option.

Choose Yes to instruct Poser to adjust the coloring of your ��
Face room texture to match the existing body texture. 
Figure 41 shows an example of this option.

Open the 4.	 Figures library and save your new character so that 
you can use it in other projects.
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Figure 15.40. Here, the head and face texture have been applied to the figure 

without adjusting the color of the texture, keeping the original colors of the 

photographs. Choose this option when you plan to create a matching body 

texture.

Figure 15.41. Here, the head and face texture have been applied to the figure 

while adjusting the color of the texture. Choose this option when you use the 

default body texture.

Using Third-Party Textures with the 
Face Room
There are many textures available in the Poser community, many 
of which will work on any applicable Poser 5 or later figure. There 
is a two-part process to using third-party textures with the Face 
room. You will need to add the third-party texture to the Face room 
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to get an accurate view of how your face shape will look when 
done. You’ll also have to apply only the head shape to the figure 
in the Pose room after you create your head shape. The steps are 
as follows:

Use the 1.	 Material room, or MAT poses provided with your 
third-party texture, to apply the third-party texture to your 
figure. 

Make sure that the figure is selected in the 2.	 Pose room, and 
then click the Face tab to enter the Face room.

Click the 3.	 Import Original Figure Head Texture button in 
the Actions area. You can do this before or after you develop 
your head shape.

After you morph your head in the 4.	 Face room, click the Apply 
Shape Only button in the Actions area of the Face room. 
This applies the head to the character without affecting the 
texture that you purchased.

Go to the 5.	 Pose room to view the result, as shown in Figure 
42.

Figure 15.42. Use the Import Original Figure Head Texture and Apply Shape 

Only options to use third-party textures in the Face room.

Creating a Morphable Face
You may not want to use this character all the time; or, you may 
want to store several different characters in one Library file. In 
cases like these, the Face room allows you to apply the head and 
eye morphs as a morph target. This will allow you to “dial in” the 
amount of character you apply to the default character. It will also 
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allow you to mix and match between other characters that you 
create in the Face room.

When you choose Spawn Morph Target from the actions area, 
the morph appears in the list of morphs in the Pose room. By 
saving your character to the Figures library after you spawn one or 
more morph targets, you can dial in any character, or combination 
of characters, any time you choose.

To apply the head and eyes from the Face room to the Pose room 
as a morph target, follow these steps:

Go to the 1.	 Pose room and add or select the figure that you 
want to apply the texture to.

Return to the 2.	 Face room and click the Spawn Morph Target 
button in the Actions area.

Go back to the 3.	 Pose room. If necessary, choose the Window 
> Parameter Dials command to open the Parameters 
palette.

Select the head of your character, and expand the 4.	 Morph 
section of the dials. Scroll to the bottom of that section, where 
you will see a new morph named “head” as shown in Figure 
43. Dial this to 1 to apply your head morph target.

Figure 15.43. When you spawn your head room morph, the morph appears in the 

“Morph” section of the Parameters palette, and it is named “head.

The eyes look a little odd at this point, don’t they? That’s 5.	
because you also have to do the same for the left eye and 
right eye. Click one of the eyes, and go to its morph section. In 
this case, there is already a morph named “rightEye”, so the 
new morph that you created is named “rightEye 1” as shown 
in Figure 44.” Dial that to 1 to apply your Face room morph.
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Figure 15.44. The Face room morphs appear as “leftEye 1” and “rightEye 1” 

for the eyes.

Repeat step 5 for the opposite eye.6.	
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Chapter 16: The Cloth Room

	
by Denise Tyler
The Cloth room helps you create dynamic clothing that drapes 
naturally, and that responds to movement and wind forces during 
an animation. You will find dynamic clothing in the Poser Props 
library.

The Cloth room contains four main areas: 

Cloth Simulation (area 1). This area creates and defines •	
settings for a new cloth simulation.

Cloth (area 2). This area allows you to turn an object into •	
“cloth”, and specify which objects the cloth will respond to 
when they collide.

Cloth Groups (area 3). This area allows you to assign dynamic, •	
choreographed, constrained, or decorated groups to your cloth 
object. 

Dynamics Controls (area 4). This area allows you to assign •	
properties that affect how the cloth behaves in the simulation.

Figure 16.1. The Cloth room consists of four main areas. 

Task 1: Creating Still Images 
with Dynamic Clothing
In this task you will create a still image. Even though the final goal 
is a still, you have to create an animation to drape and settle the 
clothing to the correct position. By default, Poser creates a 30-
frame animation, which will be perfect for our needs. We will pose 
the character in the first frame, and use the remaining frames to let 
the cloth settle.
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The ClothRoomTask1.pzz file has Jessi loaded into the scene. She 
appears in the default position and the inverse kinematics settings 
are turned off for the arms and legs.

  To turn Inverse Kinematics off, choose the Figure > 
Use Inverse Kinematics menu option, and uncheck all 
options.

Afterward, the easiest way to place a character in the default 
position is to open the Joint Editor palette (Window > Joint 
Editor). Then click the Zero Figure button to zero out all of 
the joints. (If the Zero Figure button is grayed out, click any 
body part first.) After you close the Joint Editor, double-check 
in the Parameters palette to verify that the X, Y, and ZTran 
settings on the hip and body are all at zero. 

In the following example, we will use one of the clothing items 
from the Props library for Jessi. 

Open the ClothRoomTask1.pzz file, which you will find in the 1.	
Tutorials/ClothRoom folder in your Poser installation. This 
scene contains Jessi, who is placed in the default position.

Now, navigate to the Tutorial subcategory in the Props library. 2.	
Open the Dynamic Clothing subcategory folder. Select the 
JessiEveDressRaw dress shown in Figure 2 (the one with the 
red dot in the icon), and add it to your scene.

  The JessiEveDressRaw dress contains around 10,000 
polygons. If you have limited system resources, use the 
JessiEveDressLo version (the one with the yellow dot), which 
contains less than 3000 polygons. It will not bend as smoothly, 
but will still serve the purpose for this tutorial.

  The only difference between the JessiEveDress and 
JessiEveDressRaw is that the raw version does not contain any 
Cloth room cloth groups. Use the raw version for this tutorial.



Poser 8
Tutorial Manual

151

Chapter 16: The Cloth Room

Figure 16.2. Select the JessiEveDressRaw file, which does not contain any cloth 

groups.

To attach the clothing to the figure, you’ll need to assign 3.	
the character’s Hip as the parent to the dress. With the dress 
selected as the current object, choose Object > Change 

Parent. The Choose Parent dialog appears. Choose either the 
Hip or the Body, as shown in Figure 3, then choose OK to 
return to the Cloth room.

Figure 16.3. Choose the figure’s Hip as a parent to the dynamic clothing prop.

Verify in the Animation controls that you are on Frame 1, as 4.	
shown in Figure 4. Then click on Jessi to select her as the 
current figure.
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Figure 16.4. Verify that you are on Frame 1 of your project file.

Open the Tutorial folder in the Poses library, and choose the 5.	
JessiWalk01 pose. Then click the Apply Library Preset check 
mark at the bottom of the Poses library. Jessi should now be 
posed as shown in Figure 5. Note that the dress does not 
automatically conform to the figure in the way that clothing 
from the Figures library does. The reason for this is that the 
dress is a prop that was designed for the Cloth room. It does 
not contain groups that automatically respond to the groups 
in the figure.

Figure 16.5. The character is posed in Frame 1, but the dress does not pose with 

it.

Now, click the Cloth tab to enter the Cloth room. You will step 6.	
through the sections quickly in this first tutorial. Later in this 
section you’ll learn more about what each of the settings do.

Initially, only one button in the Cloth room is enabled. Click 7.	
the New Simulation button in section 1, shown in Figure 6.
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Figure 16.6. Click the New Simulation button to create a cloth simulation.

In the Simulation Settings dialog box (shown in Figure 7) enter 8.	
Dress for the Simulation Name. Check the Cloth self-collision 
option so that the dress won’t fold over onto itself during 
the cloth simulation. Then enter 10 in the Drape Frames field. 
This setting adds ten frames before the animation begins, to 
drape the dress naturally on the character before the dynamics 
calculations start. Press OK to create the simulation.

Figure 16.7. The Simulation Settings dialog box.

After you create a simulation, the next step is to turn your 9.	
prop into a cloth object. To do this, first click the Clothify 
button in section 2 of the Cloth room, shown in Figure 8.

Figure 16.8. The Clothify button turns the prop into a cloth object.
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When the Clothify dialog opens as shown in Figure 9, expand 10.	
the Props popup-menu, and choose the dress prop as shown 
in the following figure. Then click the Clothify button to turn 
the prop into cloth.

Figure 16.9. Choose the dress from the Props pop-up menu.

The Collide Against button should now be active in the 11.	
Cloth section (section 2). Click this button to open the Cloth 
Collision Objects dialog shown in Figure 10.

Figure 16.10. The Cloth Collision Objects dialog lets you select the objects that 

will cause the cloth to respond when they collide.

Click the Add/Remove button to open the Hierarchy Selection 12.	
button shown in Figure 11. By default, nothing is selected. 
Because this is a small scene that should calculate very quickly, 
you can select (or check) Figure 1 (or the number of the figure 
you want to dress). This automatically selects the entire tree 
beneath it. Click OK to return to the Cloth Collision Objects 
dialog.

  In the case of larger scenes, you may want to limit 
the selection to only those body parts or other items that you 
expect will come into contact with the cloth object. This will 
reduce calculation time during the dynamics calculations.
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Figure 16.11. Select the object or objects that you expect will come in contact 

with the cloth object.

You should now notice that additional options are enabled in 13.	
the Cloth Collision Objects dialog. For purposes of this tutorial 
we will leave the default values. The important setting to note, 
however, is that Start Draping from Zero Pose is checked in the 
Figure Collision Options dialog, as shown in Figure 12. This 
setting is applicable because the first frame of the animation 
has the figure in the zero “Default” pose. Press OK to return 
to the Cloth room.

Figure 16.12. Verify that the “Start draping from zero pose” option is checked.

The Dynamic Controls settings in section 4 are sufficient 14.	
for the purpose of this brief tutorial. Click the Calculate 
Simulation button located at the top of the Dynamics Controls 
section (section 4). This button is shown in Figure 13.

Figure 16.13. Click the Calculate Simulation button.

After a brief wait, Poser should drape the dress over the figure 15.	
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as it moves toward the pose you selected. During the draping, 
it will appear as if the clothing is always one frame behind 
the final result. Once Poser completes the draping calculations 
and starts calculating dynamics, the dress should be posed 
correctly. During the dynamics calculations the cloth will settle 
a little bit. This will be more noticeable when clothing is fuller. 
The final result of the simulation, shown at Frame 30, is shown 
in Figure 14.

Figure 16.14. The final result using cloth dynamics.

With Frame 30 (or the frame of your choice) selected as the current 
frame in the Cloth room, click the Pose room tab. You can add 

items to the scene, change lighting, or whatever else needs to be 
done to complete the scene. Then render it to any size you like, just 
as you would any other still image. You can even adjust the hand 
on her left leg so that the fingers don’t poke through the clothing. 
The only thing you really can’t do is move her pose in any way 
that would affect the draping of the clothing. If you do, you would 
have to enter the Cloth room again, and click the Calculate 
Simulation button again to re-calculate the cloth simulation.

  The steps to create an animation that uses dynamic 
clothing are pretty much the same as outlined above. You 
simply add keyframes that pose your character in various 
frames throughout the animation, and the clothing dynamics 
will move in response to the character’s motion.

Task 2: Controlling How 
Clothing Acts
Sometimes, results don’t come out quite as you expected. For 
example, you might want to create a still image of a woman sitting 
in a chair, wearing a full dress. You put the figure in its default 
position in the first frame, and add the dress and chair. In a later 
frame, you pose the figure in its final position, sitting down in 
the chair. When you calculate the dynamics, things don’t appear 
the way they should. As the figure sits down, the dress bunches 



Poser 8
Tutorial Manual

157

Chapter 16: The Cloth Room

beneath her and doesn’t fall properly when she sits. The dress 
overlaps the chair during the calculations, and creates a jumbled 
mess. How can you prevent that?

Think about the actions that a woman performs while wearing a 
dress. When she sits down in a chair, she uses her arms and hands 
to pull a dress toward her while she moves toward the chair to sit. 
That prevents the dress from bunching up and getting wrinkled. 

You can accomplish similar results in Poser for your dress. There are 
actually a number of different ways you can accomplish this:

You can animate the character’s arms in the same way they •	
would move in the real world. This would probably be the best 
solution for an animation, but it seems a lot of work for a still 
image. 

Use a prop, such as a bar or half-donut shape, to push the •	
dress forward while the character moves toward the sitting 
position. After the dress is in place you can move the prop out 
of the view of the camera.

Animate the chair in such a way that the chair itself •	
pushes the dress forward as needed. This approach will be 
demonstrated in the following tutorial.

The file ClothRmTask2.pzz, located in the Tutorials/ClothRoom 
folder in your Poser installation, contains Jessi in a mid-length 
dress. There is also a chair in the scene. The simulation is set as 
follows in the Simulation Settings dialog: 

Simulation Name: •	 Dress

Start Frame: •	 1

End Frame: •	 30

Additional Cloth Collision Objects: •	 Cloth self-collision

Drape Frames: •	 10
Cloth Collision options are also important when you want the 
clothing to react to props. In addition to selecting Figure 1 for 
collision objects, the project file is also set to respond to the chair, 
as shown in Figure 15.
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Figure 16.15. The cloth will react to the figure and the chair during collision.

The chair appears just behind her in Frame 1. Note how the dress 
intersects with the chair in Figure 16. This is a situation that you 
must avoid, as it can create a tangled mess as well as excessively 

long calculation times. We will correct this problem in the tutorial.

Figure 16.16. The chair is placed directly behind the figure, but the dress 

intersects the chair.

Move forward to Frame 15, and you will see Jessi sitting in the 
chair. The dress tilts to respond to the position of her body as 
shown in Figure 17. 
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Figure 16.17. Jessi sits on the chair in Frame 15.

For demonstration purposes, click the Calculate Simulation 
button in section 4 and observe what happens with the project 
settings as they are now. Poser drapes the dress over the standing 
figure. Then, as the figure begins to drape, and then sit, you notice 
the back of the skirt begins to bunch up over the chair, as shown 
in Figure 18. 

Figure 16.18. At the beginning of the calculations, the dress begins to bunch up 

over the chair.

As the animation progresses further, the calculations take longer 
to complete in each frame. This is usually an indication that things 
are getting bunched up and faces are starting to overlap. When 
the calculations are complete, the dress appears really bunched up 
under the character as shown in Figure 19. While it doesn’t look 
objectionable, you can also improve it. 
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Figure 16.19. When the calculations are finished, the dress is very bunched up.

To remedy some of these problems, try these steps:

Use the Animation controls to return to Frame 1.1.	

If the Parameters palette is not opened, choose Window > 2.	
Parameter Dials to display it. 

Click the chair to select it. Notice that the zTran value is set 3.	
at -1.746. To move the chair farther away from the character, 
decrease the value to somewhere around -3.7 as shown in 
Figure 20.

Figure 16.20. Move the chair farther away from the character by decreasing the 

ZTran value.

Advance to Frame 15 and make sure that the chair is in its 4.	
final position, and that Jessi is sitting on it properly. If not, 
adjust the position of the chair as needed.	

Click the Calculate Simulation button again. This time, the 5.	
dress drapes naturally over the character before the chair starts 
to move toward the character. As the chair moves toward its 
final position, it moves the dress forward and underneath the 
character, in much the same manner as the dress would fall 
naturally. The final result is shown in Figure 21. Notice that the 
dress isn’t quite as bunched up now.
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Figure 16.21. After animating the chair into place, the dress appears more 

natural.

Task 3: Using Different 
Materials in Clothing (Part 1)
After you “clothify” an object (or turn it into cloth), Poser assigns 
all of the vertices in the clothing to a group named _default_. What 
this means to you is that the entire object will behave as if it is all 
made of the same type of cloth.

What if you want your clothing to behave as if it were made of 

two different types of cloth? Cloth groups allow you to assign 
vertices to different areas of your clothing object. First, however, it 
helps if you assign different materials to the clothing object first, 
and then use the material zones to define the cloth groups.

There are other reasons for using different groups in your dynamic 
clothing object. For example, your clothing may also include 
buttons or laces that decorate the clothing. If you keep everything 
in the _default_ group, your buttons will stretch and bend the 
same as the cloth in your object. In addition, they might even fall 
off onto the floor during the calculations. In the case of buttons, 
you can assign them to a rigid decorated group in section 3 
of the Cloth room. Lacings or belts might be assigned to a soft 
decorated group.

For example, the top of a dress can be made of sequins, and the 
lower part made of satin. Sequins are stiff and satin flows very 
easily. In that case, you need to create a new dynamic group, 
and assign the “sequin” vertices to it. Then, you use the Dynamic 
controls in section 4 to cause the sequin dynamic group to 
behave differently.

  You can assign materials to your objects in a modeling 
application (such as LightWave, 3D Studio Max, Wings, or 
similar applications). You can also use UV mapping programs 
such as UV Mapper Classic or UV Mapper Pro to assign 
materials. You can even use the Poser group editor to assign 
materials to your objects. 
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There are five types of cloth groups in Poser, all accessible in section 
3 of the Cloth room:

Dynamic cloth groups•	 : Assign vertices to this group 
when you want the cloth to be of a different “fabric” than 
the rest of the clothing. Later, you define the behavior of that 
fabric in the Dynamics Controls section of the Cloth room. 
An object can contain more than one dynamic cloth group.

Choreographed groups•	 : Only one choreographed group 
is allowed per object. Assign vertices to a choreographed 
group when you want to keyframe their movement. You can 
also use choreographed groups to prevent faces from being 
used in the cloth simulation. To cite an example, imagine that 
you have a sheet lying on top of a bed. You define a small 
circle of vertices located at the center as a choreographed 
group. You animate the choreographed vertices upward and 
away from the bed, and the remaining vertices respond to 
gravity and motion ... and the sheet now looks like a ghost 
flying across the room.

Constrained groups•	 : Assign vertices to a constrained 
group when you want them to “stick” to the underlying faces. 
For example, if you have a strapless top on a character, you 
can assign the very top row of vertices to a constrained group 
so that the top will not slip off and fall to the floor. Only one 
constrained group is allowed per object.

Soft Decorated groups•	 : Assign vertices to this group 

when you want them to flex and move with the underlying 
cloth. Belt buckles, belts, and shoelaces would be good 
examples of the types of vertices that would belong to this 
group. One object can have two decorated groups: one soft 
and one rigid.

Rigid Decorated groups•	 : Assign vertices to this group 
when you want them to move with the underlying cloth, but 
not bend or flex. Buttons, pins, jewelry, belt buckles, and other 
similar items are good examples here. One object can have 
two decorated groups: one soft and one rigid.

Let’s put these points into practice with a simple example. The dress 
we used in the previous task does have a couple of problems:

In certain positions, the straps of the dress slip off her shoulders. To 
prevent this, we can assign some of the vertices at the top of the 
strap to a constrained group.

The top of the dress is also a bit too stretchy. We can create a new 
dynamic group that includes all of the vertices from the waist up. 
Later, we can use Dynamics Controls to make the sequin group a 
little less stretchy, and a little less soft.

The best approach is to add vertices to a new dynamic group first, 
and then select a small amount of vertices from the top of the 
straps afterward. The following task demonstrates how you can 
assign these cloth groups to the dress:

Open the project file named ClothRoomTask3.pzz from the 1.	
Tutorials/ClothRoom folder in your Poser installation. This file 
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begins where Task 2 left off.

Click the Cloth tab to enter the Cloth room if necessary.2.	

The project should open with the Dress simulation displaying 3.	
as the current cloth simulation. In section 3, _default_ 
appears as the current dynamic group. To add a new dynamic 
group for the top of the dress, click the New Dynamic Group 
button shown in Figure 22.

Figure 16.22. The New Dynamic Group button.

A dialog opens, and prompts you to enter a name for the new 4.	
dynamic vertex group. Enter Sequins, as shown in Figure 23. 
Click OK to continue.

Figure 16.23. Create a new dynamic group named Sequins.

Note that Sequins now appears as the currently selected 5.	
dynamic group at the top of the Cloth Groups section. Click 
the Edit Dynamic Group button shown in Figure 24 to assign 
vertices to this new group.

Figure 16.24. Click the Edit Dynamic Group button to add vertices to the new 

group.

The Group Editor window opens, and Sequins displays as the 6.	
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current group name. Now, you can use the mouse to select 
the upper portion of the dress, down to the waist as shown in 
Figure 25. Rotate the camera to make sure that you include all 
vertices from the top of the dress.

Figure 16.25. Use the mouse to add vertices from the upper portion of the dress 

to the sequin group.

To verify that you have included all of the top vertices, switch 7.	
back to the default cloth group, using the group selection box 
at the top of the Group Editor (shown in Figure 26). If some of 
the vertices in the top still appear in the default group, you can 
reselect the Sequins group again to add them in.

Figure 16.26. Alternate between the default group and the Sequins group to make 

sure that you have selected all of the top vertices for the Sequins group.

With the Sequins group completed, we will now select some 8.	
vertices to prevent the straps from falling over her shoulders. 
Click the Edit Constrained Group button in the Cloth Groups 
section, shown in Figure 27. 

Figure 16.27. Click the Edit Constrained Group button to select some vertices in 

the straps.
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Using the mouse, draw a selection around the top portion 9.	
of the dress straps, as shown in Figure 28. Again, rotate the 
camera to make sure that you select enough vertices. to 
prevent the straps from slipping down.

Figure 16.28. Select vertices near the top of each strap to add them to the 

Constrained group.

  There is another approach that you can use to assign 
vertices to cloth groups. Use your modeling program, or a 
UV mapping program (such as UV Mapper Pro), to assign 
materials to the different cloth groups. For example, you 
could select the top of the dress and create a material named 
“Sequins.” Use the Group Editor in the Cloth room to 
create the Sequins dynamic group as described in the previous 
example. Then, click the Add Material button in the Group 
Editor to select the Sequins material.

Task 4: Using Different 
Materials in Clothing (Part 2)
In the previous task, you created a couple of different cloth groups. 
The dynamic cloth group named Sequins will behave differently 
than the bottom of the dress, which uses the default cloth settings. 
The purpose for these different groups is to demonstrate how you 
can create a garment that uses more than one type of material.

The Dynamics Controls section of the Cloth room controls how 
fabrics behave. The settings you choose here may be different, 
depending on whether you are doing a still or an animation. Low 
settings may make a dress drape naturally for a still image of a 
sitting figure; on the other hand, that same setting could wreak 
havoc during animation and cause the fabric to fly and stretch 
much more than it would naturally during movement.

In cases like this, the settings in the Dynamics Controls section 
can help you create cloth that behaves in a manner that is more 
typical of the type of cloth you are trying to simulate. In brief, the 
settings are as follows:

Fold Resistance 

(Default 5.000)

This setting controls how much or how little the fabric 
will fold or bend. Settings can range from 0 to 1000, with 
a setting of 5 being the default setting. Lower settings 
produce cloth that flows and drapes more easily, like silk 
or satin. Higher values create cloth that is more resistant to 
folding and bending, such as a heavy wool or leather coat.
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Shear 
Resistance 

(Default 50.000)

This setting controls how much or how little the cloth will 
bend from side to side or collapse on itself, as the corners of 
a tablecloth or bedspread would behave when draped over 
the table or bed. Softer materials will have higher Shear 
Resistance values than more rigid materials.

Stretch 
Resistance 

(Default 50.000)

This setting controls the stretchiness of your material. 
Materials such as coat leather don’t stretch much at all. 
Glove leather stretches a little bit more. A knitted sweater is 
even stretchier still ... and spandex is extremely stretchy. Use 
lower Stretch Resistance settings here to increase the 
stretchiness. The default setting of 50 is suitable for cotton.

Stretch Damping 

(Default 0.0100)

Stretch Damping is most obvious during an animation. 
This setting controls how slowly or rapidly the fabric stops 
moving while it stretches. Low settings cause the cloth 
to flap excessively, whereas high values make the cloth 
move in slow motion. A setting of .01 is suitable for most 
purposes.

Cloth Density 

(Default 0.0050)

The Cloth Density setting controls how heavy the fabric 
is, and represents the weight of a 1 cm by 1 cm piece of 
cloth. Therefore, lighter fabrics such as silk or rayon will have 
a lower setting than heavier fabrics like wool or corduroy. 
Heavier fabrics will tend to weigh the garment down more 
and will cause more stretching.

Cloth Self-
Friction 

(Default 0.0000)

This setting controls how easily cloth moves over itself. 
For example, wool creates more friction against itself than 
silk, which is very slippery. Increase the setting to create 
more friction.

Static Friction 

(Default 0.5000)

This setting controls how much force it will take to make a 
stationary cloth move against another solid object. Using 
an example, nylon over smooth plastic will have a very low 
amount of Static Friction while denim over wood will 
have a high amount.

Dynamic Friction

(Default 0.1000)

This setting controls the amount of surface friction between 
the cloth and an object when the cloth moves over the 
object. Again using an example, Silk moving over a steel 
surface has low resistance, while cotton moving over skin or 
coarse sandpaper over rough wood has high resistance.

Air Damping 

(Default .0200)

This setting controls how easily the cloth moves through the 
air. Cloth that is woven very tightly has a higher resistance 
than loosely woven cloth. Values that are too excessive can 
cause unpredictable results.

Collision Friction 

(Default Off)

Set Collision Friction to On if you want to calculate 
friction when the cloth collides with other objects.

Continue from the previous task, or open the file named 1.	
ClothRmTask4.pzz which starts where Task 3 left off. This file 
already has the Sequins dynamic group and the constrained 
group.

 The ClothRmTask4.pzz file can be found in the Tutorials/2.	
ClothRoom folder in your Poser installation.

If necessary, select Sequins as the current dynamic group in 3.	
Section 3, as shown in Figure 29.
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Figure 16.29. Select Sequins as the current dynamic group.

If the Group Editor is open, click the square at the upper-right 4.	
corner (see Figure 30) to close it.

Figure 16.30. Close the Group Editor after you finish your selections.

To make the top material a little less stretchy, increase the 5.	

Stretch Resistance setting to 500 as shown in Figure 31. 
Increasing this setting means that the fabric will stretch less 
than the default setting of 50. The maximum setting is 1000.

Figure 16.31. Increase the Stretch Resistance setting to 500.

After you change the Stretch Resistance setting, press the 6.	
Calculate Simulation button to view the results. Notice that 
the top does not stretch as much now. The top of the dress 
does not stretch beyond her waist, and there is also not as 
much stretching beneath the armpits as shown in Figure 32.
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Figure 16.32. The top of the dress now stretches much less.

Task 5: Saving Dynamic Clothing 
to a Library
Because dynamic clothing is different from conforming clothing, you 
cannot save it to the Figures library. The main reason conforming 
clothing is saved in the Figures library is because it contains group 
names that correspond to the figures that the clothing is designed 
to fit.

Dynamic clothing is basically a prop with specialized groups, so you 
save it to the Props library. The procedure to save dynamic clothing 
is as follows:

If you have not completed all of the previous tasks, open the 1.	
file ClothRmTask4.pzz from the Tutorials/ClothRoom folder in 
your Poser installation.

To add the dress to the library, first open the Props library, and 2.	
select or create a new subcategory in which to save the dress. 

Click the dress to select it as the current object, and then press 3.	
the Add to Library button shown in Figure 33. 

Figure 16.33. Click the Add to Library button to save the dress to the Props 

library of your choice.

When the Set Name dialog appears, enter a name for the dress 4.	
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in the New Set Name field, shown in Figure 34.

Figure 16.34. Assign a name in the New Set Name field.

Click the Select Subset button (shown above in Figure 34) 5.	
to open the Hierarchy Selection dialog. Choose dress as the 
object to save as shown in Figure 35. Then click OK to return 
to the Set Name dialog.

Figure 16.35. Choose the dress in the Hierarchy Selection dialog.

Click OK to save the clothing object to the current Props 6.	
library. Poser saves the dress with the groups and settings that 
you created. 

  When you add the dynamic clothing from the library 
to the scene, you must create a new simulation. 



Poser 8
Tutorial Manual 

170

Chapter 16: The Cloth Room

Task 6: Adding Wind to Your 
Project
Poser provides the capability of adding wind forces to your scene 
or animation. Dynamic clothing and dynamic hair react to the wind 
forces, which can simulate gentle or strong gusts as well as strong, 
forceful winds.

The Object > Create Wind Force command adds a wind force 
object to your scene. It resembles a small fan, with the wider end 
containing blades that should point in the direction that the wind 
blows.

Wind force objects have the following key properties in the 
Parameters palette:

Amplitude•	 : Adjust this setting to control the strength of the 
wind force. Low settings create gentle winds, and high settings 
create strong winds.

Spread Angle•	 : Adjust this setting to control the area that 
the wind effects. Small Spread Angles create winds that target 
a specific area, such as when a person blows out a candle. 
Large Spread Angles create winds that affect a wide area, such 
as a storm.

Range•	 : Adjust this setting to control how far the wind can 
affect objects. Small Range settings will only affect close 
objects, whereas larger Range settings affect objects in the 

distance.

Turbulence•	 : Adjust this setting to control the amount of 
irregularity in the wind.

The file ClothRmTask6.pzz, located in the Tutorials/ClothRoom 
folder in your Poser installation, will help to illustrate how wind 
forces work. Rather than demonstrate with clothing, this file 
contains a wall with an opening. Curtains hang from a rod on the 
“inside” of the wall. Figure 36 shows the “inside” view, as seen 
through the Main camera. 

Figure 16.36. Curtains hang over an opening in the wall.

The cloth simulation for this file is already configured for you. Some 
of the important things to note in regards to this simulation are:
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There are a total of 60 frames in the animation.��

The Simulation name is Curtains. The simulation is set to ��
start at Frame 1 and end at Frame 60. Cloth self-collision 
is checked, and there are 10 drape frames.

The Cloth object is named Curtains. The curtains are set ��
to collide against the Wall and the Curtain Rod.

The default dynamic group is the only group used in the ��
curtains.

Choose the Display > Camera View > From Back command, to 1.	
view the items from the back side. Here, you will see a Wind 
Force object that has already been created for you. 

Click the Wind Force object to select it. Open the Parameters 2.	
palette (Window > Parameter Dials) if necessary.

Note that the Wind Force object is not in its default position. 3.	
In order to position the wind force correctly on the other 
side of the window, the yRotate setting was changed to 180 
degrees (to face the wind in the proper direction). The xTran, 
yTran, and zTran settings are set to .447, 4.662, and -5.736 
respectively.

The settings that affect the wind force (or its force field) 4.	
appear in the Other and Dynamics portions of the Parameters 
palette. They are Amplitude, Spread Angle, Range, and 
Turbulence, as shown in Figure 37.

 Figure 16.37. The Amplitude, Spread Angle, Range, and Turbulence settings 

affect the force of the wind.

Now, let’s take a look at one of the settings that is important 5.	
in this project: Range. To adjust the range of the wind force, 
first choose the Left camera (Display > Camera View > Left 
Camera). The range is represented by the length of the two 
“arms” that stick out from the wind force fan. They currently 
end well before the wall, as shown in Figure 38.
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Figure 16.38. The range of the wind force is represented by the length of the two 

“arms” that stick out in front of the fan.

Move the Range slider until the arms extend beyond the 6.	
curtain. The setting should be around .700. 

Now, let’s adjust the Spread Angle, which controls the width 7.	
of the wind force. The default of 45 degrees is too wide, as 
it goes above and below the window and wall. Reduce the 
Spread Angle setting to about 23 degrees. At the same time, 

adjust the yTran setting of the force field to around 4.955 so 
that the wind force is centered better in the window. Looking 
through the Aux camera, here is the result thus far, shown in 
Figure 39.

Figure 16.39. The Range and Spread Angle have been adjusted to fit the window.

For now, leave the Amplitude setting at 1, and the Turbulence 8.	
setting at 0 (their default settings). Press the Calculate 
Simulation button and view the effects. If desired, use the 
Animation > Make Movie command to generate a movie of 
the test so that you can see the effects more easily. 
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Verify that you are in Frame 1, and increase the Amplitude 9.	
setting to 10. Calculate another simulation and you will notice 
that the curtains move more in response to the stronger wind. 
Though the curtains move more, they still move very gracefully 
as if being blown by a gentle wind.

To demonstrate what Turbulence does, again return to Frame 10.	
1. Adjust the Turbulence setting to 1 (full strength), and 
calculate your simulation again. Now, the curtains react to 
“gusts” of wind that are not all at the same strength.

You can also add keyframes beyond the first frame, or use 
the animation graph to vary the forcefield settings throughout 
the animation. 

Now that you know the basics of wind force objects and how they 
affect clothing, you can experiment with dynamic clothing as well 
as dynamic hair. Both react to wind force using the same principals 
that you learned here. 

Adjusting Dynamic Clothing to 
Fit Other Characters
Poser allows you to morph a character so that it has a different 
body type. This is done with magnets, or with morph dials that are 
already built into the character for you.

But dynamic clothing won’t fit a customized character “right out 
of the box”. Fortunately, the Cloth room can fit the clothing for 
you. The approach is different, depending on whether the target 
character is lighter or heavier than the default body shape.

The following examples show how you can use the Cloth room to 
adjust clothing to fit a morphed body. Though this example uses 
DAZ Stephanie Petite, the same principals can be used with other 
models that are morphed to a different body shape.

Fitting a Heavier Body Shape
To begin, load the character that you want to morph from the 
Figures library. Then, add an item of dynamic clothing from the 
Props library. Use the Object > Change Parent command to 
choose the Body of the figure as the parent to the clothing, as 
shown in Figure 40.
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Figure 16.1: The Right Shoulder selected on the figure.

Figure 40. Choose the Body as the parent to the clothing item.

Using the default of 30 frames for your animation, advance to 
Frame 15. This will leave the last 15 frames in the animation for the 
clothing to settle and drape naturally after it resizes. Once you get 
to Frame 15, morph the character into the desired body shape. For 
example, in Figure 41, you see Stephanie Petite with the Pear Figure 
body morph set to 1.

Figure 16.1: The Right Shoulder selected on the figure.

Figure 41. In Frame 15, the Pear Figure body morph is applied to the figure.

Go to the Cloth room, and create a New Simulation, as shown 
in figure 42. Set the simulation to run through all 30 frames of your 
project file, allowing the remaining 15 frames to settle the cloth. 
You don’t need to set the drape frames.
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Figure 16.1: The Right Shoulder selected on the figure.

Figure 42. Create a new simulation for the clothing.

Clothify the clothing as outlined in the previous tasks, and set 
it to collide against the figure as shown in Figure 43. The Start 
Draping from Zero Pose setting can either be checked or 
unchecked.

Figure 16.1: The Right Shoulder selected on the figure.

Figure 43. Set the cloth to collide against the figure.

Press the Calculate Simulation button. As the simulation 
progresses, you should see the character gradually morph through 
the first 15 frames until it reaches the desired shape in Frame 15. 
The dress should also morph accordingly. Then, when calculations 
run through Frames 16 through 30 you should see the dress settle. 
Figure 44 shows the result.
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Figure 16.1: The Right Shoulder selected on the figure.

Figure 44. The final fit on the Pear Figure Stephanie is much better!

Fitting a Lighter Body Shape
The process to fit a lighter body shape is slightly different than the 
previous example. Basically, if you use the previous steps to apply 
the dress to a lighter figure, the dress will appear too large.

The way around this is to scale the body smaller in the first frame, 
and let it “grow” into the dress on Frame 15. In this example, we 
start Stephanie Petite at her default body size in Frame 1. In Frame 

15, she is set to “Emaciated” (to show an extreme), as shown in 
Figure 45.

Figure 16.1: The Right Shoulder selected on the figureFigure 45. Stephanie 

Petite, set to “Emaciated” in Frame 15.

Just to illustrate what we are trying to avoid, here is what the 
dress looks like if you use the same procedure as that used with 
a heavy figure. Notice in Figure 46 how Stephanie is swimming in 
that dress! Not only is it dragging on the floor (not shown), but it’s 
hanging off her, most noticeably in the back.
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Figure 16.1: The Right Shoulder selected on the figureFigure 46. Emaciated 

Stephanie Petite is swimming in the dress.

To prevent this from happening, follow the same steps as outlined 
for the heavy figures. But, before you calculate the simulation, 
return to Frame 1. Select the Body of Figure 1 (your character), 
and adjust the xScale and the zScale to 90% (This figure may vary, 
depending on how skinny the figure is. This is an extreme example). 
Leave the yScale setting as is, otherwise you will affect the length 
of the dress in the simulation. Figure 47 shows the location of these 
settings.

Figure 16.1: The Right Shoulder selected on the figureFigure 47. Set the BODY 

xScale and zScale to 90%.

Next, go to Frame 15, or the same frame that has the body morph 
set to 1. Set the xScale and zScale for the body back to 1, as shown 
in Figure 48.
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Figure 16.1: The Right Shoulder selected on the figureFigure 48. At Frame 15, 

set the BODY xScale and zScale back to 100%.

Once you finish this additional step, you can calculate the 
simulation. The clothing will probably fit better this time around!

  If you are scaling multiple pieces of clothing to fit the 
same body shape, you will need multiple simulations. For 
example, let’s say you want to fit a shirt, pants, shoes, and a 
jacket. The shirt tucks into the pants, the pants drape over the 
shoes, and the jacket goes over the shirt and pants.

Given that scenario, you probably won’t “clothify” the shoes, 
as leather is not very flexible. However, you do want the pants 
to drape over the shoes appropriately, so make sure your figure 

is wearing the shoes.

First create a cloth simulation for the shirt, and set it to collide 
against the figure. Calculate its simulation.

Next, create a cloth simulation for the pants, and set it to 
collide against the figure, the shirt, and the shoes. Calculate 
its simulation.
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Chapter 17: The Hair Room

	
by Denise Tyler
You have no doubt seen furry creatures in animated movies such 
as Shrek or Monsters, Inc., and observed their hair blowing in the 
wind, or reacting to gravity or other movement when the characters 
change position. The hair on those characters uses a technique that 
is similar to what you find in Poser’s Hair room.

To begin, notice that Poser uses three different types of hair, each 
of which have strengths and weaknesses. The first type of hair uses 
an HR2 or HRZ extension. This type of hair uses a geometry file, a 
texture map, and a transparency map, and can look quite realistic. 
HR2 files are usually configured as a smart prop that automatically 
attaches itself to a figure’s head. You can also attach them yourself 
with the Figure > Set Figure Parent or Object > Change 
Parent commands. 

Though HR2 hair does move along with the character as far as 
positioning goes, it requires morphs to make it pose correctly when 
the head bends in any direction. For example, if you add long hair 
to a character and then bend her head forward, the bottom of the 
hair sticks out. In many cases, morphs are added to make the hair 
bend appropriately, as shown in Figure 1.

Figure 17.Hair from the Hair library attaches to the figure’s head. It requires 

morphs to bend and style it.

The second hair type uses a CR2 or CRZ extension. This type of 
hair works the same way as conforming clothing. You attach it to 
the figure using the Figure > Conform To command, and then 
it automatically bends to follow the pose of the character. For 
example, if you put a long hair object on a figure and then bent her 
head forward, the parts on the head and neck bend accordingly, 
as shown in Figure 2. Conforming hair also utilizes morphs to style 
and animate the hair.
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Figure 17.2. Conforming hair, found in the Figures library, moves with the 

character like conforming clothing does.

While prop hair and conforming hair can look quite realistic in 
still images, they are difficult to use in animation. You need many 
keyframes and extensive morphing to make them move realistically. 
Strand-based hair, found in Poser’s Hair room, is the ideal solution 
for realistic hair animation. Strand-based hair looks more lifelike, 
and reacts to movement and wind forces in much the same way as 
dynamic clothing. 

There are four basic steps to creating dynamic hair:

Create a skull cap and divide it into hair growth groups.1.	

Define the length and amount of pull in the hair.2.	

Configure the density and amount of curl in the hair, and style 3.	
it.

If using the hair in an animation, specify how the hair reacts to 4.	
gravity, air, bending, and change of position, and calculate the 
dynamic properties.

  Dynamic hair contains many faces. As a result it needs 
a lot of computing power during dynamic calculations and can 
affect the performance of your system. 

A good way to approach hair is to first add all of the hair groups to 
the skullcap, using the Group Editor. Then, start with the bottom-
most layer, growing and styling the hair on it. As you work your way 
up to the crown, you continue to add  hair.

Task 1: Quick Start to Creating 
and Styling Hair
Let’s take the basic steps of hair creation one step farther. In this 
quick start tutorial, you’ll create hair from a skull cap that only has 
one group. You’ll create a nice, soft hairstyle with a little bit of curl 
and styling. 
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  Though you can add hair directly to a character’s head, 
you won’t be able to distribute it without the character, or use 
the hair with other characters. The only way you can save a 
character, with hair, is to save the entire project. This makes it 
difficult to use the same hairstyle on any character.

Adding Groups
To style your first hair style, follow these steps:

Open the project named JessiHairRoom01.pzz from the 1.	
Tutorials/HairRoom folder in your Poser installation. This file 
has Jessi in the default pose, wearing a red and black cocktail 
dress. She is also wearing a skull cap that has no hair groups 
defined. The skull cap appears as a transparent object on the 
head.

Enter the 2.	 Hair room. If necessary, choose the Face Camera 
so that you can see Jessi as shown in Figure 3.

Figure 17.3. Jessi appears in the Hair room wearing a skull cap.

Click the skull cap on Jessi’s head to make it the current 3.	
object.

Find the 4.	 Hair Growth Groups section of the Hair room 
(section 1, in the upper-left section), and click the New 
Growth Group button shown in Figure 4. 
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Figure 17.4. The New Growth Group button creates a new hair group.

Name the new growth group All, as shown in Figure 5, and 5.	
click OK to continue. The other buttons in Section 1 of the Hair 
room should now be available for use.

Figure 17.5. Name the new growth group All.

To define which faces belong in the new growth group, click 6.	
the Edit Growth Group button shown in Figure 6.

Figure 17.6. Click the Edit Growth Group button to select faces for the new hair 

group.

The 7.	 Group Editor opens in the Hair room. To add all of the 
faces to the All hair group, click the Add All button, shown in 
Figure 7. All of the faces in the skull cap should turn red.
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Figure 17.7. Click the Add All button to add all faces to the current growth 

group.

Click the square in the upper-right corner of the 8.	 Group 

Editor palette to close it and return to the Hair room. You 
have just completed your first hair growth group … the only 
one necessary for this tutorial.

Growing the Hair
You should now notice that the Growth Controls in section 2 
are enabled. These controls are shown in Figure 8, and provide the 
following functions:

Figure 17.8. The Growth Controls define the length and natural behavior of the 

hair. 

Grow Guide Hairs�� : Press this button to grow some 
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guide hairs on the current hair growth group. Guide hairs 
are representative strands that allow you to style the hair 
without having to view all of the hairs on the head. You 
can view all hairs when you render, or if you check the 
“Show Populated” option in Section 3 of the Hair room.

Hair Length�� : The Hair Length dial controls the length 
of the guide hairs, and the populated hairs, in the current 
hair growth group. The default value is .3440, which 
creates hairs that are about equal length to Judy’s neck. 
A value of 0 produces a good representation of 5 o’clock 
shadow stubble. A value of about 2.5 to 3.0 creates hair 
that reaches out at about arm’s length.

Length Variance�� : The Length Variance creates hair 
that is uneven in length, creating a more natural look. A 
value of 0 creates no variation in length, making all hairs 
in the current group even (like a blunt cut). A value of 
one creates unevenness that is about equal to the length 
of the neck. A value of .1 produces fairly natural results, 
somewhat like a feathered cut.

Pull Back�� : Not to be confused with pulling back from 
styling, the Pull Back setting controls how the hair in the 
hair group is naturally pulled back. For example, men’s 
short hair pulls back naturally from the hair line. A value 
of 0 does not pull hair back at all. Increase values above 
0 to pull hair backward, and decrease values below 0 to 
push hair forward.

Pull Down�� : The Pull Down setting controls how much 
the hair naturally pulls down because of gravity or length. 
Long hair weighs more than short hair, so its natural 
tendency to pull downward is greater. Increase the setting 
to pull the hair downward, and decrease the setting 
below 0 to create hair that sticks up. A value of .005 
creates a nice natural bend for medium to long hair.

Pull Side�� : The Pull Side setting controls how much 
the hair naturally pulls to the right or left, such as when 
the hair is parted. Numbers above 0 pull the hair toward 
the character’s right, while numbers below 0 pull the hair 
toward the character’s left side.

Click the Grow Guide Hairs button. Initially you’ll see the 1.	
wild style shown in Figure 9. There are two things to point 
out here: first, the hair that you see in the render will not be 
as thin as what you see in the window here. These are only 
representative guide hairs that help you style the hair without 
having to wade through thousands of hairs at once. Secondly, 
all of the hairs you see on the head are roughly the same 
length all across the head. For this style it’s okay, but later 
you’ll learn how you can control hair lengths a little better.
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Figure 17.9. After you click the Grow Guide Hairs button, you see a wild hair 

style. 

We’ll adjust a couple of the controls to tame that hair a little 2.	
bit. Set the following growth controls in Section 2 to the 
values shown below. Your hair should look as shown in Figure 
10.

Hair Length: �� 0.3440 (default)

Length Variance: �� 0.0000 (default)

Pull Back:��  -0.00011

Pull Down: �� 0.00043

Pull Side: �� 0.00000 (default)

Figure 17.10. After some adjustments in the Growth Controls section, the hair is 

a little tamer.

Adding or Removing Curliness
Take a look next at the Styling Controls in section 3. These 
controls define how thin/thick or how naturally straight or curly the 
hair is. They serve the following purposes:

Style Hairs•	 : Click this button to open the Hair Style Tool 
(described later in this task).
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Show Populated•	 : Check this option to see the density 
of the hair as it will be rendered. Unless you have a good 
amount of computer resources, it is best to leave this option 
unchecked. A good time to use it, however, is when you set the 
Hair Density setting described next. 

Hair Density•	 : For best results, adjust this setting with the 
Show Populated option checked until you cover the head 
sufficiently. Too high a setting affects system performance.

  Hair tends to look better when it isn’t quite as dense. 
However, in Poser 5, the only way to prevent the scalp from 
showing through was to increase the Hair Density setting. This 
put a huge strain on system resources.

To help remedy this issue, Poser offers the Opaque in 
Shadow option found in the Hair Material nodes. This option 
is explained more fully later in this tutorial section.

When the Opaque in Shadow option is checked on the 
current hair material (as it is in the current project file), you do 
not have to make the hair real dense to hide the scalp. Instead, 
the hair gets more opaque as it recedes into the shadows, and 
gives the impression that the hair is fuller. This saves valuable 
resources and allows you to create hair that renders much 
faster.

Tip Width•	 : This setting controls the thickness of the hair at 
the end of the hair, and should be lower than the root width, 
which follows.

Root Width•	 : This setting controls the thickness of the hair 
at the base of the head, and should be higher than the tip 
width, above.

Clumpiness•	 : Increase this setting for hair that clumps 
together, such as in dreadlocks or heavy curls. Decrease for 
fine, thin hair.

Kink Strength•	 : Increase this setting for curlier hair; 
decrease for straight hair.

Kink Scale•	 : Increase this setting for tighter curls, and 
decrease it for looser curls. This setting is also affected by the 
Verts per Hair setting below.

Kink Delay•	 : Controls the distance between the root of the 
hair and the point at which it begins to curl. Higher numbers 
cause the curls to start farther away from the head.

Verts Per Hair•	 : Controls the number of vertices that are 
in each hair strand. Higher values create smoother hair but 
increase system resources. Lower numbers are easier on your 
resources but it is better to use them in straight styles.

Starting from the top setting, we are going to make the hair a little 
more dense than the default setting. . We’ll also make the hair 
less clumpy, because it is straight and fine. To create hair that is 
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straighter, we will decrease the Kink Strength, Kink Scale, and Verts 
per hair settings, and increase the Kink Delay. Try these settings to 
get the results shown in Figure 11:

Hair Density: •	 2500. With the Opaque in Shadow option set 
in the hair material node, this setting strikes a perfect balance 
between fullness and system resources.

Tip Width: •	 4 (default)

Root Width: •	 1 (default)

Clumpiness: •	 0.100

Kink Strength: •	 2 (Straightens the hair a little bit)

Kink Scale: •	 50 (Makes hair less kinky)

Kink Delay: •	 1.00 (Straightens hair further)

Verts Per Hair: •	 10 (Reduces system resources for straighter 
hair)

Figure 17.11. After some styling control adjustments, the hair is a little straighter.

Styling the Hair
Now for the fun part. Click the Style Hairs button in section 3 1.	
to open the Hair Style Tool shown in Figure 12. 
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Figure 17.12. Click the Style Hairs button to open the Hair Style Tool.

Select Hairs�� : Use this tool to select the guide hairs that 
you want to style.

Translate Hairs�� : Drag the mouse left or right to move 
hairs.

Curl Hairs�� : Curls hair upward in a flip style of under 
toward the head.

Scale Hairs�� : Moves vertices farther away or closer to 
each other along the horizontal axis.

Deselect Hairs�� : Deselects the currently selected 
vertices. You can also Command-Click (Mac) or Ctrl-click 

(Windows) with the Select Hair tools to achieve the same 
thing.

Translate Hairs In-Out�� : Moves the selected vertices 
toward you or away from you.

Twist Hairs�� : Twists the hairs, somewhat like the shape 
of a tornado.

Click the 2.	 Select tool, and select the vertices along the bottom 
of the hair. Be sure to rotate the camera and select them all 
the way around the head if necessary. Figure 13 shows the 
bottom four rows selected.

Figure 17.13. The bottom four rows of vertices are selected.
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  The Select Tool adds vertices to the current selection. 
To remove vertices from the selection, press the Command 
(Mac)/Ctrl (Windows) key while drawing a selection box 
around the vertices you want to remove. To remove all vertices 
from the selection, click the Clear Selection button in the Hair 
Style Tool.

Now that a selection is made, the remaining tools should be 3.	
enabled. Select the Scale tool (last tool on the top row) and 
bring the vertices in closer to the neck. The direction of scale 
depends on which way the camera is facing. View the model 
from the front. Place the cursor in the center of the selection, 
and drag the mouse toward the left to bring the selection in 
toward the neck, as shown in Figure 14. Figure 17.14. Scale the lower hairs in toward the neck.

Rotate the camera so that you are looking at the character 4.	
from the side. Select the Move tool (second tool on the top 
row) and bring the selection in closer to the neck, as shown 
in Figure 15.
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Figure 17.15. Move the vertices closer to the neck.

Click the 5.	 Clear Selection button in the Hair Style Tool. The 
yellow vertices should become deselected.

Now, select the group of vertices above those you just worked 6.	
on, as shown in Figure 16. If necessary, use the Deselect tool 
or press Command (Mac)/Ctrl (Windows) while you use the 
Select tool to remove the previous vertices from the selection.

Figure 17.16. Select another set of vertices above the previous selection.

Adjust the 7.	 Lengthen slider in the Hair Style Tool until your 
guide hairs are approximately the same length as the previous 
layer, as shown in Figure 17. 
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Figure 17.17. Use the Lengthen slider to increase the length of the selected 

strands.

  After you grow and style guide hairs, it is better to use 
the Lengthen slider in the Hair Style Tool to make hair longer 
or shorter. If you use the Hair Length setting in the Guide 
Hairs section it will reset all in the growth group (in this case, 
all hairs) to their pre-styled state..

Again, use the 8.	 Scale tool and the Move tool until you see 
results that are similar to those shown in Figure 18. You can 
also adjust the Falloff slider more toward the root to move 
the affected region more toward the base of the head rather 
than toward the tip of the hair strands.

Figure 17.18. Scale and move the strands closer to the head.

Use the 9.	 Select tool to draw a selection around both sets 
of bottom vertices. Then, uncheck the Constrain Length 
checkbox in the Hair Style Tool. Use the Move and Scale 
tools to adjust the length up or down until you get a length 
that you like. An example is shown in Figure 19. 
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Figure 17.19. Adjust the length of all strands you have worked on thus far.

Finally, clear the current selection, and select the top portion of 10.	
the head. Use the Scale and Move tools to bring the hair in 
closer to the head, keeping the bangs at a proper length. The 
results should look similar to that shown in Figure 20.

Figure 17.20. Scale and move the top layer of vertices to finish the style.

Render your style to see how it looks, and if it needs any other 11.	
adjustments. If the hair looks too thin, go to the material room 
and check the material settings for the hair. If necessary, check 
the Opaque In Shadow option in the hair node. You can 
also increase hair density settings, but try not to increase it 
too much.

  The two settings that affect your resources the most are 
the Hair Density setting and the Verts Per Hair setting. Keeping 
them both as low as possible will create hair that renders much 
faster. 
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Figure 17.21. Render the hair and make any adjustments you feel are necessary.

Creating Multi-Grouped Hair
Though the hair in the previous example is a good start, you get 
more control over styling if you use a skull cap that has more than 
one hair group. As a case in point, you’ll have more control over 
the top of the head if you create hair groups that focus on the 
crown, or on right and left sections so that you can create hair with 
a center part.

If you have ever worn or seen a real wig, you may have noticed 

that the hairs are sewn on a cap made of netting. This is known as 
a skull cap. Poser’s skull caps serve the same purpose: you attach 
the hair to a base part called a skull cap. Poser comes with some 
skull caps for you to start with, but in order to share with other 
users you should make your own to avoid copyright issues. You can 
also create your own in a modeling program such as LightWave, as 
shown below.

Though skull caps can be rescaled to fit a figure, you’ll no doubt 
obtain the best results if the skull cap is designed specifically for 
the character. For example, the position and shape of Judy’s head 
(the Poser 5 female) is different than Jessi’s (the Poser 6 female), 
and DAZ 3D’s Victoria also has a head that is different from Jessi’s 
or Judy’s. 

You can actually create a skull cap very easily in Poser’s Pose room. 
Click the figure’s head to make it the current selection. Then select 
the Grouping tool from the Editing tools shown in Figure 22.
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Figure 17.22. Select the character’s head, then open the Group tool.

With the head selected, create a new group named Skullcap. 
Use the tools in the Group Editor to select the polygons that 
you want to include in the skull cap. It helps to view the head in 
Wireframe mode while you do this (Display > Document Style > 
Wireframe). It also helps to view the head with the Left or Right 
Camera while you select the faces, as shown in Figure 23. This 
helps you get a symmetrical selection.

Figure 17.23. Create a Skullcap group and select faces to include in the new 

group.

After you have the faces selected, click the Create Prop button 
in the bottom section of the Group Editor. Poser prompts you 
to name the prop (Skullcap). It leaves the original head intact, but 
creates a skull cap that uses the same texture that was assigned to 
the faces you originally selected. You can then use this skullcap to 
create your hair.

On the other hand, if you intend to share your hairstyle with 
others, you cannot distribute any of the geometry from your Poser 
character. In the case of distributing or selling hair, you will need to 
create your own skull cap in a 3D modeling program. For example, 
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Figure 24 shows a skull cap in progress for Will (the Poser 5 boy). 

Figure 17.24. A skull cap designed in LightWave.

As you learned in the previous example, hair is initially all the same 
length when you create it. In reality, when you look at your own 
hair, this is typically not the case. For example, think of a girl with 
long, shoulder-length hair that appears to be all one length, bangs 
and all. In reality, the hair at the base of the neck is much shorter 
than the hair at the crown of her head.

The easiest way to simulate this in the Hair room is to create 
more than one hair group in the skull cap. When it comes time to 
“grow” the hair, you can create shorter hairs on the lower layers, 

and longer hairs on the upper layers, giving everything a smooth, 
uniform look. In addition, if you want the hair to part in the middle, 
or even to the right or left, you can anticipate this with the hair 
groups.

You can assign hair groups in a modeling program, a UV mapping 
program, or in Poser’s Group Editor. The following sections 
explain how.

Using a Modeling or UV Mapping 
Program
One way to approach hair groups using a modeling or UV mapping 
program is to assign different material zones to the skull cap. 
Figure 25 shows several different material zones, colored for clarity, 
that are created in a skull cap.

The groups shown in the following figure allow you to create a 
wide variety of hair styles. Three layers in the back can each be 
different lengths. The lower layers can be closer to the head, while 
the upper layers can be farther away. Three crown layers (Crown, 
Top Right, and Top Left) allow you to gain more control over the 
hairs at the top of the head, allowing you to pull part of it toward 
the back, and part the upper part in the middle or on one side 
or the other. The two side zones, top and bottom, give you more 
control over longer hair that might fall in front of the shoulder.
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Figure 17.25. Divide the skull cap into several material zones using a modeling 

or UV mapping software.

After you assign the material zones and save the object as a 
Wavefront OBJ file, import the OBJ file into Poser and position it 
properly over the character’s head. You can use the material zones 
to create the hair growth groups by using the following procedure:

Choose File > Import > WaveFront OBJ. Select the skull cap 1.	
with materials assigned, and click Open.

The 2.	 Prop Import Options dialog appears. As long as the OBJ 
file is the correct size and in the correct position, you don’t 
need to check any options. Leave them all unchecked and 
press OK to continue. 

With the object imported, click the 3.	 Hair tab to enter the Hair 
room.

Click the 4.	 New Growth Group button in section 1 of the 
Hair room, shown in Figure 26.

Figure 17.26. Click the New Growth Group button to create a hair group.

A dialog prompts you to enter a group name. Enter a name 5.	
that is representative of the section you want to grow. In this 
example, I enter TopLeft and click OK.

Click the 6.	 Edit Growth Group button. The Hair room Group 
Editor shown in Figure 27 appears.
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Figure 17.27. The Hair room Group Editor allows you to select faces for your 

new group.

Because the OBJ was divided into separate material zones, 7.	
you can use the Add Material button to choose which 
material to add to the TopLeft group. To begin, click the Add 
Material button, shown in Figure 28. The Add Material 
dialog appears.

Figure 17.28. You can add all faces assigned to one or more materials to the 

current group.

Click the arrow to reveal the materials contained in the skull 8.	
cap. Choose TopLeft, as shown in Figure 29. The TopLeft faces 
turn red.
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Figure 17.29. Choose the TopLeft material for the TopLeft hair group.

Proceed through the remaining material zones in the skull cap 9.	
to add all the other groups. To add the next group, click the 
New Group button at the top of the Group Editor. A dialog 
prompts you to enter a new name. The Group Names in the 
table below are added one by one. The Add Material process 
adds the appropriately named material zone to the selected 
faces. Continue in this manner until all of the following groups 
are assigned.

GROUP NAME MATERIAL NAME

BackMiddle BackMiddle

BackTop BackTop

Crown Crown

SidesTop SidesTop

SidesBottom SidesBottom

BackBottom BackBottom

TopRight TopRight

Before you close the 10.	 Group Editor, check the Show 
Non-Grouped Faces option to see if any faces show up 
highlighted in red. If there are any, you forgot to create and 
assign some material faces. You should see everything in black, 
as shown in Figure 30.

Figure 17.30. The Show Non-Grouped Faces option highlights unassigned faces 

in red. If all faces are assigned you should see all black.

Sometimes, an object is imported with a default group that 11.	
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is generated in your modeling or UV mapping software. In 
that case, move through the list of groups in the Group List 
to determine if any exist. In the case of the example shown 
in Figure 31, a group named Object__0 is found. Press the 
Delete Group button to delete the group. If there are other 
unwanted groups, delete them as well. Then close the Group 
Editor.

Figure 17.31. Delete any groups that you did not create yourself.

Using Poser’s Group Editor
As you saw in the previous lesson, it is very easy to add hair groups 
if material zones are defined for you ahead of time. If the object 
does not have material zones defined already, you can use the 
Group Editorin the Hair room to define each Hair Group and the 
faces that are included in it. This approach takes a bit more time 
and care, but it still achieves the same results.

The basic steps start similar to the previous method, but you’ll use 
the selection tools in the Group Editor to select the faces. You 
may also find it easier to see the boundaries of each face if you 
change the Poser display mode.

Choose File > Import > WaveFront OBJ. Select the skullcap 1.	
OBJ file and click Open. 

The 2.	 Prop Import Options dialog appears. Leave all options 
unchecked and press OK to continue.

It will be much easier to view the skull cap in a manner that 3.	
shows you where the faces are when you enter the Group 
Editor. For this reason, choose Display > Document Style 
> Wireframe. The skull cap should now look as shown in 
Figure 32. 
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Figure 17.32. The skull cap is shown in Flat Shaded Lined mode. This helps you 

select faces more easily.

In the 4.	 Hair room, click the New Growth Group button in 
section 1.

A dialog prompts you to enter a group name. Enter 5.	 TopLeft 
and click OK. This section will create a part in the middle of 
the crown.

The 6.	 Edit Growth Group button should now be enabled. 
Click it to open the Group Editor.

Choose the 7.	 Top Camera (Display > Camera View > From 
Top) and adjust the view so that you can see the skull cap 
more closely. Select four rows of polygons from the center of 

the skull cap to the left side of the skull cap (which is on your 
right facing you). Figure 33 shows an example of the selected 
faces highlighted in red.

Figure 17.33. Click the New Growth Group button to create a hair group.

  If you select too many faces, or accidentally include 
faces that do not belong in the group, press the Command 
(Mac)/Ctrl (Windows) key while you click a single face or use 
the selection tool to select multiple faces to remove.

Now we’ll create the other side of the part. Click the 8.	 New 
Growth Group button again, and create a new growth group 
named TopRight. Confirm that it is the current group selected 



Poser 8
Tutorial Manual

201

Chapter 17: The Hair Room

in the Group Editor, then select the faces shown in Figure 
34.

Figure 17.34. Click the New Growth Group button to create a hair group.

Choose the 9.	 Right Camera (Display > Camera View > 
From Right) and move the skull cap closer to your view. 
Settings to get the view shown in Figure 35 were Dolly Y 
53.658, DollyX 1.258, and Scale 11%.

Figure 17.35. Use the Right Camera to look at the side of the skull cap.

Click the 10.	 New Growth Group button to create a new 
growth group named FrontTop, and add the faces shown in 
Figure 36 to the selection. Because you are viewing the model 
in wireframe view, the faces on the opposite side will also be 
selected for you. 
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Figure 17.36. In Wireframe view, both sides of the model’s faces are selected at 

the same time.

Continue as above, creating the remaining groups and 11.	
selecting appropriate faces. Figure 37 shows the remaining 
group names along with the selections that went along with 
them.

Figure 17.37. Create the remaining hair groups and assign faces to them.

After you assign all polygons to your hair groups, you might 12.	
want to double-check a couple of things. First, check the 
Show Multigrouped Faces option to see if you have 
accidentally assigned faces to more than one group. If so, they 
appear in red as shown in Figure 38.
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Figure 17.38. Faces that are assigned to more than one group appear in red.

The reason all faces are shown in red is because modeling 13.	
programs and UV mapping programs sometimes assign all 
faces to a group during export. In the case of the example in 
Figure 39, there is a group named Cap. After you uncheck the 
Show Multigrouped Faces option, use the arrows beneath 
the group name list to advance to the Cap group, and delete it 
with the Delete Group button.

Figure 17.39. Delete the Cap group from the list.

In a similar manner, check the 14.	 Show Non-grouped Faces 
option. Any faces that have not yet been assigned to a group 
will appear in red. Uncheck the option, and select the group 
that should contain some or all of the missing faces, and add 
them to the group.

As Figure 40 shows, you can sometimes accidentally have 15.	
faces in a group that you don’t want. Here, we see faces from 
the side of the head included in the TopLeft group. Simply 
press the Command (Mac)/Ctrl (Windows) key while you select 
the faces to remove them.
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Figure 17.40. Remove stray faces by pressing the Command (Mac)/Ctrl 

(Windows) key while you select the faces to remove.

  If some faces accidentally get assigned to more than 
one group, determine which groups share the common faces. 
Then, select the group that you want to keep the faces in. 
Click the Remove Group button to choose the group that 
incorrectly shares the faces.

  This task shows the basic steps to assign faces with 
the Group Editor. For more information about the Group 
Editor, refer to the Poser Reference Manual, The Group Editor 

on page 486.

Task 2: Growing and Styling 
Multi-Grouped Hair
When you divide a skull cap into different hair groups, it gives you 
greater control over the way hair falls over the skull cap. Though 
you have more hair groups to work with, the process is very similar 
to the method used in Task 1. 

There is one main difference when using multiple hair groups. 
Think about how a hairdresser cuts women’s hair in the salon. If a 
customer has long hair, the hairdresser piles all of the hair on the 
top of the head, except for a section at the bottom. The bottom hair 
is trimmed and styled, and then the hairdresser pulls another layer 
down to style over the hair that has already been cut.

You will find it easiest to approach your Hair room style in the 
same manner. You’ll find it easier to grow and style the bottom hair 
group first. Then, choose the next highest hair group, and grow and 
style it.

In the following tutorial, you’ll step through the process very 
quickly, using the skills you learned in the previous hair tutorial. 
For the sake of brevity, this tutorial will not incorporate the Hair 
Style Tool.

Open the file JessiHairRoom02.pzz from the Tutorials/1.	
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HairRoom folder in your Poser installation. This project contains 
Jessi with the same skull cap used in the previous exercise, 
except that it has been divided into the following hair growth 
groups:

Crown��

TopLeft��

TopRight��

Sides��

UpperBack��

MiddleBack��

LowerBack��
Enter the 2.	 Hair room and select the skull cap. Use the Current 
Group list to select the LowerBack growth group, as shown 
in Figure 41.

Figure 17.41. Select the LowerBack layer first.

In the 3.	 Growth Controls section, set the values as shown 
below, and click the Grow Guide Hairs button. Where 
settings differ from the default, the reason for the change is 
noted in the following. 

Hair Length: �� 0.6000 (makes hair longer)

Length Variance: �� 0.0000

Pull Back: �� 0.00015

Pull Down: �� 0.00200 (weighs hair down more)

Pull Side:��  0.0000
In the Styling Controls section, set values as follows:4.	

Hair Density: �� 2500.00 (Increases the number of hairs 
for each guide hair). This setting can be much less if you 



Poser 8
Tutorial Manual 

206

Chapter 17: The Hair Room

check the Opaque in Shadow option on the hair material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.200

Kink Strength: �� 20.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but greatly 
increases resources. This is a very brave setting for 
dynamic hair. If it bogs your system down, cut this setting 
back until you get a balance between softness and 
resources. Always use the lowest possible setting for this 
parameter that still looks good. This setting, together 
with the Hair Density setting, is the most “expensive” 
when it comes to system resources.)

If desired, render the first layer. Your results should look similar 5.	
to Figure 42.

Figure 17.42. After rendering, the bottom layer of hair.

Figure 

Next, select the MiddleBack layer, and in a similar manner, 6.	
grow the hair and set controls as follows:

GROWTH CONTROLS (Section 2)

Hair Length: �� 0.7000 (makes hair longer)

Length Variance: �� 0.0000

Pull Back: �� 0.00015

Pull Down: �� 0.00200 (weighs hair down more)
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Pull Side: �� 0.0000

STYLING CONTROLS (Section 3)

Hair Density: �� 2500.00 (Increases the number of hairs 
for each guide hair). This setting can be much less if 
you check the Opaque in Shadow option on the hair 
material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.200

Kink Strength: �� 20.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but increases 
resources)

Click the 7.	 Style Hairs button and select the vertices in the 
MiddleBack layer. Use the Scale tool to bring the vertices 
closer to the head, as shown in Figure 43. Click the Clear 
Selection button in the Hair Style Tool when you are 
finished.

Figure 17.43. Scale the MiddleBack layer closer to the head.

Close the 8.	 Hair Style Tool, and select the UpperBack layer 
as the current group. Grow the hair and set the controls as 
follows:

GROWTH CONTROLS (Section 2)

Hair Length:��  0.6000 (makes hair shorter than the 
previous layer)

Length Variance: �� 0.0000

Pull Back: �� 0.00015

Pull Down: �� 0.00300 (weighs hair down more)

Pull Side: �� 0.0000
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STYLING CONTROLS (Section 3)

Hair Density: �� 2500.00 (Increases the number of hairs 
for each guide hair). This setting can be much less if 
you check the Opaque in Shadow option on the hair 
material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.200

Kink Strength: �� 20.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but increases 
resources)

Now select the Sides section. This section of hair affects the 9.	
hair that is above and in front of the ears. We’re going to pull 
this layer toward the back a little. To do so, use the following 
settings after you grow the hair. Figure 44 shows the progress 
after you complete this step.

GROWTH CONTROLS (Section 2)

Hair Length: �� 0.6000 (makes hair shorter than the 
previous layer)

Length Variance: �� 0.0000

Pull Back: �� 0.00600 (pulls the hair toward the back of 

the head)

Pull Down: �� 0.00250 (weighs hair down more)

Pull Side: �� 0.0000

STYLING CONTROLS (Section 3)

Hair Density: �� 2500.00 (Increases the number of hairs 
for each guide hair). This setting can be much less if 
you check the Opaque in Shadow option on the hair 
material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.200

Kink Strength: �� 20.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but increases 
resources)
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Figure 17.44. The sides are added to the figure.

Choose the Crown section and grow hair with the following 10.	
settings, so that the crown blends in well with the existing 
hair:

GROWTH CONTROLS (Section 2)

Hair Length: �� 0.7000 (makes hair shorter than the 
previous layer)

Length Variance: �� 0.0000

Pull Back: �� 0.00015

Pull Down: �� 0.00100

Pull Side:��  0.0000

STYLING CONTROLS (Section 3)

Hair Density: �� 2500.00 (Increases the number of hairs 
for each guide hair). This setting can be much less if 
you check the Opaque in Shadow option on the hair 
material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.200

Kink Strength: �� 20.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but increases 
resources)

Now for the top sections. You’ll use the 11.	 Pull Side control 
in section 2 to pull each top section to the appropriate side, 
keeping the bangs off the forehead. For the TopLeft section, 
use the following settings:

GROWTH CONTROLS (Section 2)

Hair Length: �� 0.2500 (the bangs are shorter than the rest 
of the hair)

Length Variance: �� 0.0000

Pull Back: �� 0.00050 (pulls the hair back away from the 
forehead)
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Pull Down: �� 0.00005 (Because the hair is shorter, it 
doesn’t weigh the strands down as much)

Pull Side: �� -0.00050 (negative numbers pull toward the 
character’s left side)

STYLING CONTROLS (Section 3)

Hair Density: �� 4000.00. This setting can be much less if 
you check the Opaque in Shadow option on the hair 
material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.000 (Hair does not stick together in the 
front)

Kink Strength: �� 10.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but increases 
resources)

For the TopRight, the settings are almost the same as the 12.	
TopLeft. The only difference is the PullSide setting, which is 
now a positive number:

GROWTH CONTROLS (Section 2)

Hair Length: �� 0.2500 (the bangs are shorter than the rest 
of the hair)

Length Variance: �� 0.0000

Pull Back: �� 0.00050 (pulls the hair back away from the 
forehead)

Pull Down: �� 0.00005 (Because the hair is shorter, it 
doesn’t weigh the strands down as much)

Pull Side: �� 0.00050 (positive numbers pull toward the 
character’s right side)

STYLING CONTROLS (Section 3)

Hair Density: �� 4000.00. This setting can be much less if 
you check the “Opaque in Shadow” option on the hair 
material.

Tip Width: �� 0.40000

Root Width: �� 1.00000

Clumpiness: �� 0.000 (Hair does not stick together in the 
front)

Kink Strength: �� 10.00 (Makes hair curlier)

Kink Scale: �� 100.00

Kink Delay: �� 0.30

Verts Per Hair: �� 30 (Makes curls softer, but increases 
resources)

Render the hair to see your result. It should look similar to the 13.	
hair style shown in Figure 45.
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Figure 17.45. After all layers are grown, the hair could use a little styling with 

the style tools.

I’ve omitted using the 14.	 Hair Style Tool in this tutorial, in favor 
of showing you how to add hair to each layer. If desired, you 
can revisit each hair group in the order you created them, and 
use the Hair Style Tool to twist, curl, or scale hairs into place 
as desired. For example, you can move the bangs from the 
TopLeft and TopRight sections inward a little more, or scale 
and move the sides of the Crown section in closer to the face. 
Figure 46 shows what the hair looks like after each of these 
changes are made. Now that you know the basics of hair 
styling you can experiment further to get different results.

Figure 17.46. After the Styling tools are used on the TopRight, TopLeft, and 

Crown sections, the hair looks much better!

Saving Your Hair to the Library
When you save dynamic hair to the Library, you must also tell 
Poser to save the hair strands along with it. This process is very easy 
to accomplish, but it takes a few extra steps than it does to save 
other items to the Library. The procedure is as follows:

Click the skull cap, or choose it from the selection menu at the 1.	
top of the Document window. 
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Select or create a folder in the 2.	 Hair library.

Click the + button at the bottom of the 3.	 Library palette. The 
dialog shown in Figure 47 appears. Click OK to continue.

Figure 17.47. Poser advises you to save the hair groups along with the prop 

(skull cap).

The 4.	 Set Name dialog prompts you to assign a name to the 
new hair. Before you click OK, you need to choose the objects 
that make up the dynamic hair. Basically, you need to select 
the skull cap and any hair growth groups that are attached to 
it. Click the Select Subset button as shown in Figure 48.

Figure 17.48. Click the Select Subset button to choose the hair parts.

In the 5.	 Hierarchy Selection dialog, place a check mark 
beside the parts that make up the hair. In Figure 49, we select 
the skull cap and seven growth sections. Then click OK to 
return to the Set Name dialog.

Figure 17.49. Choose the skull cap and all growth groups from the Hierarchy 

Selection dialog.

Make sure that you have entered a name for the hair, and 6.	
click OK. Your hair should appear in the Hair library that you 
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selected.

Setting Hair Dynamics
There is one more aspect to dynamic hair that we have yet to cover. 
You have to calculate the dynamics in order for the hair to react 
to animation. Dynamics are the forces that the hair has to work 
against: gravity, springiness, air, bending, and so on. In addition, 
you will also be concerned with collision detection. That is, you 
don’t want the hair to go through objects, you want it to bounce 
off of them. 

In order for collision detection to work, you have to turn it on with 
the Do Collisions option. You also have to think ahead about the 
body parts or objects that the hair will collide against. For each 
of those parts, try the dynamic calculations first without the “Do 
Collisions” option turned on. If the desired quality isn’t achieved 
due to intersections with the body, turn on the Do Collisions 
option for the offending body parts only. This saves system 
resources.

The process is as follows:

Select a body part that you know intersects with the hair.1.	

If the 2.	 Properties palette is not open, choose Object > 
Properties to display it (or, if the Parameters palette is 
already open, click the Properties tab to switch the view).

Check the 3.	 Collision Detection check box, shown in Figure 
50 if previous calculations caused hairs to intersect with the 
body.

Figure 17.50. Check the Collision detection option for each body part that will 

make contact with the hair.

Repeat steps 1 through 3 for each body part that the hair 4.	
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intersects with.

After you generate your hair groups and create the hair, as 5.	
described in the previous tasks, select the first section of hair 
that you want to calculate. Once you select the growth group, 
set the controls in the Dynamics Controls section of the hair 
room. The controls are as follows: 

Gravity�� : Controls how the hair is affected by gravity. 
Higher numbers weigh the hair down more, while lower 
numbers cause the hair to fly out more easily.

Spring Strength�� : Controls how much the hair 
bounces. Higher values create hair that is more bouncy 
(appropriate for fine hair), while lower values bounce less 
(more appropriate for very curly, thick hair).

Air Damping�� : Controls how much resistance the hair 
has against air. This setting should be used with caution. 
Higher values are more appropriate for longer hair, and 
lower values are more appropriate for short hair.

Spring Damping�� : Controls the elasticity, or 
stretchiness, of the hair. Higher values are more stretchy, 
while lower values remain constant.

Bend Resistance�� : Controls how much you want to 
allow the hair to bend or fold upon itself. Higher values 
are more resistant to bending.

Position Force�� : Controls how much or how little 
the hair vertices are allowed to move from their 

choreographed positions. Higher settings create less of a 
dynamic effect.

Root Stiffness�� : Controls how stiff the hair is at its 
root (the base of the object that has hair).

Root Stiffness Falloff�� : Controls the amount of 
distance between the root and the tip before the stiffness 
of the hair begins to decrease.

  The default settings in the Dynamics Controls section 
work well with the curly hair style that is covered in Task 2. 

Check the 6.	 Do Collisions checkbox, shown in Figure 51. This 
prevents the hair from breaking through the head. However, 
make note that dynamic calculations take longer to complete 
when collisions are calculated.

Figure 17.51. Check the Do collisions option to prevent hair from penetrating the 

head or other objects.
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Pre7.	 ss the Calculate Dynamics button to calculate the first 
section of hair.

Repeat steps 1 through 3 for each additional section of hair 8.	
in your object, working your way up to the top sections in the 
head.

Creating and Changing the Hair 
Color
It is very possible to get realistic looking hair colors in the Poser 
Material room. One easy way to generate nice hair colors is to find 
a color photograph with the hair color you want to emulate. Pick a 
dark color from the photograph for the root color, and a middle or 
light color for the tip color.

Here’s an example:

Click the Material tab to enter the Material room. 1.	

Drag your mouse over the preview window. The cursor turns 2.	
into an eyedropper. Use the eyedropper to select a hair growth 
group. The Shader window should display the hair material in 
the Advanced tab, shown in Figure 52.

Figure 17.52. Select a hair section to display its material.

Find a photograph that shows a person with the color hair 3.	
that you would like to reproduce. A photo that shows nice 
variations between light and dark will produce the best results. 
Open the photo up in an image editing program that will 
allow you to select a color and display its Red, Green, and Blue 
color formula. For example, Figure 53 shows a hair photo in 
Photoshop. The area beneath the eyedropper shows a Red, 
Green, Blue color formula of 84 (red), 42 (green), 26 (blue).
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Figure 17.53. Open a photo in an image editor that allows you to view color 

formulas.

Find three representative colors for the hair: one for the 4.	
darkest color, one for a middle color, and one for the lightest 
color. Write down the color formulas for each. For example:

Dark blonde: �� Red 84, Green 42, Blue 26

Middle blonde: �� Red 140, Green 100, Blue 74

Light blonde: �� Red 196, Green 168, Blue 144
Return to the 5.	 Material room, and locate the Hair node. You’ll 
see three colors: Root Color, Tip Color, and Specular Color. First 
we will use the dark color for the root color. Click the Root 
Color color square to open the Poser color palette shown in 

Figure 54. Then, click the tri-colored square in the upper-right 
corner. 

Figure 17.54. Click the tri-colored square in the Poser color palette to open the 

standard color dialog.

When the standard color dialog opens, enter the Red, Green, 6.	
and Blue color values for your dark hair shade, as shown in 
Figure 55. Then click OK to return to the Material room..

Figure 17.55. Enter the Red, Green, and Blue values for your dark hair shade.

In a similar manner, click the Tip Color color square. For this 7.	



Poser 8
Tutorial Manual

217

Chapter 17: The Hair Room

hair color entry, use the middle color value that you selected 
from your hair sample (Red 140, Green 100, Blue 74 as shown 
in this example).

There’s a little bit of a twist to the specular color. You want to 8.	
start with the lightest color sample that you selected (Red 196, 
Green 168, Blue 144). 

After you plug the light values into the Specular Color, 9.	
click its color square again to open the Poser color mixer. 
Now, desaturate the light color a bit by moving your mouse 
downward along the color bar on the left side, as shown in 
Figure 56. This desaturated color softens the highlights so that 
they look less shiny and plastic.

Figure 17.56. Desaturate the specular color to soften the highlights

Once again returning to the Hair color node, check the Opaque_
In_Shadow option at the bottom of the hair node. You can see this 
setting in Figure 50, after step 2 above. This new option makes 
hair look more opaque in shadows. This helps the hair look fuller 
without having to raise the Hair Density settings, and makes 
rendering a lot easier on system resources.

Before you leave the 10.	 Material room, save your new material 
so that you can apply it to the remaining hair sections. Locate 
the Materials library in which to save the new material. Then 
click the + button at the bottom of the Library window. The 
New Set dialog appears.

Enter a name for your material (such as Medium Blonde, 11.	
shown in Figure 57), and check the Single Material option. 
Then click OK to save the material to the library.

Figure 17.57. Name the material, and save it to the library as a single material.

Use the object selector at the top of the 12.	 Material room 
window (shown in Figure 58) to select each growth group, one 
at a time. Then double-click the material icon that you saved 
to the library. This changes the current growth group to your 
new color. After they are all assigned, render your hair to see 
the results!
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Figure 17.58. Make sure you assign the new color to all hair growth groups.

Hair Coloring Tip!
You’ll notice that the default hair color uses noise to vary the colors 
of the hair a little bit. You can also use a bitmap to accomplish the 
same thing. This allows you to create hair with streaks, or to control 
the coloring of a fur coat, or a leopard. Basically, the hair will take 
on the color of the underlying bitmap.

To illustrate this, open the file CheckerBoardHair.pzz from the 
Tutorials/HairRoom folder in your Poser installation. In this example, 
a checkerboard material is applied to the underlying prop with the 
Diffuse Color node. Note that the color beneath the hair generates 
the color of the hair that grows upon it, as shown in Figure 59. 

This has great possibilities. For example, you can create hair that 
has streaks in it, or use an animal’s texture map to use as the 
underlying color for fur on the animal.

Figure 17.59. With a checkerboard material assigned to a prop, the hair takes on 

the color beneath it.

In cases where you don’t want the underlying geometry to use the 
same color as the hair texture, you can use the approach shown 
in CheckerBoardHair2.pzz (also in the Tutorials/HairRoom folder). 
In this example, a hair node is attached to the Alternate Diffuse 
channel. The Root and Tip colors are then output to the tile shader 
(or, a bitmap, or another color source). Note that in this case in 
Figure 60, the underlying geometry retains its own color and 
material, and the texture only affects the hair.
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Figure 17.60. You can also use a hair node in combination with another color 

source on the Alternate Diffuse channel.
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Chapter 18: Building a Basic 
Skin Shader

	
by Kiera Wooley

A Note on Workflow
There is a definite relationship between the FireFly render options, 
the Material room, and the lighting in any Poser scene. Changes 
to any one of these elements might necessitate changes to the 
others. When developing a scene that will be rendered as a still 
image, it is generally easiest to compose the scene, create an 
appropriate lighting arrangement, and then tweak materials to 
suit the environment. Polishing the render will generally involve 
making adjustments to the lights, materials, and render options all 
at once. Because of these workflow concerns, any tutorial involving 
the Material room should be viewed as a general guideline rather 
than a definite recipe for a specific result.

Advanced Materials
For the purpose of this tutorial, we will be using the Advanced 
tab to take advantage of the more complex nodes and their ability 
to interact more deeply with scene lighting and the FireFly renderer. 
If you are unfamiliar with the basic operation of shader nodes in 
Poser, please review the Poser Reference Manual, Part 3: Materials 
on page 202.

Getting Started
We will use James for this tutorial. Load James from the Figures 
library and switch to the Material room. Select the Advanced 
tab. Mouse over the miniature Document window and use the 
eyedropper to select any part of the skin to display the basic 
shader. Connected to the Diffuse_Color node is James’ texture 
map, which defines the color of his skin when displayed under 
a pure white light. We shall use this map (and his other texture 
maps) as the basis for our skin shader.

Leave the texture map connected to the Diffuse_Color node, but 
change the Diffuse_Value to 0. 
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	 Figure 18.1: 1: Diffuse_Value set to 0

This eliminates the influence of the Diffuse_Color node on the 
rendered output but preserves the texture in Shaded document 
preview. For our purposes we shall employ the Alternate_Diffuse 
node, which allows us to access the more complex and realistic 
lighting models available under the lighting submenu. We will get 
to that part a bit later. First we will deal with bump mapping and 
specularity.

Bump Mapping
Basic bump maps are often created in a paint program by 
desaturating the texture map to generate a grayscale version. For 
basic skin shading, this method is adequate and provides enough 
roughness to approximate realism. We can create the same effect 
without a separate map or a paint program using basic shader 
math right in the Material room. To do this, drag a Math_
Functions node (New node | Math | math_functions) out from the 
Bump section of the PoserSurface root menu. Connect Value_1 to 
James’ texture map, and leave all the other values alone. Instant 
grayscale! This is an extremely useful technique that you will find 
yourself returning to again and again for reasons we shall discover 
shortly. To finish off the bump mapping, change the value of Bump 
to .003. 
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	 Figure 18.2: Bump value set to .003

At this value, the bump is subtle but noticeable. For stronger bump, 
increase this number in small increments. 

Specularity
Specularity describes the shininess of a surface. Extremely smooth 
surfaces tend to have small, sharp highlights while rougher 
surfaces tend to have large, soft highlights. The specularity of skin 
varies depending on a variety of factors: whether it is wet or dry, 
oily or rough, young or old, and so on. For our purposes, we will 
assume that James has normal skin with a hint of sheen.

Selecting a Specular_Color is something of an art because a 
number of factors affect the rendered output: lighting, texture color, 
and so on. Ultimately, it’s a matter of taste. Try a dark blueish tint, 
RGB 52 52 82. (CTL or CMD click on the color swatch to bring up 
the color picker.) The general rule of thumb is that the darker the 
color, the less specular the surface appears. If we use the value of 
the color to determine how shiny the surface is, we can have fun 
with the Specular_Value node.

In a perfect world, we would use a paint program to create a 
grayscale map to indicate different levels of shininess for different 
areas of skin. White areas of the map would indicate the shiniest 
parts and black areas would be the dullest parts. A specularity map 
for the face would probably be light throughout the oily T-Zone 
area and dark elsewhere. But this is the Basic Skin Shading tutorial, 
so we will take a shortcut. Remember that grayscale version of 
the texture map we created using math nodes earlier? We will use 
it again here. Set the Specular_Value to 1 and connect it to the 
Math_Functions node that we are using for the bump map. This 
will add some realistic shiny variation across the face and keep 
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the sheen from looking too uniform and plasticine. Highlight_Size 
controls how much of the surface area is shiny. Change the value 
to 0.1.

	 Figure 18.3: Skin Specularity settings

Diffuse Skin Shader
Now we’ve reached the heart of our skin shader. Here we will 
combine the glancing light effects of Fastscatter with the more 

subtle lighting model of the Skin shader. One way to do this is 
through the use of a Blender node. Drag a Blender node out from 
the Alternate_Diffuse section (New node | Math | Blender.)

Let’s start with the Skin node. The Skin node offers a more realistic 
lighting model than the standard connection to Diffuse_Color. 
Drag a node from one of the Blender inputs and connect it to a 
Skin node (New node | Lighting | Special | Skin.) Change SkinColor 
to white and connect it to James’ texture map. Change the 
SheenColor to a very pale blue (RGB 235 244 255) related to the 
Specular_Color we set earlier. Connect this to James’ texture map 
as well. Change the skin Thickness value to 1 to get a brighter, 
more natural looking skin tone. The rest of the values may be left 
alone for most renders, but it is important to be aware of the Ka 
(ambience) value and how it affects rendered output. This value will 
need to be adjusted down for any render that requires parts of the 
body to appear in total darkness. For normal lighting, however, the 
.25 value renders nicely.
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	 Figure 18.4: Application of a Skin node

The FastScatter shader allows us to use glancing lights that 
emulate that bright backlit subsurface scattering effect. It’s not 
true subsurface scattering, so we don’t have to wait for a time 
consuming calculation prior to rendering. It’s cheap in terms of time 
and effective. To use it, drag a node from the remaining Blender 
input and create a FastScatter node (New node | Lighting | Special 

| FastScatter.) Connect the Color section of that node to an Edge_
Blend node (New node | Math | Edge Blend.) We do this so we 
can tint the skin affected by the FastScatter effect if we so desire. 
The Outer_Color refers to the edges and the Inner_Color refers to 
interior areas. To visualize how this works, change the Outer_Color 
to a bright orange and the inner color to a bright green and watch 
the effects in the Material preview. It’s not generally necessary 
to tint the skin, but it’s handy to have the option. For now, leave 
the base colors white and connect the nodes to the Skin node we 
created earlier. 
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	 Figure 18.5: FastScatter node settings

That’s it for the basic skin shader. To apply the same settings 
to other parts of the body, right click anywhere in the Shader 
window and “select all”, then copy the selected nodes. Then 
choose another part of the body to apply these settings to, right 
click in the Materials window, and “paste.” Make sure that the 

Image_Map is calling for the proper texture; the body would 
require the James_Body texture map, and so on. Also keep in 
mind that a material collection recalls the location of the nodes in 
the Shader window; arranging the nodes neatly will make later 
adjustments simpler.

Some Notes on Eyes
They say that the eyes are the window to the soul, and so we must 
pay special attention to shading them. Dull, flat eyes can decrease 
the impact of a render, so most of the shader work for eyes is in 
specular highlighting and reflection.

The geometry of James’ eyes is fairly straightforward and 
anatomically realistic. Because of the way the eyes were modeled, 
we can do some interesting things in the Material room. The 
EyeBall material zone actually covers the entire eye, so we will use 
this material zone to create most of the specular and reflective 
effects. By default there is a transparency map applied to the 
eyeball; this will have no effect on the specularity of the eyes. To 
simulate the shininess of tears over the sclera and iris, we will use 
all of the specular nodes available to us.

The default values for Specular_Color, Specular_Value, and 
Highlight_Size are actually fine. They can be zeroed out or left they 
way they are for most renders. To add a bit more drama, though, 
we can add to these values by making use of the Alternate_
Specular section of the root node. Here we may take advantage of 
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additional specular lighting models, such as glossy, anisotropic, or 
phong, and the Color_Math node can be used to combine specular 
lighting models. Drag a Color_Math node (New node | Math | 
color_math) from the Alternate_Specular section of the root node.

Now we’re going to combine Glossy and Anisotropic nodes using 
the Color_Math node we just created. Anisotropic shading is 
useful because it can create irregular specular highlights that are 
more or less pronounced depending on the angle of the light. 
Drag an Anisotropic node from one of the Color_Math values 
(New node | Lighting | Specular | Anisotropic.) It can be effective 
to adjust the u_Highlight_Size (horizontal) and v_Highlight_Size 
(vertical) according to the lighting in the scene. For example, larger 
u_Highlight values create a nice horizontal glancing effect in side-lit 
scenes.

Drag a Glossy node from the remaining Color_Math value (New 
node | Lighting | Specular | Glossy.) The glossy node is valuable 
for wet or slick surfaces. It produces a large highlight that can be 
adjusted for sharpness and size. We can use this highlight to create 
a light reactive reflective appearance to the pupil area without 
using time true reflection or reflection maps. In a paint program, I 
used a photograph to create an image to use as the basis for this 
faked reflection. It is beyond the scope of this tutorial to describe 
the exact methods for doing this, but it should suffice to say that 
a slightly blurred, high contrast, black and white photo works well 
for this purpose. For more realism I added some eyelash marks to 
the top of the photo and aligned it to the iris location on the eye 
texture map. Connect this reflection image to the Ks section of 

the Glossy node. Combined with the Anisotropic node we created 
earlier, the result is a sharp light reactive highlight with a hint 
of realistic irregularity that suggests that the eye is reflecting an 
environment. 

	 Figure 18.6: Eye shader settings
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Conclusion
This walkthrough was just a demonstration of one approach to 
skin shading. It’s not the right way or the only way, and may not 
be useful for every situation. I encourage everyone to study all of 
the shaders supplied with Poser and to experiment with their own 
ideas about what makes for great skin rendering. Happy posing!

Figure 18.7: Completed basic shader results.
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Chapter 19: Image Based 
Lighting

	
by Colin Gerbode
One of the useful features in Poser is its ability to use image-based 
lighting, in which the lighting values for the scene are computed 
based on the brightness values of an image which is “wrapped” 
around the scene. This allows a realistic lighting model to be 
applied quickly and easily without having to place and fine-tune 
multiple lights in a scene.

The process for using image-based lighting in a Poser scene is 
fairly simple. Select a light, either from the Current Actor menu 
at the top of the preview window or by clicking on one of the light 
controller “pins” (see below.)

Figure 19.1.

Figure 19.2.

Now, get the properties for that light by selecting Properties from 
the Object menu. Click the Diffuse IBL radio button and then 
the Advanced Material Properties button to pick an image to 
use for your lighting. You’ll be taken to the Material room with 
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the light selected and its shader information available. Once you’re 
in the Material room, you should attach an image map node to 
the light’s shader. Click and drag from the little plug icon in the 
light’s shader to bring up a menu; select New node > 2D textures > 
image_map as shown.

Figure 19.3.

Now click in the Image Source section of the new node and open 
one of the supplied light probe files. For this tutorial we’ll use the 
sunRight.jpg file, found in Poser/Runtime/textures/Poser 6 Textures/
LightProbes. This is a regular JPEG file shot with a digital camera 
using a mirrored ball as the light probe. If you want to create your 
own light probes, you will need a mirrored ball to allow the image 
to contain lighting information for as much of the environment 
as possible. A good mirrored gazing ball will do nicely. These are 
available for around $70 from garden supply stores, but we have 

seen people use reflective Christmas ornaments in a pinch. The 
larger your ball and the higher your image resolution, the better 
the lighting quality will be. With the sunRight image selected, the 
shader should look something like this:

Figure 19.4.

Now, we can build a scene to make use of this lighting. I’ve used 
a high-res ball prop, a cube and a cone on its side; not terribly 
interesting but together they show how the light affects different 
surfaces. The components of the scene are clustered rather closely 
together to show off the shadowing abilities of image-based 
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lighting. A render using basic settings gives this result: 

Figure 19.5.

This is OK, but we should have shadows here. First, we should 
turn the render Auto Settings up to the point where Raytracing 
is used; this will increase render times but down the road will 
definitely improve quality, as shown below: 

Figure 19.6.

Now, that’s better, but there is still room for improvement. The 
shadows in particular are not terribly realistic. The trick here is to 
turn on Ambient Occlusion--a feature of Poser that lowers the 
ambient light when objects are close together, as they are in this 
image. Turning Shadows off and Ambient Occlusion on in the 
light’s Properties allows us to render once again, with this result: 
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Figure 19.7.

Note that this render was done with the render Auto Settings at 
about half of maximum quality; this setting (shown below) should 
be quite sufficient for most high-quality rendered images. Certain 
specific situations will require a higher quality setting, and often in 
cases like these using custom render settings will provide the best 
balance between quality and performance.

 As noted, for Ambient Occlusion effects to appear, Raytracing must 
be used; for a discussion of FireFly render settings and parameters, 
see Chapter 8: “FireFly Render Tips” on page 103. 

Figure 19.8.

A diffuse image-based light by definition does not contribute any 
specular light. This means that there will not be any highlights in 
a scene lit solely by one Diffuse IBL. To ensure that surfaces with 
specularity (such as a figure’s eyes) appear as glossy as may be 
desired, you might want to consider adding a specular-only light 
source. The Set Up Light Style wacro in the Material room can 
assist you with creating such a light. The following images show 
which option to select in the Choose Light Style dialog, and how 
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a specular-only light is configured. 

Figure 19.9.

Once you have finished adding your specular-only light, position it 
so that it is located roughly in the same location as the brightest 
spot in your light probe.

Poser introduces support for High Dynamic Range Images (HDRI) in 
image-based lighting, which allow even more realism and accuracy 
in lighting calculations. High Dynamic Range Images capture 
more detail in the very dark and very light portions of the image, 
so that details don’t get lost. HDRIs are typically either in EXR or 
HDR format; Poser supports either of those formats, as well as 
16-bit-per-channel TIFF and PNG images. (Of course, standard Low 
Dynamic Range TIFF and PNG images can also be used, as well as 
JPEGs, but these are not HDRIs.) When using Low Dynamic Range 
images for IBL, the IBL Contrast setting in the Advanced tab of 
the Material room can be set to 2 or 3. Whe using HDRI in image-
based lighting, remember to adjust the IBL Contrast setting to 1 
as shown, to preserve the subtleties that HDRI allows. 

Figure 19.10.

The following image demonstrates the difference in lighting quality 
between renders generated using Low Dynamic Range and High 
Dynamic Range Images for image-based lighting.
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Figure 19.1: The Right Shoulder selected on the figure.
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Chapter 20: Using Talk 
Designer

	
by Colin Gerbode
Poser includes the Talk Designer--an easy way to get your Poser 
figures talking naturally without recourse to outside programs 
or tedious keyframing by hand. Using Talk Designer is simple. 
First, select a Poser figure which includes phoneme morphs; 
these are facial morphs that allow the figure to make the mouth 
shapes required for speech, and many Poser figures have them 
already installed. To see if the figure you want to use has phoneme 
morphs installed, bring the figure into the scene and select its 
head in the Current Actor menu. In the Parameters palette 
(select Parameter Dials from the Window menu if need be) look 
for Phonemes in the Morph dials to ensure that your figure has 
phonemes available, as shown. 

Figure 20.1.

Once you have a figure with phoneme morphs ready to use, you’ll 
need a sound file. Talk Designer works with AIFF (Mac) and 
WAV (Windows) files. There are a number of audio-conversion and 
editing applications available that can translate other file formats 
(MP3, etc.) into AIFF or WAV, or allow you to record your own 
speech on the computer. When you have your sound file ready to 
go, select Talk Designer from the Window menu to see the Talk 
Designer palette. 
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Figure 20.2.

Click the Sound File button as shown in this image to load the 
chosen WAV or AIFF. To help Talk Designer create accurate mouth 
movements, users can also load a text version of the speech into 
Talk Designer (by clicking the Supplemental Text entry-
box widget as shown and directly keying in text, or by clicking 
the button to load an existing text file). You don’t have to load 

supplemental text, but including it makes a significant impact on 
your final animation. Talk Designer uses viseme map files for 
mapping speech sounds to visemes, which are essentially morph 
targets or settings that correspond to specific speech sounds. Take 
a look at http://en.wikipedia.org/wiki/Viseme for a quick definition 
and explanation of visemes. The Viseme Map File pop-up menu 
includes viseme map files for most of the Poser figures included 
with your Poser installation that have phoneme morphs. Be sure 
to select the appropriate file for the figure you have selected. If 
for some reason your selected figure does not match one of the 
viseme map files included in the menu, the Viseme Map File 
button allows you to load an alternate viseme XML file (if one is 
available). If you aren’t sure whether your figure has a viseme map 
file associated with it, contact your content provider. 

Talk Designer also allows you to apply other head movements 
including eye blinks, and to control the figure’s expression during 
the speech. Live actors don’t hold their heads perfectly still while 
talking, and you’ll most likely want your Poser figures to look 
natural as they speak. Talk Designer helps to make this easier. 
The Eye Blink Rate slider and Create Eye / Head Motion 
checkboxes allow you to tell Poser to apply intermittent small 
movements to the figure’s head and eyes over time. Setting the 
Emotional Tweaks sliders applies expression morphs over 
the course of the speech animation; configure these sliders to 
customize facial morphs to match your specific sound file.

One other tool that Talk Designer provides is the Enunciation 
slide. This control affects how strongly the facial morphs are 

http://en.wikipedia.org/wiki/Viseme
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applied, with higher settings giving a more extreme application 
of the facial morph. The degree to which morph targets are 
manipulated is controlled by the energy of the phonemes in the 
imported sound file, with louder or higher energy sounds applying 
more pronounced morphs. However you may want to adjust the 
Enunciation slider to exaggerate or diminish the morph effects a 
bit, for example if the figure is whispering but you want their mouth 
movements to be more distinct, or if the figure is mumbling. 

Talk Designer takes advantage of Poser’s new Animation 
Layers feature, which lets you store keyframed animation data 
for different actions or body parts as separate layers, which 
can be edited separately and then blended to produce the final 
animation. Talk Designer lets you save the speech animation 
into its own separate layer, or into any other existing layer, if for 
example you already have some facial animations to which you’d 
like to add speech. If you have more than one figure speaking in 
your animation, putting each sentence into a separate layer with 
individual start and end frames can help keep your animation 
organized. For more information about Animation Layers in 
Poser, see Chapter 16: “Animation Layers” on page 288. You can 
also save the animated speech directly into your Expressions 
library for later use.

Once you have created the proper settings, click the Apply button 
to generate the animated facial pose and merge the sound into the 
Poser scene. If you check the Keyframe palette, you’ll see the new 
keyframes for the head. Simply select the layer into which you saved 
the speech animation as shown in the following image. 

Figure 20.3.
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Chapter 21: Animation Layers

by Colin Gerbode
The Animation Layers feature allows animators to save different 
animation information to separate layers. A walk could be saved to 
one layer while facial expressions are saved to another, and hand 
and arm movements are saved in a third layer, allowing each set 
of movements to be edited separately and blended in a controlled 
fashion. Using animation layers is simple. When applying a pose or 
using the Walk Designer or Talk Designer, Poser asks the user 
whether to place the animation information into the Base layer or 
into a new layer, which can then be edited to meet your specific 
needs. Poser’s Animation palette has a new Layers tab, which 
allows users to choose which layer to edit and to specify how the 
layers should interact. 

Figure 21.1.

Let’s suppose we want to create an animation in which Jessi 
walks along and waves and smiles. This is pretty simple, and we 
can actually do this in Poser without using layers; but using layers 
allows us to edit keyframes non-destructively, so we have more 
control.

We’ll start by bringing Jessi into an empty scene. Now, we open 
up the Animation palette (choose Animation Palette from the 
Window menu, or click the button at the bottom of the screen 
with the little key on it) and select the Layers tab as shown above. 
We can click the New button to create a new layer; rename it if 
you like by entering a new name in the Layer Name field and 



Poser 8
Tutorial Manual

239

Chapter 21: Animation Layers

hitting Enter. Now, click the Keyframes tab; we’re looking at the 
scene in frame #1, with only the initial keyframes set. Select the 
new animation layer we just created by choosing it in the Layer 
drop-down menu; click the appropriate square on the chart for the 
element you wish to pose and the point in time at which you want 
it to be posed. In this case we’ll pose the right shoulder, forearm 
and hand to make Jessi wave. Pose the part(s) to create the new 
keyframe(s) in the new layer; continue this process until you have a 
decent wave motion. Keyframes should appear something like this: 

Figure 21.2.

Note that the keyframes (the brightly lit green frames) in the above 
image are spaced far enough apart to allow sufficient tween 
frames in between for Jessi to move from one of your designated 
poses to another. Poser will calculate the tween frame poses for 

you, but for more realistic animation it is important to allow enough 
frames between your keyframes for natural movement.

We now have the keyframes for the wave stored on their own layer. 
Now, we can repeat this process for Jessi’s wink and smile. Click 
the Layers tab and create a new layer; call it Expressions as shown: 

Figure 21.3.

Go back to the Keyframes tab at Frame 1 and proceed down the 
timeline, adjusting Jessi’s facial morphs to change her expression. 
Bear in mind that animating facial expressions usually requires 
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some corrections to the tween frames, so you may need to iterate 
over your facial animation until you are satisfied with the results. 
(For more information on tween frames and animating facial 
expressions, please refer to the “Poser Animation 101” tutorial 
on the Smith Micro website, www.smithmicro.com, in the Training 
> Tutorials > Poser section.) Your Expressions layer should look 
somewhat like this: 

Figure 21.4.

Continue setting keyframes and facial morphs until you have 
completed the smile and wink animation. When finished, you will 
have keyframes for the facial expressions in the Expressions layer 
and keyframes for the wave in the Hand Gestures layer: 

Figure 21.5.

We can now use Walk Designer to lay down a walk in the Base 
layer, then combine them all to create a finished animation. 

From the Figure menu, choose Create Walk Path; edit the path 
by dragging its control points around, or leave it as given. Select 
Jessi and open the Walk Designer from the Window menu; 
set walk parameters (or use the defaults) and click Apply to 
have Walk Designer generate keyframes for the walk. For more 
information on using the Walk Designer to animate a walk, see 
the tutorial in “Character Creation and Animation” on page 65. If 
these keyframes go into the Base layer, that’s fine; if they go into a 
new layer, that’s okay too. In that case call the new layer Walk. 
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Figure 21.6.

And there you are! When Poser renders or displays the animation, 
if the Composite Method on the Layers tab is set to Replace 
(the default setting) then keyframes in upper layers replace 
corresponding keyframes in lower layers. Lower keyframes for which 
there are no corresponding upper keyframes remain untouched, as 
shown below: 

Figure 21.7.

Consequentially, if you are using a Poser tool like Walk Designer, 
which generates keyframes for every element of a figure, it may be 
necessary to select and create keyframes for additional parts of a 
figure aside from the specific part you’re animating. For example, 
setting an arm to wave is a simple task, but just manipulating 
one parameter (like the Bend value) creates keyframes only for 
that parameter of the selected part--if Walk Designer has the 
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character’s arm moving back and forth past his hip, then just 
applying an additional layer with the forearm’s Bend parameter 
changing won’t give you a good wave at all. To fix this, first think 
through what other animation you’re using on other layers. Figure 
out which body parts will need to be keyframed in order to make 
the motion look right.

Figure 21.8.

To make a character wave while walking, we’d need to apply 
keyframes for all parameters of the collar, shoulder and forearm, 
in order to override the keyframes that Walk Designer will 
apply (see screen shot above). This is easily done: in each frame 
in which you move the forearm, select the shoulder and click the 
Add Keyframe button on the Animation palette. Do the same 

for the forearm and hand. It isn’t necessary to select any particular 
parameter, just choose the whole body part from the Current 
Actor menu, or by clicking on it, and add the keyframe; that will 
set keyframe data for all parameters, which will then be available to 
override unwanted keyframes in underlying layers.

Setting the Composite Method to Add produces more complex 
interactions. Specifically, if a certain body part has a keyframe 
at some point in the timeline in one layer, and that same body 
part also has a keyframe at that point in another layer, the values 
for those keys will be added together. For example, if Jessi has a 
keyframe set for her right forearm that bends it +15 degrees in 
frame #10 of the Base layer, and we apply a pose that, in frame 
#10, has a bend value of 20 degrees for the same right forearm, 
then when these layers are composited together the net value 
for the bend will be 35 degrees at that point. As you can imagine 
this can produce some odd effects especially when using poses in 
combination with Walk Designer, which provides keyframe values 
for everything in every frame. We suggest that the Add method be 
used sparingly and with careful thought as to its effects.

Remember, when looking at the Graph palette or the Keyframes 
tab in the Animation palette, you’ll only see values for the 
current layer- although in order to help visualize the net effects 
of changes made over the various layers, the Graph palette now 
has an additional display. A grey or dotted line shows the value of 
the current parameter taking into account the various layers and 
Composite Modes. Thus, if the dotted line is the same as the solid 
red one on the graph display, the Composite Method is most likely 
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set to Replace, and any frames with data (keyframes or tween 
frames) will replace frames in layers below them. If the dotted line 
diverges from the solid red one, the Composite Method is set to 
Add, and underlying frame data is affecting the final result.

There are a couple of things to be aware of when using animation 
layers that have to do with the way in which keyframes are applied, 
viewed and modified as you work in the various layers. Certain 
animation tools display all the layers--the Document window, 
for example--while others show only the current layer regardless 
of setting, like the Parameters and Graph palettes, as well as 
the Keyframes tab of the Animation palette. Don’t be surprised 
if certain keyframes that you have set seem to ‘disappear’ if you 
switch layers--this is normal, the keyframes are still there, they’re 
just not on the current layer.

A layer begins at its start frame but may contain keyframes that 
exist ‘after’ its end frame; the end frame merely determines the 
point at which the frames in the layer are no longer applied or 
viewed; frames after the end frame are still in existence but are 
ignored. Moving the start frame, then, will change the position 
of any keyframes in the layer, while moving the end frame won’t 
(but may reveal or obscure keyframes that have already been set.) 
Moving a layer forward or back along the timeline in the Layers 
tab of the Animation palette does reposition the keyframes in 
that layer along the timeline; their spacing relative to each other 
won’t be affected. Think of each animation layer as a piece of film 
laid atop other pieces of film- everything on a given bit of film 
moves together.
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Chapter 22: Advanced Posing 
and Animation
From previous chapters within this manual, you should now have 
a grasp of the basic procedures involved in posing and animating 
figures within Poser. This chapter introduces additional Poser 
features that will enable you to refine your techniques, to create 
more realistic images and animations.

Auto Balance and Posing
The Auto Balance feature can be a valuable tool for creating 
realistic poses. When the feature is enabled, Poser calculates 
what the mathematical “weight” for a figure is and then tries to 
maintain it. In this mathematical model, there is more weight in the 
hip or center portion of the figure, than there is in the upper torso. 

As you move figures, Poser automatically adjusts body parts to 
attempt to maintain the original weight distribution. This results 
in more natural looking poses, without the need to make several 
position adjustments. 

To further affect the weight distribution and compensation 
calculations, you can reposition the Center of Mass Control 
Object (red outlined ball) at the base of the figure. This control 

object is adjustable along the X and Z axes in the ground plane. 
Moving the Center of Mass Control Object also adjusts the 
Center of Mass Indicator, which appears as a shaded sphere 
in the XZ (ground) plane under the figure. This Indicator shows 
the position above which the current center of mass is located., 
as calculated from the body part weights and the position of the 
Control Object.

Figure 22.1: Example of posing using Auto Balance.

When posing using Auto Balance, small, subtle motions result in 
better poses, than do large motions. Large motions may create 
drastic results. When this happens, use the multiple Undo or the 
Restore feature to reset the position of body parts. 

To enable the Auto Balance feature:

Choose •	 Figure menu > Auto Balance. 
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Motion Capture and Animations
Poser can read stored motion capture files, known as Biovision or 
BVH files. These files let you apply stored human motion to your 
3D models. BVH files create incredibly realistic motion without you 
having to set up a large number of keyframes. 

BVH files are created using motion-capture hardware. Reflectors 
are attached to a person’s joints. As the person moves, the 
position and rotation is captured in 3D space at different points 
in time. Each point of time is then keyframed together to create a 
smooth animation. Since this process creates literally thousands 
of keyframes, there is no interpolation needed to create smooth 
motion. 

Importing and Exporting Motion 
Capture Files
BVH files can be imported and exported like any other file type. 
Sample BVH files are stored in the Tutorials > Motion Capture 
folder that is included with your Poser installation.

To import a BVH file:

Choose 1.	 File menu > Import > BVH motion. 

The Import dialog appears. 2.	

Locate the desired file and choose Open. 3.	

To export a BVH file:

Choose 1.	 File menu > Export > BVH motion

This may take several minutes, depending upon the complexity 2.	
of the file.

Setting the align axis

You can set whether the figure’s arms are aligned to the X or Z axis 
during the import process. The align axis is determined at the time 
of recording. It’s important to choose the right axis or else your 
figures look incorrect. 

To determine the correct axis for BVH files, please read the 
documentation supplied by your content provider. 

Editing keyframes

The BVH keyframes are applied to the current figure when imported. 
You can edit BVH keyframes as you would any other animation.
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Figure 22.2.
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Chapter 23: Morph Target 
Creation

	
by Lisa Ahrens
The Create tab on the Morph Editor palette contains controls 
that allow you to create new morph targets by selecting and 
modifying the mesh vertices on any object within your scene that 
has a mesh. If you have a project that requires actual modeling 
work, you can create morphs in a 3D modeling application and 
then import them into Poser (see “Morph Targets” on page 307 for 
more information). You can access the Morph Editor by clicking 
the Morphing Tool within the Editing Tools display.

Figure 23.1.

Before starting work with the Morph Editor, make sure to select 
the object (prop or body part) you wish to modify in the Current 
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Actor menu. 

Figure 23.2.

When you then mouse over the selected actor with the Morphing 
Tool enabled and the Create tab displayed, you will see a multi-
colored display overlaid on the mesh. This display serves as a visual 
preview of the impact region for any of your modifications. The red 
area of the impact region will be directly affected, with the orange-
yellow-green surrounding areas indicating the gradiated falloff 

region for the modifications. 

You can adjust the impact region by selecting from five different 
brush styles, all with varying degrees of direct impact vs. falloff. 
Falloff specifies the degree to which vertices towards the outer 
edges of the impact region will be affected by your modifications. 
Falloff can be a gradual lessening of impact as you move out 
from the center of the impact region, or an abrupt drop in effect, 
depending on the brush style you select. 

Figure 23.3.

The left-most brush style affects only a single vertex on the mesh. 
The other four brush styles all affect a region of the mesh, with the 
size of the falloff region decreasing, until the right-most brush style 
represents a region with zero falloff, so that all vertices within the 
region are impacted equally. Your specific task will determine which 
brush style you should select. For highly detailed work such as fixing 
geometry issues, you may wish to work with one or two vertices at 
a time. For other tasks like creating facial expressions or improving 
cloth simulation results, you may find that one of the regional brush 
styles suits your purpose better.

Once you have selected the brush style with which you wish to 
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work, you can adjust the Radius dial, which will increase or 
decrease the size of the impact region. Note that regardless of how 
large you set the impact region, only the selected Current Actor 
will be affected by your modifications. 

  The Radius dial controls the size of the impact region, 
while the various regional brush styles determine the degree of 
falloff within that impact region.

You can also adjust the Magnitude dial, which will change how 
much effect the Morphing Tool will have within the specified 
impact region. High Magnitude settings make for more dramatic 
changes, while low Magnitude settings are better for precision 
work.

After setting up the impact region and Magnitude to your liking, 
go back up to the top of the Morph Editor palette, and specify 
the type of action you wish to use when you modify the mesh. 
Your options are Push, Pull, Smooth and Restore. Push moves 
the vertices inward from the original mesh surface to create 
concavities, Pull draws the vertices outward from the original mesh 
surface to create bulges or bumps. The Pull option is especially 
useful for fixing issues with body parts poking through conforming 
clothing, as shown in the images below. Just select the clothing 
item, and pull it out past the bit of showing skin. You can also use 
Push and Pull to add details on existing surfaces, such as moles or 
dimples, creases or edges.

Figure 23.4.

The Smooth action gradually reduces variation in the mesh 
surface; use this with care, as it tends to reduce definition in the 
surface of the object. It’s great for smoothing out highly variable 
surfaces, to create a more consistent surface texture. Restore 
is a great tool to use if you make modifications that go a little 
beyond what you were hoping for. Restore gradually reverts your 
modifications, taking the mesh back towards its unmorphed state. 
Thus, it allows for a gradual “backing off”, rather than simply 
undoing your changes and having to start over.

Select your desired action, and then specify whether you wish 
your modifications to be made relative to the mesh surface, or the 
screen, by selecting either the Surface or Screen radio buttons. 
When working in Surface mode, all changes will be made in the 
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direction of the surface normal of the mesh at the point of impact. 
Screen mode allows you to modify the mesh in any direction, but 
requires you to rotate the figure relative to the camera in order 
to deform the mesh in different directions. When first starting 
to use this tool, I recommend working in Surface mode, as it 
will probably meet most of your mesh sculpting needs, and frees 
you from having to worry about how your figure and camera are 
positioned. 

Figure 23.5.

Three other options to consider before you start to make your 
modifications are the Accumulate, Stroke and Group options. 
Enabling Accumulate means that so long as you continue with 
a single click-and-drag movement with your mouse, the changes 
to the mesh will continue to accumulate. This lets you work faster, 
as you can do more with each click-and-drag movement. However, 

it increases your chances of taking your modifications too far. 
Disabling Accumulate gives you more precise control, but requires 
a new click-and-drag motion for each modification. Play around 
with enabling and disabling the Accumulate option, and with 
combining Accumulate with different Magnitude settings, to 
find the mode that lets you work most comfortably and efficiently.

Like Accumulate, the Stroke option also will have a direct affect 
on how your changes impact the mesh. Enabling Stroke means 
that all changes are restricted to the original impact region only, 
and the mouse movement controls the degree of the change. 
Disabling Stroke means that as you move the mouse, your 
modifications will affect the vertices along the trajectory of your 
mouse stroke. 

Figure 23.6.
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The Group option is useful if you want to restrict your 
modifications to polygons within a specific group. This can be 
helpful for increased control on a mesh that has multiple groups 
within the selected actor. Even if your mesh does not include 
groups, you can create one for the specific purposes of limiting 
modifications to specific polygons on the currently selected actor. 
For more information about groups, and creating groups, see <add 
x-ref to Ref Manual > .

Once you have configured the Morphing Tool settings as 
described above, go ahead and make your mesh modifications. As 
you work, all of your modifications will automatically show up in a 
“Custom Morph” target, which can be found on the Parameters 
palette for the currently selected actor. This morph target is basically 
a container for the current state of the mesh for that actor; any 
future changes to the mesh will overwrite previous modifications 
held within this morph target. Therefore, if you wish to save any 
particular mesh state, use the Save a Copy As... button at the 
bottom of the Create tab to create a new, separate morph target.

Remember, if any of your changes are more than you wanted, you 
can either Undo to erase your change(s) and do them over, or you 
can change to Restore mode to gradually back your change off to 
the point where you wanted to stop.

As you work, feel free to experiment with the various display 
settings included on the Create tab. Display Mesh will show the 
mesh overlaid on the surface of the object, regardless of which 
Display Style option you are using. Display Brush enables and 

disables the impact region preview display. Work with Current 
Morphs allows you to visualize or hide the current state of any 
other morph targets. Disabling this option simply reverts the mesh 
to its neutral state temporarily; it doesn’t actually change the 
state of those other morph targets. So when you leave the Morph 
Editor, those morph targets will revert to their current states 
automatically.

The bottom portion of the Create tab contains several buttons 
that you may wish to make use of in the course of your work. The 
Mirror button allows you to make modifications to one portion 
of a mesh, and then to directly mirror those changes on the other 
half of the mesh, along a specified axis such as -x to +x or +y to -y. 
Note that Mirror only translates changes across the mesh of the 
actual selected actor. It will not translate changes from one actor 
to another.

Figure 23.7. 
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Chapter 24: Advanced Body 
Shaping
Besides the basic body shaping tools like the Scale and Taper tools, 
Poser provides two features for customizing the shape of figures: 
Morph Targets and the Joint Editor. 

Morph targets let you add additional parameters to a body part 
that allow you to gradually reshape it. Joint Parameters let you set 
up how the joints in your figure move. 

Morph Targets
One of the most powerful features in Poser is the ability to add 
user-defined morph targets. Morph targets are transitional changes 
in the geometry of the figure that can be animated over time. 
Morph targets can be created directly within Poser using the 
Create tab of the Morphing Tool (see Chapter 18: “Morph Target 
Creation” on page 301 for more information). Or, if your project 
requires more advanced modeling work, you can create the morphs 
in a 3D modeling application, and import them into Poser. This 
process will be described in detail in the following section.

The figure’s geometry can move from the original shape of the 
model to the geometry of the morph target. During the course of 

an animation, the model begins to change shape until it reaches 
the morph target geometry. 

Figure 24.1: A Morph Target used to alter figure geometry.

If you want to see an example of how morph targets are used, take 
a look at the Head parameters of a Poser human figure. All the 
facial parameters, like Mouth and Tongue settings, were created 
using Morph Targets. 

Setting Up Morph Targets
Morph targets are assigned to individual body parts. When you 
set up a morph target, a new parameter dial is added to the body 
part’s parameters. The dial lets you control the amount of morphing 
applied to the body part. 

In order to add a morph target, you need to create a morph target 
geometry. This geometry represents the end-point of the morphing. 
The morph target geometry must contain the same number of 



Poser 8
Tutorial Manual 

254

Chapter 24: Advanced Body Shaping

vertices as the original body part, that’s why you’ll usually use the 
original body part as a starting point. 

A morph target geometry can be created in any 3D modeling 
application that allows you to save a file in OBJ format.

To add a Morph Target in Poser:

Select the body part to which you want to add a morph target. 1.	

Choose 2.	 Object menu > Properties to display the 
Properties palette. 

Figure 24.2: Properties palette.

Click the Load Morph Target button. The 3.	 Load Morph Target 
dialog appears. 
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Figure 24.3: Load Morph Target dialog.

Click the 4.	 Browse (“...”) button to find the geometry file you 
want to use as a morph target. 

The name of the file appears in the 5.	 Geometry field. The file 
must be in OBJ format with the same number of vertices as 
the original body part. 

Do not use a file of the entire figure. The file should contain 6.	
only the body part you are morphing.

Enter the name you want to attach to the parameter dial that 7.	
controls the morph. This dial is added to the parameter dials 
list for the selected body part.

Click OK to return to the 8.	 Properties palette. 

A new dial is added to the 9.	 Parameters palette for the 

selected body part. Use this dial to morph the body part from 
its original shape to the morph target. A value of 0.0 for this 
dial is the original object. A value of 1.0 completely changes 
the body part to the morph target. A value of 0.5 is a hybrid 
halfway between the original object and the morph target. 
You can also use negative values to invert the vertices.

Morph Target Tutorial
This tutorial assumes that you are familiar with 3D modeling 
applications, such as Shade, and that you are able to use such an 
application to edit geometries and save files in the Wavefront OBJ 
format. 

To Prepare the Morph Target OBJ File:

Using your favorite 3D modeling application, open or generate 10.	
a male human head mesh object.

Add a morph target to the tip of the nose.11.	

Open the 12.	 Poser > Runtime > Geometries directory, and 
create a folder called “TutorialMorph”.

Save the morph target file as an OBJ file, to the 13.	 Poser > 
Runtime > Geometries > TutorialMorph folder, and 
name it “nosemorph.obj”.
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  In order to work as a morph target in Poser, the OBJ file 
you save must have the same vertex count and order as the 
geometry to which the morph target is supposed to be applied.

To add a Morph Target in Poser:

Launch Poser.14.	

Display the 15.	 Library palette, by clicking the handle on the right 
side of the screen. 

Figure 24.4: The Library Palette.

Click the 16.	 Figures category button.

Click the Poser 1-4 sub-category pop-up and choose Poser 2 17.	
Hi.
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Figure 24.5. The Poser 2 Hi sub-category.

Double-click the Casual Man P2 preview. 18.	

The figure appears in the 19.	 Document window. 

Figure 24.6: The Casual Man in the Document window.

Close the 20.	 Library palette.

Click the 21.	 Face Camera icon in the Camera controls.

Figure 24.7: The Face Camera icon.

Select the Head, and choose22.	  Object menu > Properties.
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The 23.	 Properties palette appears. 

Click the 24.	 Load Morph Target button. 

The 25.	 Load Morph Target dialog appears. 

Figure 24.8: The face of the figure.

Click on the 26.	 Browse (“...”) button.

Select the file 27.	 Poser > Runtime > Geometries > 
TutorialMorph > nosemorph.obj.

Click Open.28.	

Change the 29.	 Label field to Nose. This assigns the name “Nose” 
to the new parameter dial.

Click OK to return to the 30.	 Properties palette, and click on the 
Parameters tab to switch to the Parameters palette.

Use the rotation trackball to rotate the view slightly to the left 31.	
or right.

Figure 24.9: A rotated view of the figure.

Click the 32.	 Current Actor pop-up menu in the Document 
window.

Select the Head.33.	

You can now use the Nose dial to morph the Nose. Drag it to 34.	
the right towards 1.0 for an interesting effect.
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Figure 24.10: The Nose after morphing.

Figure Joints and Blend Zones
The joints on a figure control how parts bend, blend, twist, and 
bulge. Realistic movement in a figure is controlled by joint settings. 
For example, a human knee joint can’t bend forward. 

Figure 24.11: An example of figure joints.

The bending and twisting motion in a figure is created by using 
transformers. Transformers stretch, skew, or scale polygons in the 
transformation zones to produce desired joint motion. 

The transformation zone is defined by the inclusion and exclusion 
angles that are assigned to each transformation. Polygons within 
the exclusion angle are not affected by a transformation. Polygons 
within the inclusion angle are affected. Polygons in the area 
between the angles, called the Blend zone, are adjusted to 
create a smooth transition between the surrounding polygons. 
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Figure 24.12: An example of blend zones.

Joints are controlled using the Joint Editor. Blend zones are edited 
each time you adjust the transformation inclusion and exclusion 
angles. Blend zones can be further refined using the Spherical 
Falloff zones.

Editing Joint Parameters
The Joint Editor lets you control both joints and blend zones. It 
lets you directly manipulate joints and blending transformers to set 
how a joint works. These advanced settings can be used in different 
ways:

Fine tune the bending of existing figures to suit your needs•	

Create new types of effects, such as imitating the comic •	
character ‘Plastic Man’

Customize joints and transformers for entirely new figures, •	
imported with the Convert Hier File command. Refer to 
“Creating Figure Models” on page 336 for more information 
about how to create your own Poser figures. 

Figure 24.13: The Joint Editor.
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Before making any changes with the Joint Parameters, 
be sure to turn all IK Chains off. It is also easier to see some 
attributes, such as the center, if you view them in outline or 
wireframe display mode. If your computer is fast enough, use 
Full Tracking to see the results of your changes in real-time.

Each joint on the figure has a set of attributes, like Bend, Twist or 
Side-to-side. The attributes available for editing depend upon which 
joint is selected. Editable attributes are displayed in the pop-up at 
the top of the palette. 

To edit a joint’s parameters, you first select a joint attribute and 
then set each of its parameters. Each attribute has a specific set 
of parameters that control how the attribute affects the joint. For 
example, the parameters for the Center attribute let you control the 
exact position of the center point. 

To display the Joint Editor:

Choose •	 Windows menu > Joint Editor. 
The controls available on the 35.	 Joint Editor palette depend on 
the currently selected body part or prop. 

To edit a joint parameter:

Select a body part. 36.	

Display the 37.	 Joint Editor. 

Click the popup at the top of the palette and choose an 38.	
attribute. 

Set the attribute’s parameters. 39.	

Using the Joint Editor
The Joint Editor contains several controls you can use to set 
attributes for a joint. These controls change as you select different 
body parts. However, here are a few controls that are common to 
all:

Display Deformer: Toggles the graphical display of the joint on 
the figure.

Spherical Falloff Zones: Toggles on or off the Spherical Falloff 
Zones on the figure. Refer to Spherical Falloff Zones for more on 
falloff zones. The Spherical Falloff Zones control appears on all 
attributes except the Center attribute.

Zero Figure: Resets to 0 the rotation (Bend, Twist, Side-Side, 
Front-Back) for all body parts.

Joint Order: Defines the joint’s axes of rotation. The joint order is 
expressed as three letters corresponding to the X, Y and Z axes.

Using the front camera position, the X axis runs from 
left to right, the Y axis runs up and down, and the Z axis runs 
from the front to the back.
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Curve Radio Button: Specifies the use of curve bends as opposed 
to the standard twist/joint/joint bends. When you set up a joint 
using curves, the joint will have one twist and one curve primitive. 
The curve primitive will automatically bend the body part as if it 
were part of a curved chain of objects.

Interactively Editing Joint Parameters
When you select a joint attribute in the Joint Editor, a graphical 
representation of the parameter appears on the figure. For example, 
when you select the Twist attribute for the leg, a red and green line 
appears on the leg.

Center.

The center of a body part becomes the outline of the selected target 
when you can edit it.

Twist

When you select the Twist attribute, a line with two handles 
appears on the figure. The red handle represents the starting point 
of the twist transformation area. The green handle represents the 
end. Dragging these handles increases or decreases the Twist area.

Figure 24.14: A Twist attribute displayed graphically on the figure

Editing Inclusion and Exclusion angles

When using Bend or Side to Side/Front to Back, the red line 
represents the exclusion angle, while the green lines represent the 
inclusion angle. 

Any polygons within the exclusion angle are not affected by a 
transformation. Polygons within the inclusion angle are affected by 
the transformation. The area between the inclusion and exclusion 
angles is called the Blend zone. 

You can edit theses angle by dragging their points directly on the 
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figure. As you drag an angle, the figure updates to show the effects 
of your change. When the cursor is over an end-point, it appears 
as a target. 

Inclusion and exclusion angles exist in three dimensions, so you can 
rotate the figure to see all the areas affected by the transformation. 
You can also edit the angles in all three dimensions. 

If you want to make sure you’re moving an angle in only one 
dimension, use the orthogonal cameras (From Top, From Front, 
From Left, etc.). For example, if you use the From Front camera, 
moving left and right moves in x. Moving up and down moves in y. 
In the From Left view, left and right move in z, and up and down 
move in y.

Bend

You can adjust the Bend transformation area by dragging the end-
points of the red or green angle. To change the center of the body 
part, drag the center point target. 

Side-Side/Front-Back.

Both the Side-Side and Front-Back attributes can be edited like the 
Bend attribute, by dragging the inclusion and exclusion angle lines.

Joint Attributes.
Each joint on a body part has a number of parameters that 
together control how the joint moves. 

Center

The Center Attribute sets the center of rotation for a selected body 
part. This attribute is available for all body parts and props. 
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Figure 24.15: The Center attribute in the Joint Editor.

The Center attribute has the following parameters:

Center Point: Sets the XYZ position of the center of the body part. 
0,0,0 is located in the center of the body on the floor.

End Point: Sets the endpoint for a joint with multiple children, or 

no child joint.

Orientation: Sets the XYZ rotation of the axis. Click and drag on 
these dials to rotate the axis. You can alt-click on the dials to reset 
them to 0.

Align: Aligns the axis to the rotation of the body part.

Twist	

The Twist attribute alters the location of the twist transformer for 
each body part. The intensity of the transformation is controlled 
using the Twist parameter dial or Twist tool.
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Figure 24.16: The Twist Attribute in the Joint Editor.

Note that there is not a Twist attribute for the hip, since the hip 
is the parent of the entire figure. Twisting the parent is the same 
as rotating the entire figure. When IK is enabled, twisting the hip 
transforms body parts included in the IK chains. 

By default, the Twist axis runs lengthwise down the center of each 
body part. For example, for arms the twist axis is the x-axis, while 
for legs the twist axis is the y-axis. Moving and rotating the center 
of a body part can alter the position of this axis.

Figure 24.17: The Twist axes on the body.

The Twist attribute has the following parameters:

Twist Start, End: Sets the start and end of a twist area on a body 
part. Only the parts of the figure within the twist area are affected 
by the twist transformation. 

Twist areas can be set to larger than the body part to make a 
twisting motion appear more natural. In most cases, you want to 
include the body part’s parent. 

Bend

The parameters for the Bend attribute alter the angles of the bend 
transformers and define how bulges are created.



Poser 8
Tutorial Manual 

266

Chapter 24: Advanced Body Shaping

Figure 24.18: The Bend attribute in the Joint Editor.

The Bend attribute has the following parameters:

Center Point: Sets the XYZ position of the center of the body part. 
Bending occurs at the center point. Changing that point changes 

the center of the body part. 

Joint Angles: These parameters set inclusion and exclusion 
angles for the Bending transformation. The values in Static A and 
D together set the exclusion angle. Polygons within the exclusion 
angle are not affected by the bending. The values in Dynamic B and 
C together set the area of inclusion. Polygons within the inclusion 
angle are affected by the bending. 

Figure 24.19: The angles of inclusion and exclusion on a body part.

Bulge Settings: When enabled, these parameters control how 
polygons within the bend zone are stretched or pinched to create 
bulges or wrinkles. 

The Apply Bulges checkbox specifies whether or not the bulges 
defined by the parameter dials will be applied to the polygons in 
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the current blend zone. Use the parameter dials to control the 
bulges. Right and left dials refer to the sides of the figure. The 
positive dials control how much bulging out will occur when the 
joint moves, and the negative dials control the amount of wrinkling 
and pinching. You can alt-click these dials to reset them to 0. 

Figure 24.20: Differences in bulges and wrinkles, when the body part center is 

changed.

Side-Side/Front-Back

The parameters for the Side-Side/Front-Back attributes control 
angles of the Side-Side/Front-Back transformers and define how 
bulges are created.
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Figure 24.21: The Side-Side attribute in the Joint Editor Figure 24.22 The Front-Back attribute in the Joint Editor.

The Side-Side/Front-Back attributes have the following parameters:

Center Point: Sets the XYZ position of the center of the body part. 
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Side-Side transformations occurs at the center point. 

Joint Angles: These parameters set inclusion and exclusion angles 
for the Side-Side transformation.

Bulge Settings: When enabled, these parameters control how 
polygons within the Side-Side transformation zone are stretched or 
pinched to create bulges or wrinkles.

Scaling

Each body part has parameters that let you scale the parent and 
child body parts. The settings are similar to the Twist parameters, 
and follow the Twist axis of the child or parent body part. 

For example, the Right Collar body part of the Business Man has 
scaling controls for the chest (the parent body part) along the 
y-axis, and scaling controls for the Right Shoulder (the child body 
part) along the x-axis.

Figure 24.23:  Scaling attribute displayed in the Joint Editor.

High Start/End, Low Start/End: The High and Low parameters 
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define a blending area. For example, when scaling the head, you 
might also want the top of the neck to scale as well. 

When setting this parameter, only one pair of settings—the high 
or the low setting—is relevant. The unused parameter pair is 
automatically set to an out-of-limit number (such as 100.000 or 
99.000). This indicates that the pair is not relevant to the area you 
have selected for blending. The out-of-limit settings should not be 
edited. 

Figure 24.24: The effects of High/Low scaling.

The end of each blending zone is represented in red, while the 
start is represented in green. The effects can be uniform, or can be 
controlled by spherical falloff zones. Refer to Spherical Falloff Zones 
for more information. 

Copying Joint Parameters

You can copy joint parameters from one half of the figure to the 
other using the Symmetry commands on the Figure menu. Hold 
down the Option/Alt key while using the Symmetry commands to 
include joint parameters.

Saving Joint Parameters

Changes to joint parameters effect only the current scene. If you 
want to save joint parameter changes, you need to either save your 
scene, or save the figure as a new preset in the Library palette. The 
new figure has new joint parameter settings. Refer to the Poser 
Reference Manual, Chapter 7: The Poser Library on page 88 for 
more about saving figures to the Library palette. 

Spherical Falloff Zones
Spherical Falloff Zones are an advanced method for controlling the 
blending between body parts. Two spheres, a green ‘inner’ sphere 
and a red ‘outer’ sphere represent the falloff zones. 

Figure 24.25: Spherical Falloff Zones.

The green sphere defines the area that is affected 100% by the 
transformation. The red sphere represents the boundary of the 
transformer’s effect. The area between the inner and outer sphere 
is the ‘blending’ zone. The effects of the transformation gradually 
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decrease from 100% at the boundary of the inner sphere to 0% at 
the boundary of the outer sphere.

When adding Spherical Falloff Zones, the default position of the 
sphere is 0,0,0.

Displaying Spherical Falloff Zones

Spherical Falloff Zones can be selected and displayed using any 
display mode. Choose Display menu > Element style to select 
the desired display mode. The default display mode for these 
spheres is outline.

Wireframe mode lets you view the spheres in 3D and still see the 
body parts they surround.

Figure 24.26: A Spherical Falloff Zone viewed in Wireframe mode.

Editing Spherical Falloff Zones

Spherical Falloffs can be edited using any of the Editing tools. You 
can reposition, scale, rotate or twist Spherical Falloff zones.
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Chapter 25: Basic Figure 
Creation
This section provides two examples of creating Poser figures 
from imported props (geometries). Tutorial files are located in the 
Tutorials folder with your Poser installation.

Example One: Wormy
Wormy is a happy little inchworm that also happens to be a great 
example of how you can rapidly create a simple figure using the 
Setup room.

Figure 25.1.

Begin by launching Poser and importing the file 1.	 wormy.

obj from the Tutorials folder accompanying your Poser 
installation. Do this by selecting File > Import > Wavefront 
OBJ and navigating to the folder on your system. Set both 
Full Tracking and the Texture Shaded document display 
style. Do this by choosing Full Tracking from the Tracking 
Mode menu at the bottom of the Preview tab, followed by 
clicking the right-most button in the Display controls.

Enter the 2.	 Setup room by clicking the Setup room tab.

Set a side camera, such as 3.	 Right, by clicking the words Main 
Camera in the Document window and selecting From 
Right. Next, select the Bone tool (3rd from the right in the 
Editing tools). Starting near the bottom, create the first (hip) 
bone going up Wormy’s body. This hip bone is the parent 
for the entire figure. Next, create three additional bones for 
the Abdomen, Chest, and Head. Please refer to the Poser 
Reference Manual, Chapter 29: Figure and Prop Editors on 
page 486 for more information about the Setup room.
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Figure 25.2.

Click the hip joint (base of the bottommost bone), and 4.	
create two more bones going down Wormy’s tail as follows. 
Remember that the tailbones are children of the hip bone (see 
“Hierarchy” on page 13 for an explanation of hierarchical 
relationships).

Select the 5.	 Group tool (just to the left of the Bone tool in 
the Editing tools), then click the Auto Group button in 
the Group Editor palette to create groups of polygons and 
attach them to the bone structure you created. Click the Next 
Group button several times to see the groups that have been 
created. You can modify these groups as discussed in the 
Poser Reference Manual, Chapter 5: The Document Window 
on page 60. Close the Group Editor palette and exit to the 
Pose room. Try posing Wormy using the Translate tool (third 
Editing tool from the left): 

Figure 25.3.

You will probably notice that there is a problem with the joints 
when you try to move the tail: Wormy’s waist deforms incorrectly. 
Correct this by opening the Joint Editor palette, selecting the 
upper tail joint, and making the following adjustments (see the 
Poser Reference Manual, The Joint Editor on page 499 for more 
information about the Joint Editor palette):

Rotation Order�� : Select ZYX as the rotation order.

X-Rotation�� : Select the X-Rotate parameter and position 
the inclusion/exclusion angles as shown:

Close the 6.	 Joint Editor palette and try moving Wormy’s tail. 
The tail now bulges as if muscles were flexing, creating a far 
more natural appearance. You can, of course, create any effect 
you desire by tweaking the joints.
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Figure 25.4

Congratulations! In just a couple of minutes, you have transformed 
Wormy from a static prop into a fully poseable Poser figure! 

Example Two: Goldy the Robot
Wormy used a simple bone structure built from scratch. Goldy the 
Robot was originally created by assembling Poser props from the 
Props category within the Library palette. For this example, she 
will use a skeleton belonging to an existing library figure and be 
adjusted as necessary.

Begin by launching Poser and importing the file 7.	 goldy.
obj from the Tutorials folder accompanying your Poser 
installation.

Set both 8.	 Full Tracking and the Texture Shaded document 

display style, and enter the Setup room.

Select the 9.	 Front camera. Goldy should now appear as follows:

Figure 25.5.

Open the 10.	 Figures library and select Figures > Poser 2 Lo 
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> Default Guy. Click the Change Figure button to load the 
skeleton. If you prefer, you can also begin at the hip and create 
a skeleton from scratch, just as you did with Wormy:

Select the 11.	 Translate tool and position the bones on your left 
(Goldy’s right) side and center (Outline display style shown 
for maximum contrast).

Figure 25.6.

Select 12.	 Figure > Symmetry > Right to Left. Click Yes when 
prompted to copy joint zone setups. Goldy’s skeleton should 
now look something like this:

Figure 25.7.

Goldy’s bones are now aligned side to side. Select a side 13.	
camera (or multiple pane view, as described in the Poser 
Reference Manual, Single/Multiple-View Panes on page 68) 
and adjust the front-to-back alignment. As in the previous 
step, you can use symmetry to save time. When you are 
finished, select the Main camera and fly around Goldy to 
make sure that the skeleton is correctly placed.
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Figure 25.8.

At this point, you could use the 14.	 Auto Group tool. However, 
Goldy’s hoop will not work properly, since the Grouping tool 
will assign its polygons to the hips and abdomen, causing 
the hoop to distort or break as Goldy moves. To prevent this, 
select a side view, select the abdomen bone, and draw a new 
bone protruding from Goldy’s center to the hoop.

The 15.	 Auto Group tool will assign some of the hoop polygons 
to the bone you created, and others to the hip, thighs, etc. 
Simply select the group corresponding to the bone you created 
in the previous step, and add the rest of the hoop polygons to 
the group to make the hoop move properly.

Figure 25.9.

Check all of the groups to ensure that the correct polygons 16.	
are assigned to each group. Make any necessary adjustments. 
When you are finished, exit the Setup room and try posing 
Goldy.

Figure 25.10.
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Not too bad for a few minutes’ work. Still, to make Goldy 17.	
move like a robot instead of an organic figure, you will need 
to adjust the joint parameters. You may also need to adjust 
the bones and/or turn off body part bending by selecting body 
parts and/or disabling bending in the Properties palette. 
The Poser scene Goldy_Raw.pz3 in your Poser Installation’s 
Tutorials folder shows Goldy just after leaving the Setup 
room. Goldy_Adjusted.pz3 in the same folder shows Goldy 
after her joint parameters and bones have been adjusted. 
Notice how she now moves like the robot she is. Load this file, 
select each joint, and note its parameters. Try using the Walk 
Designer (see the Poser Reference Manual, Using the Walk 
Designer on page 335) and playing the resulting animation.

The final step is to make Goldy gold. To do this, enter the 18.	
Material room and make the Diffuse_Color, Ambient_
Color, and Reflective_Color attributes gold as described 
in the Poser Reference Manual, Chapter 15: Material Room 
Nodes on page 231. Render the scene to see Goldy in all her 
glory!

Figure 25.11.
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Chapter 26: Advanced Figure 
Creation
A figure in Poser is basically a 3D model that has separate parts 
for each moving limb. What makes a Poser model unique is how 
it interacts with the controls in Poser. When a 3D model is within 
Poser, it has joints that move realistically. It seems to move like a 
real person. 

How Do You Make a New 
Figure?
Poser created the ability to mirror real body movement by 
adding joint parameters to each body part. This allows you to 
then manipulate the figure based on those parameters. By using 
parameter dials and the Walk Designer you can create realistic 
motion. 

To create your own Poser figures, you must set up your model in a 
way that Poser can understand. Once that is done, you can move 
or pose your model, just as you would any of the models that are 
included with Poser. 

This chapter describes how to create articulated bending figures in 
Poser. The Tutorial starting with Creating the Initial Figure leads you 

thorough the entire process step-by-step. 

Figure creation is a multi-step process:

Create a 3D model of the new figure.•	

Create a hierarchy file for the figure.•	

Convert the hierarchy file.•	

Locate and use the new figure file in Poser.•	

Verify the figure’s hierarchy.•	

Adjust the joint parameters of each body part.•	

Set limits.•	

Set favored IK angles.•	

Store the default position.•	

Set the surface materials for the figure. •	

Add morph targets to individual body parts.•	

Set part names•	

Save the new figure to the Library palette.•	
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Creating Figure Models
Almost any geometry that is made up of polygons and has 
individual parts can be used as a figure in Poser. What your model 
looks like makes no difference to how it works in Poser. It doesn’t 
even have to look human, it just needs to be set up properly and 
stored in the correct format.

Once those two criteria are satisfied you can make anything into a 
Poser figure. With the right set up, you can make anything from an 
accordion to a zebra into a poseable figure. 

Model Format
In order to use geometry as a figure in Poser, it must be stored in 
a Wavefront (.obj) compatible format. As well, you must use only 
polygons to create your model. Nurbs or spline surfaces are not 
suitable.

Grouping
Poser uses a group name as the internal name of a body part 
inside Poser. Some Poser features, like the Walk Designer, require 
specifically named body parts. The group name is also the default 
name that you see when working with this body part (you can 
change that at a later time).

It’s important that groups are set up to denote the individual 
moving sections. You can store body parts as individual OBJ files or 
save the entire figure as a single file. In either method, you need 
to carefully plan how you choose to separate the polygons into 
individual moving parts. 

You do not need to move these parts to the origin individually. 
You should leave them where they naturally relate to one another. 
Local origins are set up later inside Poser.

When you store each body in a separate wavefront OBJ file you 
need have only one specified group in each file. That group contains 
all the polygons in that file.

When you store the entire body in one Wavefront OBJ, you must 
use “groups” to separate different parts of the body that represent 
the moving hierarchy. Saving the entire body in one Wavefront OBJ 
file is usually the preferred method. 

It is very important that groups do not overlap. Wavefront 
grouping allows polygons to be in more than one group. If this 
happens, the overlapping polygons are duplicated when you bring 
the file into Poser, each group being turned into a separate Poser 
body part.

For example, if you build a human-like object, you want to separate 
the polygons of the model into the following groups:

rHand
lHand
head
neck
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lCollar
rCollar
chest
abdomen
hip
rThigh
lThigh
rShin
lShin
rFoot
lFoot
rShldr
lShldr
rForeArm
lForeArm

In order to use the figure in the Walk Designer you’ll have to 
make sure that the above groups are used in the figure. 

Before creating a hierarchy file, import your OBJ file as a prop •	
to check that the geometry is imported correctly.

Naming Groups

In a Poser figure file, there are actually two names applied to each 
body part. One name is used internally, the other is what the you 
see. It is important that certain body parts use standard internal 
names in order to be available for specific Poser features. The user 
name (specified by the “name” line of actors) can be anything you 
wish.

The following body part names (therefore Wavefront group names) 
should be used when available:

“rHand” -- for the body part that represents the base palm of •	
the right hand

“lHand” -- for the body part that represents the base palm of •	
the left hand.

In order for the hand Library features to work completely, the 
fingers of the hand should be broken up using the following names 
(working from root to tip):

rHand
rThumb1 rThumb2 rThumb3
rIndex1 rIndex2 rIndex3
rMid1 rMid2 rMid3
rRing1 rRing2 rRing3
rPinky1 rPinky2 rPinky3
lHand
lThumb1 lThumb2 lThumb3
lIndex1 lIndex2 lIndex3
lMid1 lMid2 lMid3
lRing1 lRing2 lRing3
lPinky1 lPinky2 lPinky3

Figure 26.1: The hierarchy applied to the figure.
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Arranging Groups on the Model

When Poser processes a new model’s geometry and generates a 
Poser Figures library entry, it automatically adds bending joints 
between parent and child objects as specified in the hierarchy file. 

Joints only bend polygons of the objects that are contained in the 
parent or child body part at any given joint. So, all polygons that 
are physically located at a seam must be contained in either the 
parent object group or the child object group. In other words, don’t 
have three groups joining at the same place. 

A good rule of thumb to use when creating groups is that if two 
objects don’t have a parent child relationship, then they shouldn’t 
be touching each other. It’s important to make sure that groups 
are set up with this in mind, otherwise gaps appear when you start 
bending the model in Poser.

The following example shows the connection of the abdomen, hip, 
and upper leg of a horse. Since the abdomen is a child of the hip 
and the upper leg is also a child of the hip, there is no parental 
attachment between the abdomen and the upper leg. Therefore 
there can be no physical attachment between the abdomen and the 
upper leg:

Figure 26.2: Two incorrect ways, and then the correct way, to connect groups on 

the horse.

Creating Hierarchy Files
The Hierarchy file describes how the groups in a figure are 
arranged. It outlines the parent-child relationships between groups. 
Once created it can be imported into Poser where it is converted to 
create a new figure file in the New Figures library.

 The hierarchy file specifies four important things:

The geometry (.obj) file to use.•	

The hierarchical connections (parent-child relationships) of the •	
body parts.

The desired rotation order of each body part.•	

A specification of each Inverse Kinematics chain to be included •	
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in the figure.

Hierarchy files can be created in any text editor that can save 
documents in a text-only format.

The following is an example hierarchy file: It represents the full 
hierarchy for a horse -- including curve channels for the tails.

objFile:Runtime:Geometries:horseHi:horseHiP3.obj
1 hip zxy  

	 2 abdomen zyx 
		  3 chest zyx 
			   4 lShldr yzx 
				    5 lUpArm yzx 
					     6 lForeArm yzx 
						      7 lWrist yzx 
							       8 lHand yxz 
			   4 rShldr yzx 
				    5 rUpArm yzx 
					     6 rForeArm yzx 
						      7 rWrist yzx 
							       8 rHand yxz 
			   4 lowNeck zyx 
				    5 upNeck zyx 
					     6 head yzx 
	 2	 lThigh yzx 
		  3 lLeg yzx 
			   4 lShin yzx 
				    5 lAnkle yzx 
					     6 lFoot yxz 
	 2 rThigh yzx 
		  3 rLeg yzx 
			   4 rShin yzx 
				    5 rAnkle yzx 
					     6 rFoot yxz 
	 2 tail1 zyx curve 

		  3 tail2 zyx curve 
			   4 tail3 zyx curve 
				    5 tail4 zyx curve

ikChain	LeftLeg lThigh lLeg lShin lAnkle 
ikChain	 RightLeg rThigh rLeg rShin rAnkle 
ikChain	 LeftHand lShldr lUpArm lForeArm lWrist lHand  
ikChain	 RightHand rShldr rUpArm rForeArm rWrist rHand 

There are more samples in the Tutorials > Figure Creation 
folder that is included with your Poser installation.

Hierarchy File Explained
The following section explains the various parts of the Hierarchy 
file. 

Hierarchy File Header

The first line of the hierarchy file contains the “OBJ File” command 
which specifies the location of the OBJ file associated with the new 
figure. 

	 objFile:Runtime:Geometries:horseHi:horseTex.obj

The file location should be defined using a Macintosh format file 
specification (i.e using colons). The file location is specified relative 
to the Poser application folder. 

When the hierarchy file is converted, the text of the OBJ file is read 
into Poser where a geometry resource is created and linked to the 
OBJ file. This process results in a new figure file. 
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From then on, when Poser uses this figure file, the geometry 
resource is used to defined the figure hierarchy relationships rather 
than the text stored in the OBJ file. Reading from the geometry 
resource is dramatically faster.

Hierarchy File Body

The bulk of the hierarchy file contains lines similar to the one 
shown below:

Figure 26.3: A typical Hierarchy file line.

The first part of the line indicates Hierarchy level, or the parent-child 
relationship, of the body part. In this case, the abdomen body part 
is a child of the body part of the part on the next level up. Hierarchy 
levels are numbered in depending order, so the next level up from 
this part is 1. 

In the example below, the lShin object is located on the 3rd level of 
the hierarchy. The closest level 2 line above would be the lThigh, so 
the lShin is a child of the lThigh.

Figure 26.4: Parent-Child relationships indicated in the Hierarchy file.

The indenting of the lines is not processed but is helpful visually to 
denote the hierarchy levels.

The second part of the line specifies the name of the body part. In 
the example the part is called abdomen. This name must match the 
group name in the OBJ file. 

Figure 26.5: The body part name in a Hierarchy file line.

The 3-character string at the end of the line represents the rotation 
(or gimbal) order of the body part. A rotation order defined as “zxy” 
means that a Z axis rotation occurs first, followed by the X, then Y 
axis rotations.

Figure 26.6: The rotation order in a Hierarchy file line.
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Poser uses the following XY and Z axis orientations: 

Figure 26.7: The X, Y, and Z planes that make up 3D space.

Assigning a rotation order is a three step process:

Always place the “twist” axis first. This axis should be placed •	
lengthwise through the object. If the object, like a leg, is built 
down the Y-axis, specify the Y first since that is the axis along 
which the leg would twist.

Of the two remaining rotations, place the one most likely •	
to become 90 degrees last. This helps reduce rotation lock 
problems that occur when the middle rotation approaches 90 
degrees.

Place the remaining rotation channel second.•	

Some objects are built non-aligned to the major axes. In this •	
case, you are able to “align” the coordinate system of the 
body part later, while adjusting the joint parameters. For the 
hierarchy file, pick the rotation order that seems closest to 

what would be desired. When you align the part later, the 
twist axis you choose becomes aligned down the length of the 
body part.

Linking Body Parts Stored in Separate OBJ 
Files

If each body part were stored in a separate file, rather than all body 
parts being groups in a single file, you would specify the full path 
name for the file at the end of each line. This path is relative to the 
Poser folder. 

Here is an example of three links using this method:
1 link1 yzx:Runtime:Geometries:examples:l1.obj  

	 2 link2 yzx:Runtime:Geometries:examples:l2.obj  
		  3 link3 yzx:Runtime:Geometries:examples:l3.
obj 

Using Curved Transformations

The Curved flag tells Poser that this link should use curve 
transformations. This is a method of bending designed for the tails 
of the animal figures in Poser. Here is an example used in the Horse 
figure:

	 2 tail1 zyx curve  
		  3 tail2 zyx curve  
			   4 tail3 zyx curve  
				    5 tail4 zyx curve 
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Inverse Kinematic Chains

The last commands in the hierarchy file specify the links that 
compose the individual inverse kinematic chains. Inverse Kinematic 
chains are defined in the following format:

	 ikChain chainName firstLink nextLink nextLink... 
endGoal

In the example above the ikChain is defines as follows:

Figure 26.8: An ikChain line in a Hierarchy file.

The name of an ikChain cannot contain spaces.

Converting Hierarchy Files
Once the Hierarchy file is completed in the text editor, you can 
import it into Poser by converting it into a geometry resource (called 
a CR2 file). 

This geometry resource is then used by Poser, in conjunction with 
OBJ 3D data to create a new figure file with rotation order, and 
Inverse Kinematic relationships as defined by the hierarchy text file. 

On Windows, the resource is a separate file ending is RSR. On a 
Macintosh, the resource is stored with the OBJ file. If you need to 
edit the resource on a Mac, use a resource editor to remove the text 

from the OBJ file, or create a new text file by copying and pasting 
from the old one.

If you make changes to the hierarchy file and then convert it 
again, the conversion won’t re-create the geometry resource if it 
already exists in the OBJ file. So, if you are trying to make geometry 
changes, you need to either delete the resource, or start with a new 
blank text file that contains only the text portion of the OBJ file. 

To convert a Hierarchy file:

Choose 1.	 File menu > Convert Hier File. The Open dialog 
appears. 

Locate the Hierarchy file you created in the text editor and 2.	
click Open.

If there are no errors, a Poser Figure library file is created.3.	

The hierarchy conversion may take several minutes if there is a 4.	
large geometry file.

The figure file that gets created references the geometry file 5.	
whenever used. Its location should be established and not 
moved later or the figure file cannot find the geometry.

If the location is changed you need to edit the figure file with 6.	
a text editor to designate the new location (specified relative 
to the Poser application in Mac format).
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Verifying Hierarchy Files
Once you begin adjusting the joints you are not able to regenerate 
the figure file a second time and have all your joint changes in 
place. Make sure that all Parent-Child relationships are correct 
before editing joint parameters. You can make geometry corrections 
later, but you cannot change the hierarchy without creating 
different joints from scratch again.

Setting Up a Standard Figure
Poser provides the following methods to aid you in creating 
standard figures.

Applying the Standard Hierarchy
If a figure’s geometry was created using standard body group 
names for human/biped figures, you can use the Hierarchy Editor 
to automatically apply the Poser Standard Hierarchy to your 
figure, establishing parent-child relationships. Poser 7 can apply 
the Standard Hierarchy to full or partial figures. Refer to Naming 
Groups for more about creating figures with standard body group 
names.

To apply the Poser Standard Hierarchy to a 
figure:

Choose 1.	 Window > Hierarchy Editor.

Select the 2.	 Universe.

Click the Apply Standard Hierarchy button.3.	

Figure 26.9: The Apply Standard Hierarchy button.

The Apply Standard Hierarchy button is not available 
unless the universe is selected.

Applying the Standard Rotation 
Order
If the props for human/biped figures use standard body part names, 
Poser can automatically apply the standard rotation settings for 
each prop.
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To apply standard rotation to a figure:

Choose 1.	 Window > Hierarchy Editor to display the 
Hierarchy Editor.

Select the 2.	 Universe.

Click the 3.	 Apply Std Rotation Order button to apply the 
standard rotation settings.

Adjusting Joint Parameters
When the Hierarchy file was converted into a new figure file, Poser 
automatically added joints between all the parent and child objects 
in the figure. These joints may not work as expected as they use the 
default joint settings 

Before you can pose your figure, you need to adjust each body 
part’s joint parameters. The Joint Editor lets you select each joint, 
twist, smooth scale, and center parameter and adjust them for 
optimal bending. 

Figure 26.10: The Joint Editor.

Refer to Adjusting Joint Parameters for detailed instructions on 
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adjusting joint parameters. 

It’s highly recommended that you work from the outside of the 
figure in, making a first pass through to make sure all origins are 
located as desired. If you move the origin point (center of rotations) 
of a body part later, it carries along the other joint changes so the 
bending characteristics change. You’ll save yourself from doing 
extra work if you specify the origins (centers) first.

Remember, you can save your figure to a new Figure 
preset at any time. You should do this periodically as you work 
so you can back up if you make mistakes.

Keep the IK chains turned off until all adjustments are completed. 
You can use the Zero Figure button to quickly set all rotations to 
zero while working.

Setting Limits
Limits establish a range of rotation, position and scale for a given 
body part. Limits can be set for each body part on the figure. 
However the most commonly used, and the most logical, limits 
are Bend, Twist, Side-Side and Front-Back. For these parameters, 
limits are expressed as degrees. In this case, the limits define the 
maximum and minimum degrees of rotation. 

Limits are set by using the Edit Parameter Dial dialog. 

Figure 26.11: The Edit Parameter Dial dialog.

To set limits for a body part:

Double-click the parameter dial for which you want to set 1.	
limits. The Edit Parameter Dial dialog appears. 

Enter maximum value of the parameter in the 2.	 Max Limit 
field. 

Enter the minimum value of the parameter in the 3.	 Min Limit 
field and click OK.

  Remember, you can save your figure as a new figure in 
the Figures library at any time. You should do this periodically 
as you work so you can back up if you make mistakes.
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Setting Favored IK Angles
The Inverse Kinematics in Poser works from the current rotations 
of a body part, therefore proper IK angles need to be preset in the 
figure for it to work predictably. 

As such, the original rotation values loaded on the joint are 
important to help the IK system know which way to bend some 
joints. 

Before you memorize the default position of all the body parts, you 
should bend the ones that are used in IK chains so that they favor 
their natural bending directions. For example, a human thigh is bent 
slightly forward and out. The shin is bent slightly back and in.

Do this while keeping all the IK chains turned off. Only turn them on 
after you have set the favored angles.

Figure 26.12: Favored IK positions.

Memorizing Default Positions
When you memorize the settings on the figure you’re setting the 
default values and positions for all the figure’s joints and body 
parts. The next time you use this figure, the memorized setting are 
used. 

To memorize the figure’s settings:

Choose •	 Edit menu > Memorize > Figure. 

Setting Surface Materials
Please refer to the Poser Reference Manual, Chapter 13: The 
Material Room on page 203 for more information about applying 
surface materials to your objects and figures.

Adding Morph Targets
If you have created Wavefront format OBJ files that have the 
identical vertex ordering as any individual body part, you can load 
them as morph targets. 

Refer to “Setting Up Morph Targets” on page 308 for more on 
setting Morph Targets. 
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Setting Body Part Names
The names of the groups you set up in the OBJ file and Hierarchy 
file may not be the most descriptive names you can use. Once the 
main parameters are set for the figure, you can change the name of 
each body part. 

To change the name of a body part:

Double-click a body part. The 1.	 Properties palette for that 
body part appears. 

Enter a new name in the 2.	 Name field. 

Saving New Figures to the 
Library
After you’re finished setting joint parameters and body part names, 
you can save the final figure to the Figures category in the Libary 
palette where it can be recalled at any time. 

Refer to the Poser Reference Manual, Chapter 7: The Poser Library 
on page 88 for more information on saving figures to the Library 
palette.

Tutorial - Poser Figure Creation
In this tutorial, a 3D polygon mesh object is converted into a 
Poser figure. We assume that you are familiar with 3D modeling 
applications, such as Shade, and have the ability to generate or 
modify 3D mesh objects.

Creating the Initial Figure

To create the initial figure:

Using your favorite 3D modeling application, open or generate 1.	
a female human figure mesh object.

Name the body part groups in a manner consistent with 2.	
Poser’s body part naming format. See “Grouping” on 
page 336 for more information on naming groups.

Verify that none of the groups in this mesh object are 3.	
overlapping, and that each polygon is assigned to a group.

Open the 4.	 Poser > Runtime > Geometries directory, and 
create a new folder called “TutorialWoman”.

Save the file as a Wavefront OBJ file, to the 5.	 Poser > Runtime 
> Geometries > TutorialWoman folder.

  Subsequent parts of this tutorial use the file name 
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“womanfinal.obj” when referring to the OBJ file you have been 
asked to create. If you choose to call your file something else, 
then remember to replace any references to “womanfinal.obj” 
with your personal file name.

Checking Geometry Imports

Importing this object as a prop into Poser allows you to check the 
import of the geometry for errors. 

This part of the tutorial illustrates potential problems you may have 
in your models, and how you might fix them.

To use Poser to check for geometry errors:

Open Poser. 1.	

You may need to close your 3D modeling application first in 2.	
order to have enough memory.

Click and drag on the 3.	 Translate In/Out tool to move the 
figure away from the camera.

Select 4.	 File menu > Import > Wavefront OBJ.

Open the OBJ file you saved in the 5.	 Poser > Runtime > 
Geometries > TutorialWoman folder. Use the default 
import options.

Use the 6.	 Translate tool to drag the figure up.

Figure 26.13: Dragging the figure up.

Fixing Surface Normals

If you notice that some areas seem to have holes or appear 
inverted, this is because the surface normals are flipped. You can fix 
this in your 3D modeling application.

Creating the Hierarchy File

You must create a hierarchy file in order to import the figure back 
into Poser. See Creating Hierarchy Files for details on the syntax of 
the hierarchy file. 

To create the hierarchy file:

Create your hierarchy file to appear as follows:1.	
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objFile:Runtime:Geometries:TutorialWoman:womanfinal.obj
1 hip zxy 

	 2 abdomen yxz 
		  3 chest zyx 
			   4 neck yxz 
				    5 head yxz 
					     6 lEye yxz 
						      6 rEye yxz 
							       6 mouth yxz 
			   4 lShldr xzy 
				    5 lUpperarm xyz 
					     6 lForearm xyz 
						      7 lHand xyz 
			   4 rShldr xzy 
				    5 rUpperarm xyz 
					     6 rForearm xyz 
						      7 rHand xyz 
	 2 lPant yxz 
		  3 lThigh yxz 
			   4 lCalf yxz 
				    5 lFoot zxy 
	 2 rPant yxz 
		  3 rThigh yxz 
			   4 rCalf yxz 
				    5 rFoot yzx

ikChain lArm lShldr lUpperarm lForearm lHand 
ikChain rArm rShldr rUpperarm rForearm rHand 
ikChain lLeg lPant lThigh lCalf lFoot 
ikChain rLeg rPant rThigh rCalf rFoot

Save the hierarchy file into the 2.	 TutorialWoman folder and 
name it womanfinal.phi. 

To scale the new figure:

Open Poser1.	

Select 2.	 File menu > Convert Hierarchy File.

A new figure is created in a group called New Figures.3.	

Open the 4.	 Library palette and click on the Figures category.

Select the 5.	 New Figures subcategory.

Double-click the new figure (with the shrugging Poser figure 6.	
icon).

The figure is initially very large. Use the 7.	 Current Actor pop-
up menu to select the ‘Body’.

Double-click the scale parameter dial and change the value 8.	
to 4.2%.

To adjust body part color:

Select 1.	 Figure menu > Drop to Floor. 

Each body part is a different color. Use the color tool on the 2.	
body parts to better organize the figure.
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Figure 26.14: Body parts are different colors.

Use a similar color for the chest, abdomen, left shoulder and 3.	
right shoulder to form the shirt.

Use a similar color for the hip, left pant, and right pant to form 4.	
the shorts.

Use a similar color for each foot.5.	

Color the mouth red and each eye white.6.	

Use a skin tone for the remaining body parts. 7.	

Figure 26.15: After adjusting body part colors.

Select 8.	 Edit menu > Memorize > Figure.

Add the figure to the 9.	 Library, naming it Womanfinal.

Setting Joint Parameters

You now need to set the joint parameters for each body part. 
This tutorial gives you a general overview of how to begin setting 
your joint parameters. For more information, see Adjusting Joint 
Parameters. 

  Before adjusting joint parameters, always check that IK 
Chains for the figure are turned off.

Your first task is to set the center of rotation for all body parts. If 
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you change this later, it effects all other bending parameters for 
parent and child body parts. 

To set the hip center of rotation:

Switch to outline display mode.1.	

Open the Joint Editor.2.	

Click on Zero Figure.3.	

Start by selecting the hip. 4.	

Figure 26.16: Adjusting hip rotation.

Change the Center point x and z values to 0.0. 5.	

Set the y value to 0.9.6.	

Set the End Point y value to 0.8. The x and z value should be 7.	
0.0.

To set the centers of rotation for pant body 
parts:

Select the right pant body part. Look at the center of rotation.1.	

Select the right thigh body part.2.	

Drag the center of rotation up towards the edge between the 3.	
right pant and the hip. This gives the effect of the thigh and 
the pant leg moving together. 

Figure 26.17: Adjusting the right thigh body part.

Repeat this for the left thigh.4.	

To set the center of rotation for the abdomen:

Select the abdomen.1.	

Drag the center of rotation down, slightly into the hip. 2.	
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Figure 26.18: Adjusting the abdomen.

To set the center of rotation for the chest:

Select the chest.1.	

Drag the center of rotation up slightly, within the bottom of 2.	
the chest. 

Figure 26.19: Adjusting the chest.

To set the center of rotation for the arms:

Select the right upper arm.3.	

Move the center of rotation towards the joint of the shoulder. 4.	

Figure 26.20: Adjusting the upper arm.
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Repeat this for the left upper arm.5.	

To set the center of rotation for the head:

Select the head.6.	

Switch to the 7.	 Face camera.

To set rotation values:

In the 8.	 Joint Editor, switch from center to yrot.

Swap the twist start and twist end positions. You can test your 9.	
settings by adjusting the yrot parameter dial in the Parameters 
palette. The twist end (in green) should be above the chin. The 
twist start (in red) should be below the chin and into the neck. 
This blends the rotation of the head into the neck. 

Figure 26.21: Blending the head into the neck.

Switch to the 10.	 From Right camera, and zoom in on the head 
and neck.

Switch from yrot to xrot in the 11.	 Joint Editor. 

Figure 26.22: Adjusting the head and neck.

Drag the static handle on the left (in red) down below the 12.	
chin.

Drag the dynamic handle on the right (in green) counter-13.	
clockwise till it is also below the chin, but still higher than the 
static handle you dragged in the previous step.

Notice that as the dynamic handle hits the static handle, the 14.	
static handle is also moved.

Drag the static handle counter-clockwise until it is at the top 15.	
of the back of the neck.
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Figure 26.23: The static handle at the top of the back of the neck.

Test your settings by adjusting the xrot parameter dial.16.	

To adjust scale values:

Switch from xrot to neck_scaleY. This controls the blending 17.	
zone for the y-axis scaling of the neck when scaling the head.

Set Low start to 5.97 and Low end to 6.14. 18.	

This sets the blending to within the neck, below the chin. 19.	

Figure 26.24: Blending to within the neck, below the chin.

Select the mouth_scaleY. 20.	

Set Low start to 6.4 and Low end to 6.27. 21.	

Figure 26.25: Setting the eye.

Select lEye_scaleY.22.	
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Drag the High end up towards 9. 23.	

Figure 26.26: Dragging the High end up towards 9.

Repeat this for the right eye.24.	

You can now scale the head to see the effects. 25.	

You can now set limits for each body part. 26.	

To set remaining limits

Repeat the above procedures for the remaining body parts, 27.	
such that your figure moves and bends realistically. 

See28.	 “Adjusting Joint Parameters” on page 345 and “Creating 
Figure Models” on page 336 for more information.

Set the default IK angles. Memorize the default position. 29.	
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